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Notice

This document contains information about one or more ABB products and may include a description of or a reference
to one or more standards that may be generally relevant to the ABB products. The presence of any such description of
a standard or reference to a standard is not a representation that all of the ABB products referenced in this document
support all of the features of the described or referenced standard. In order to determine the specific features
supported by a particular ABB product, the reader should consult the product specifications for the particular ABB
product.

ABB may have one or more patents or pending patent applications protecting the intellectual property in the ABB
products described in this document.

The information in this document is subject to change without notice and should not be construed as a commitment
by ABB. ABB assumes no responsibility for any errors that may appear in this document.

Products described or referenced in this document are designed to be connected, and to communicate information
and data via a secure network. It is the sole responsibility of the system/product owner to provide and continuously
ensure a secure connection between the product and the system network and/or any other networks that may be
connected.

The system/product owners must establish and maintain appropriate measures, including, but not limited to, the
installation of firewalls, application of authentication measures, encryption of data, installation of antivirus programs,
and so on, to protect the system, its products and networks, against security breaches, unauthorized access,
interference, intrusion, leakage, and/or theft of data or information.

ABB verifies the function of released products and updates. However system/product owners are ultimately
responsible to ensure that any system update (including but not limited to code changes, configuration file changes,
third party software updates or patches, hardware change out, and so on) is compatible with the security measures
implemented. The system/product owners must verify that the system and associated products function as expected
in the environment they are deployed.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind
arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from
use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the
contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or
disclosed only in accordance with the terms of such license. This product meets the requirements specified in EMC
Directive 2014/30/EU and in Low Voltage Directive 2014 /35/EU.

Trademarks

All rights to copyrights, registered trademarks, and trademarks reside with their respective owners.
Copyright © 2019 by ABB.
All rights reserved.
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Use of warning, caution, information, and tip icons About this Book

About This Book

Use of warning, caution, information, and tip icons

This publication includes Warning, Caution, and Information where appropriate
to point out safety related or other important information. It also includes Tip to
point out useful hints to the reader. The corresponding symbols should be
interpreted as follows:

Electrical warning icon indicates the presence of a hazard which could result in
electrical shock.

é Warning icon indicates the presence of a hazard which could result in personal
injury.

discussed in the text. It might indicate the presence of a hazard which could

@ Caution icon indicates important information or warning related to the concept
result in corruption of software or damage to equipment/property.

E Information icon alerts the reader to pertinent facts and conditions.

Q Tip icon indicates advice on, for example, how to design your project or how to
use a certain function

Although Warning hazards are related to personal injury, and Caution hazards are
associated with equipment or property damage, it should be understood that
operation of damaged equipment could, under certain operational conditions, result
in degraded process performance leading to personal injury or death. Therefore,
comply fully with all Warning and Caution notices.
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About this Book Terminology

Terminology

The Glossary contains terms and abbreviations that are unique to ABB or have a
usage or definition that is different from standard industry usage. Please make
yourself familiar to that.

You will find the glossary at the end of this manual.

Document conventions

The following conventions are used for the presentation of material:

e  The words in names of screen elements (for example, the title in the title bar
of a window, the label for a field of a dialog box) are initially capitalized.

e  Capital letters are used for the name of a keyboard key if it is labeled on the
keyboard. For example, press the ENTER key.

e  Lowercase letters are used for the name of a keyboard key that is not labeled
on the keyboard. For example, the space bar, comma key, and so on.

e  Press CTRL+C indicates that you must hold down the CTRL key while
pressing the C key (to copy a selected object in this case).

e Press ESC, E, C indicates that you press and release each key in sequence (to
copy a selected object in this case).

e  The names of push and toggle buttons are boldfaced. For example, click OK.

e  The names of menus and menu items are boldfaced. For example, the File
menu.

- The following convention is used for menu operations: MenuName >
Menultem > CascadedMenultem. For example:
select File > New > Type.

- The Start menu name always refers to the Start menu on the Windows
Task Bar.
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Document conventions About this Book

e  System prompts/messages are shown in the Courier font, and user
responses/input are in the boldfaced Courier font. For example, if you enter a
value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 to 30.

You may be told to enter the string TIC132 in a field. The string is shown as
follows in the procedure:

TIC132
Variables are shown using lowercase letters.

sequence name
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Freelance Operations — Overview What is Freelance Operations?

Section 1 Freelance Operations — Overview

What is Freelance Operations?

The software running on the PC operator station of the Freelance system is called
Freelance Operations.

It offers a user-friendly graphical user interface in accordance with the MS-
Windows standard. Freelance allows you to configure up to 100 operator stations
for process operation and observation. When assigning the operator stations to
process stations, however, it must be taken into account that a maximum of 10
operator stations (clients) can be assigned to a process station (server).

Among other things, Freelance Operations offers the following process operation
features:

Standard displays such as overview display, group display, faceplate, trend
display, system display, time scheduler display, SFC display, WEB display,

Multi monitor support to customize the display types on up to four monitors,
Customized graphic displays,

Customized faceplates for user-defined function blocks,

Simple process operation using the mouse or keyboard,

Quick and direct access to tags for operation,

Comprehensive and wide-ranging message management,

Trend displaying and trend archiving,

Logging,

System diagnostics in the system display.
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Installing Freelance Operations Freelance Operations — Overview

Installing Freelance Operations

For information on how to install Freelance Operations please refer to the Getting
Started manual.
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Operating Philosophy Using Freelance Operations for process control

Section 2 Operating Philosophy

Using Freelance Operations for process control

Under Freelance Operations, the automated process can be operated either with
mouse or keyboard. This ensures that in the unlikely event of either device failing
the other can be used for all operator actions.

Mouse operation

Tag selection

A tag is selected by clicking the left mouse button in one of the following selected
areas:

a faceplate in a group display,

a message in the message line, message list or hint list,

the dynamic object in a graphic display,

the menu item Display > Faceplates..,

atrend in a trend display,

steps or transitions in the SFC display.

Calling up afaceplate

By double clicking one of these areas, the faceplate of the relevant function is
displayed and can be operated.

Operators Manual — Freelance Operations 19



Using Freelance Operations for process control Operating Philosophy

Moving a faceplate

A faceplate can be moved freely around the display area of the screen by clicking
on the header. The message line cannot be overlapped.

Executing actions in the graphic display

Depending on the configuration, one of the following actions can be performed by
selecting a dynamic graphic object in a graphic display:

e calling up a display,

e  operating a process variable,

e acknowledging messages.

The configured action is initiated by a click of the left mouse button.
Default display

The Default display for the selected tag appears as the first menu item in the
context menu of the corresponding faceplate and can be easily called up by
clicking the left mouse button, owing to its exposed position.

Context menu
You can call up the context menu at any time by right-clicking with the mouse. The
context menu contains menu items for the most important operations and directly

selectable displays, depending on the element on which the cursor is currently
positioned. See also Operation using the context menu, page 25.

Keyboard operation

Tag selection

Upon selection of the appropriate focus, a tag can be selected in the display in
different ways:
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Operating Philosophy Using Freelance Operations for process control

Use the TAB to select
o afaceplate in a group display,
e adynamic object in a graphic display.

Use the CURSOR KEYS to select

e amessage in message list,

e anentry from a display list,

e atrend in atrend display,

e steps or transitions in the SFC display.

ﬂ The selected area of a display is indicated by a frame.

Faceplate

By pressing ENTER after having selected the desired tag name, the faceplate for
operating the function is displayed.

Moving a faceplate

A selected faceplate can be moved freely around the display area of the screen.
You can move it in the appropriate direction either by one pixel using CTRL+
CURSOR KEYS or by one of the 30x4 grid units by pressing CTRL + SHIFT +
CURSOR KEYS.

Default display

A configured default display in Freelance Engineering can be called up by using
the F11 function key.

Display explorer

The display explorer shows a tree view of the individual displays available on the
operator station. You can select and call up the appropriate display as required. The
display explorer is called up by selecting the corresponding display in the menu or
by a key combination involving the following function keys:
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Using Freelance Operations for process control Operating Philosophy

Type of display Key combination
Tag list CTRL +F5
Graphic Display CTRL + F6
Group display CTRL + F7
Trend display CTRL + F8
Logs CTRL + F9

In the display explorer, you can select a display or tag by either pressing the
CURSOR KEYS or by typing the name or first characters and then confirming
with ENTER.

Display selection

After having selected a tag, you can directly call up the corresponding displays by
using the function keys F6...F9.

Focus

=i

In Freelance Operations, several windows are visible on the screen at a time.

The symbol on the left side in the status line shows which area is activated and
can thus be operated using the keyboard: i.e. the blue area is active. To change
between the display areas, press the ALT key together with the CURSOR KEY
LEFT or RIGHT and/or UP or DOWN for the faceplate display area.

The following focus areas are available:
e message line (top),

e display area (bottom left),

o faceplate (bottom right).

Function keys

Upon installation, the following function keys are used in Freelance Operations for
non-display dependent functions:

Key combination Meaning

22
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Operating Philosophy User interface in Freelance Operations

F1 Calls up help

F12 Acknowledges the control room horn, same function as
button Horn in the message line

SHIFT + F10 Calls up the context menu — please also refer to Operation

using the context menu, page 25.

User interface in Freelance Operations

=
otECt

ABD = )
Lt
S A 4+ BLUFAFGDEE G D & 4 & Toolbar

Boiler Steam Line
- —

e e s

Steam Drum
Paraaters B8

ash Conveyer S ST

= ~ StatusLine ' [Bo  [& noock | 6rsm01z | 101658 AMS

User interface.png

Message line

The message line is always visible and cannot be overlapped by other displays. As
seen in the example, it may consist of several message items with tag names and
message point details, plus the following items:
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User interface in Freelance Operations Operating Philosophy

Field for overflow area

n Field for indicating the total number of all messages on
that operator station
o @ Button for the acknowledgment or visual
V. .
@& or acknowledgment of displayed messages
- \\ﬂ Button for acknowledgment of the control room horn. The
or horn gets white a soon as the control room horn
becomes active.

A DN The ABB symbol is active and marked with an i if

APD % messages arrive for which hints have been configured.

o or The hint list can then be displayed. If there are no hints
there is no | in the ABB field.

See also View, page 33.

Menu icon

The menu icon in the toolbar is always visible. This means you can perform the
actions available in the menu in any operating situation.

Toolbar
You can use the menu line, but also the toolbar buttons to perform actions. A

tooltip is available for each icon. The toolbar can contain various buttons or icons,
depending on the currently shown display.

AEA | «» BEEAFEG R S 44 4

Display area

This screen area accommodates displays selected by the user.

24
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Status line

| o & NOLOCK 6/2212018 | 10:16:58 AMS

On the left hand side of the status line there is a small icon, the keyboard focus
indicator.

Useful information for operation is shown in the middle of the status line. The 10
most recent messages can be viewed. Select the respective arrow and keep the left
mouse button pressed.

In the right area of the status line, the number of hardcopies still to be processed is
indicated.

If the User Management is enabled via Settings tool, the user name is indicated.
Otherwise, “NOLOCK?” is displayed.

The current date and time of day are displayed in the status line on the right hand
side. The character "S" to the right of the time indicates daylight saving time.

Operation using the context menu

g Right-click within selected display or on tag
or
SHIFT+ F10

The context menu appears. It contains menu items for the most important
operations and directly selectable displays. The illustration below shows an
example of a context menu:
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Reactor2 (Graphic)
FreelanceDC5s (Overv.)
System display (Sys.)
Message list (Msg.)
cn

Control aspect

Back

Forward
Mixer (GRP)

Add Favorite

Content menu.png

The External aspect is a display allocation function which can be used in
Freelance Engineering for allocating any document or Windows program to a tag.
This function allows documents to be linked to a tag or Excel spreadsheets to be
opened for a tag. The External aspect — in this example a "readme" file — is always
the last menu item of the context menu.

é If you use this option, the program configured for the External Aspect may

provide access to the operating system.

When the Control Aspect program (CBF Viewer) is additionally installed on the
operator station PC and the Control Aspect option is activated, the context menu
of a tag includes the Control Aspect entry. Upon selecting this entry, the program
which has been used to configure the tag will be displayed with the current process
variables. It is thus possible, for example, to analyze the locking logic status of an
IDF type tag, provided the logic is in the same program as the IDF block. The
Control Aspect menu item will be displayed below the tag.

User identification

The User Management which includes Security Lock and Extended User
Management is designed to control access in Freelance Engineering and Freelance

26
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Operations. Please refer to Engineering Manual -User Management for further
details.

Until User Management is not enabled, the menu items for logging in and out and
for changing password are not active. This means that each user can call up and
operate any of the displays.

After User Management has been enabled, users must log in under Freelance
Operations. The system will detect the user identity and assign corresponding
permission to user.

g Tools > Login > Enter user name > TAB key > Enter password > ENTER

With User Management enabled, each display will indicate whether or not the
logged-in user has operating rights for this display — by means of an open or a
closed padlock:

ﬁﬂorﬁ

For each display and tag (faceplate) it is possible to define for each user group one
of the following three access levels:

e No access

e  Observation only

e  Observation and operation

In Freelance Operations, the following access control information is shown:
e  The user name is displayed permanently in the status line.

e If an appropriate signal sequence log has been configured, all control actions
along with user names are documented in it.

Standard user

| NOLOCK | User Management is not enabled.
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GUEST Appear when using Security Lock, no user is logged in, e.g. during start of
Freelance Operations.
SYSTEM Control action performed by the system (may appear in the log).

Process visualization

Standard and free displays are available to represent process-status information.

Standard displays are fixed in appearance. During configuration, only the names of
tags to be shown in the display need to be entered.

Free displays are graphic displays or user-defined faceplates both created in
Freelance Engineering during configuration using the graphic editor or the
faceplate editor.

Overview display

One overview display can be created for each Freelance operator station.

A standard overview display consists of 16 rows of 6 columns each. A maximum
of 96 displays can be represented and selected as a symbol. These displays can be
group displays, trend displays, graphic displays, logs, time scheduler displays, SFC
displays or WEB displays. The displays can be called up with a left mouse click on
the corresponding symbol.

Instead of using the standard overview display, it is also possible to define a
graphic display used as overview display in the operator station.

Group display

A group display is a configured collection of several faceplates. It offers the user
the opportunity of displaying related functions in one display. The functions or tags
can be operated directly.
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Graphic display

In addition to the standard displays described above, customized graphic displays
can also be created. These graphic displays can comprise a combination of static
and dynamic elements and are designed according to the requirements of the user.

The static section can be used for schematic representation of the plant structure in
the background. In the foreground, the dynamic elements of the displays can be
used to present the current values and states of the process variables to the
operator.

Trend display

Faceplate

The trend display is the virtual presentation of a trend recorder. Binary and analog
values from the process can be plotted against time. Up to 6 process variables can
be graphically represented per trend display. This allows the user to zoom, fade out
and scroll curves. The recorded curves can be archived on the operator station PC.
It is also possible to export trend files (archives) to another PC. The Archive
Browser software package can be used to view these exported trend files as well as
to convert them into CSV format for further processing in other programs, e.g. MS-
Excel.

Trend displays can be configured in Freelance Engineering and defined by an
operator station user. In order for a trend display to be defined by an operator, a
trend server must have been configured in the project.

When loading data from Freelance Engineering into the operator station, the
configured trend displays may be deleted. For this reason, it is recommended to
export operator-defined displays and then re-import them, if required.

Faceplates are used for operation and observation of tags. They show the current
state of the associated process. Faceplates can be called up from other displays.
They are always positioned on top of other displays. A selected tag is always
operable via its faceplate.
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SFC display

A maximum of 5 faceplates can be displayed simultaneously on the screen. Even
with the Dual Monitor option, only a total of 5 faceplates are available on both
screens. If you open an additional faceplate, the system will automatically close the
faceplate which had not been activated for the longest period.

You can fix faceplates by using the pin button in the title line of each faceplate. A
fixed faceplate can be moved, but it will not be closed automatically. You can fix a
maximum of 4 faceplates.

You can either tile or cascade the faceplates on the screen. See also View, page 33.

The faceplates for the standard function blocks are part of the basic Freelance
Operations scope of delivery. In addition, user-defined faceplates can be created
for user-defined function blocks.

In a standard SFC display, the current operating status of the SFC program is
shown. The current step and the completed program segments are identified by
color change. Disturbance states and unfulfilled process criteria are clearly shown
by colored borders in the fade-in criteria window.

In addition to the standard display shown when calling up the SFC display, you can
also display the sequential function chart overview display. This gives you the
complete structure of the sequential function chart at a glance.

Time scheduler display

Logs

The time scheduler display presents the time scheduler’s state and allows the
operator to control it. This display comprises a trend area for the progression of set
points and actual values, a status field and the associated faceplate of the time
scheduler block. If a tag was assigned to the time scheduler display, the
corresponding faceplate is displayed as well.

Logs provide the documentation of events, states and sequences from the process.
The data can be stored on the operator station hard disk, output to a printer or
displayed on the screen. Log files can also be exported to another PC. The Archive
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Browser software package can be used to view the exported log files as well as to
convert them into CSV format for further processing in other programs, e.g. MS-
Excel.

There are four different log types available:
e Signal sequence log (SSL)

e  Operation log (OPL)

e Disturbance course log (SAP)

e  Excel report (REPORT).

System display

The current status of the Freelance system hardware and software is shown on the
standard system display in Freelance Operations. Here, information can be
obtained on the operator station and the connected process stations.

WEB display

If you call up a WEB display in Freelance Operations, the local Internet Explorer
will be started and the link to the configured URL will be activated. It is thus
possible, to call up the video display from a process monitoring camera in
Freelance Operations.

The WEB display starts the local WEB browser. Users of Freelance Operations
could thus access files on the local machine or other machines in the Intranet or
global Internet. Mind the risks and hazards involved.
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The Freelance Operations menu at a glance

Operate »
Message list!

View 3
Display »
Tools »
Print -]
Help »

Operate This menu item includes all operations for the currently active
display. You can find a detailed description in the relevant chapter
of each type of display.

Message list!  Calls up the message list.

View Provision of several view options for the message line and the
faceplates.

Display Selection of a display or tag via the Display Explorer.

Tools Exit Freelance Operations upon security dialog,
login, logout and change password, run Security Lock if Security
Lock has been enabled,
definition of trend displays,
calling up the Options dialog box.

Print Print-out of hardcopies on the connected printer.

Help

Calling up the help system for Freelance Operations,
calling up the context help system for Freelance Operations,
display of the Freelance Operations version.

E Many menu items can also be selected using the icons in the toolbar. In such
cases, the icons are shown next to the menu items in the following text.
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Operate

Message list

View

AEA «»BLEEAEEFE LW T 44 4

Depending on the selected display, you can carry out different actions via this
menu item. You can find a detailed description in the chapters describing the
individual displays. This menu option is basically intended for keyboard operation.
Usually, operation via the mouse is possible directly in the context of the display.

This menu item calls up the message list without any further input. In the message
list, messages sent from the process stations to this operator station are displayed
and managed. The messages can be released by either the Freelance system or the
automated process.

Messages can be filtered for this display according to specific criteria. In the
message list, one or more messages can be selected and acknowledged or the
display assigned to a particular message can be called. Information on the selected
message is thus available within short time.

Operate >
Message list!
~"  Standard view of message line View >
Area view of message line Display >
List view of message line Tools >
Tile Faceplates il ?
Cascade Faceplates FEE ’
Close all Faceplates Ctri+Z
Close all unpinned Faceplates Ctrl+Y¥

Here you can select different views for the message line and the faceplates:
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Standard view of message line

&

The standard view of the message line — several message items
with tag names and message item information — is shown.
Depending on the configuration, visual acknowledgment (within
this operator station only) or point acknowledgment (system-wide
by acknowledging the alarm point in the process station) are

possible in this message line type.

ABB

Qo
Standard view.png

Area view of message line

Ag

[
N

The area-specific view of the message line is shown. In the
message line there is a fixed position for each plant area. The
number of associated, present messages is displayed for each plant
area. The plant area is displayed in the priority color of the most
important message. The most important message is detailed in the
tooltip. Selecting a plant area button opens a plant area specific
message list. With this message line view, no acknowledgment is
possible as the Freelance system is based on the principle that only

visible messages can be acknowledged.

sssss Beacter
2

wnde 12

Hastenater

Area view.png

List view of message line

b

: -

The list view of the message line will be displayed. The four most
important messages are displayed in the same format as on the
message page. Depending on the configuration, either the oldest or
the latest message appears at the top. Controlled scrolling in the
mini list is not possible. Double-click to open the faceplate
associated to the message. Depending on the configuration, visual
acknowledgment (within this operator station only) or point
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acknowledgment (system-wide by acknowledging the alarm point
in the process station) are possible in this message line type.

B <

i

List View.png
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Tile faceplates

||
||

The faceplates are basically arranged side by side. This holds for
both the faceplates already displayed and for those to be called up.
With oversized user-defined faceplates, the space may not be
sufficient for all faceplates to be arranged side by side. In this case,
the first non-fitting faceplate is displayed right-aligned and may
overlap other faceplates.

Cascade faceplates

=

The faceplates are basically arranged such as to overlap each other.
This holds for both the faceplates already displayed and for those
to be called up.

Close all faceplates
All current faceplates will be closed.

Close all unpinned faceplates
All current faceplates that have not been fixed with the pin button
will be closed.

Display

Operate >
Message list!

Faceplates... Ctrl+F5
Graphic... Ctrl+F6
Group... Crl+F7
Trend... Ctrl+F8
Log... Ctrl+F9
Time scheduler...

SFC...

WEB...

Overview display
Message list
Hint list

System display

Back

Forward

Display.bmp
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This menu is used for selecting a display from a list of all those available, or for
selecting a tag. Except for overview display, message and hint list as well as
system display, all of which only exist once per operator station, the Display
Explorer with the name of all tags, displays and logs is started for all other menu
items. The displays of the selected type are already open.

Faceplates

:% Opens the Display Explorer with expanded tags.

Graphic...
Opens the Display Explorer with expanded graphic displays.

[l

Group...
Opens the Display Explorer with expanded group displays.

=

Trend...
Opens the Display Explorer with expanded trend displays.

[5]

—
o
«

Opens the Display Explorer with expanded logs.

N

Time scheduler...

Opens the Display Explorer with expanded time scheduler displays.

@

@)
oL
O

ﬂ Opens the Display Explorer with expanded SFC displays.
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WEB...

Opens the Display Explorer with expanded WEB displays.
Overview

ﬁ Opens the overview display.

Message list

A Opens the message list.

Hint list
o Open the hint list.

System Display
Opens the system display.

Back/Forward

* *_ Replace the current display by the corresponding display from the ring
buffer.

Freelance Operations stores the five most recently called displays in a ring buffer.
The controls Back and Forward replace the current display by the corresponding
display from the ring buffer, with no other input being required.
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Display 1
kS

Display 2
Digplay 5 -

Display 3

Display 4

—p» Backl
------ »  Forward!

vc0630_us.png

Pressing Back and Forward leaves the content of the display memory unchanged,
i. e. after calling one of these menu items five times, the initial display will re-
appear. A new entry will be recorded in the display memory each time a display is
called up via the menu, the context menu or a dynamic graphic object. The
BACK/FORWARD buttons do not create an entry in the graphic memory! When a
new display is called up, this replaces the stored display which would be reached
by the next Forward! command.

The ring buffer can be switched on or off in the Tools > Options menu under
Cyclic back/forward display switch . When the ring buffer is switched off, the 5
display entries are managed in a linear manner, i.e. after having called Back four
times, the end of the buffer is reached. The first display is not called again as when
the ring buffer is switched on. Once the last displays have been called using the
Back button, the current pointer can be shifted again to the front memory locations
by pressing Forward.

A 4 /_\4 4
Display 1 ‘ Display 2 ‘ ‘ Display 3 ‘ Display 4 Display &

— p Backl
———————— p  Forward!
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Tools
Operate »
Message list!
View ¥
Display ]
Systermn... Tools >
Legin / Log over... gt >
Legout Ll >
Change Password...
Run Security Lock
Define Trend Displays...
Qptions

System... Here you can terminate Freelance Operations after having entered
the password previously defined in Freelance Engineering.

Login/ Log over...

Here you can login using your user name and password. Specific
access rights are assigned to each user, depending on the
configuration.

Logout Here you can log out. Only the rights for the user "GUEST" are
active then. If the user wants to execute a function that is not
available to the GUEST, he must log in again.

E The following menu items can only be selected if User Management has been
enabled.
When entering the user name and password the pattern of upper-case and
lower-case characters must be correct.

Change Password
Here, users may change the passwords they need to identify
themselves. First the old valid password must be entered, followed
by the new password (twice).

E The changed password is only valid for this operator station. If the same user is
authorized to log in on another operator station, the previously used password is
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still valid. It is recommended to change the password for the same user
successively to ensure that an identical password is used on all PCs.

Run Security Lock
Security Lock is part of the User Management. Start the Security
Lock upon password entry, provided that the user is authorized to
use the Security Lock feature. Please also refer to Engineering
Manual-User Management for detailed user permission
management. Using the Security Lock program, users can be added
or deleted, or access rights can be changed.
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Y

Options

Define Trend Displays...
Opens the dialog box for trend display definition by the user (see Defining
the trend display, page 113)

The following menu items are always available:

Opens the Options dialog box featuring the following settings:

Options

General
Cyclic backforward display switch

Faceplates always on top

Show display selection list:

Olett ® right

Graphic display
(® Use whole screen width

(O Use whole screen height

Signal sequence log
Detail view colors:

Background

|
|

i

Trend display

Operation panel:

X

@ at top O at bottom
O Centered
Message list SFC display
Priority filter preset: Tr=n @l fereriay
0
@) use last O selectall double click
oo
Options.png
General

Cyclic back/forward display switch

Management of display memory as ring buffer memory or linear

management (see Back/Forward, page 38).
Faceplate always on top

When changing to other Windows applications, the faceplates will
always be displayed on top.

Show display selection list

Here you can select whether the Display Explorer appears on the
right or left hand side of the screen.
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Graphic display

Use whole screen width / height
The graphic display is shown over the entire width/height in the
available graphic area with the aspect ratio remaining unchanged.
Depending on the display size and the used monitor, the lower or
right screen area may not be used or a part of the display is clipped
and can only be reached by using the scrollbar.

Centered The complete graphic display is arranged and centrally aligned in
the available graphic area.

Message list ~ Here you can select whether a set priority filter shall be used the
next time a message list for a specific plant area is called up.

use last When calling up an area-related message page, the messages will
be filtered according to the priority filters last used.

select all Messages of all priorities will be displayed when calling up an
area-related message page.

Signal sequence log
Here you can configure the text and background colors for the
signal sequence logs, so that you get alternating line colors which
provide a better overview of the table, as shown in the example.
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Log operation

Signal Sequence log.png

Trend display Here you can select for trend displays whether the operating field
shall be arranged above or below the curve.

SFC display If the Control Aspect/CBF Viewer is additionally installed, you can
configure the system in such a way that this program opens on a
double-click. With this setting, an automatically configured criteria
window corresponding to the transition program will replace the
criteria window to be configured.
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Print
Operate ¥
Message list!
View >
Display ¥
Tools >
Screen Print >
Display Help ¥
Region

Screen Outputs a copy of the entire screen currently displayed output to
the printer.

Display Outputs only the display area of the screen to the printer, without
the menu or dialog area.

Region Prints a selected section of the screen. To do so, you need to define
the area to be printed. Press the left mouse button and move the
focus to the appropriate section of the display. The selected section
will be printed once you release the left mouse button.

Help
Operate >
Message list!
View »
Display »
Tools »
Print »
Freelance Operations Help Help »
Context Help F1

About...

Help.png

Freelance Operations Help
Calls the Freelance Operations help system. This help system
includes all important parts of the present manual.
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Context Help Helpful information on the current screen display.

About... Provides information on the Freelance Operations software
version.

Display selection

A good, straightforward system of display selection is particularly important for a
control system. This ensures quick access to the area in question in order to take
the necessary steps and control the process safely.

You can access all displays, tags and logs of this operator station. There are
different access options.

Freelance Operations supports Multi Monitor functionality which makes it

E possible to customize the display types on up to four monitors. This can be done
in Freelance Engineering. Display types which are enabled are presented as
normal icon, disabled display types appear as grayed out icon and are
inoperable.

Via the toolbar:

] |i8d] [127] LA [57]

Q Left-click the symbol (e.g. graphic displays) > Double-click the appropriate
graphic display in the Display Explorer

Via the menu

Q Display > Graphic... (e.g.) > Double-click the appropriate graphic display in
the Display Explorer
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Via a shortcut

Q CTRL + F5to CTRL + F9 > Select the appropriate display using the
CURSOR KEYS > Enter

For further details on the display types, please refer to Process visualization, page
28.

In all cases the Display Explorer with the names of all available displays comes up.
Double clicking the required display name selects the display.

g In the Display Explorer, a quick selection is possible by entering the first letter
of the tag or of the display name.

Via the context menu

The display selection via the context menu is a fast alternative for calling up
displays. In addition to general displays, it is also possible to directly select the
displays assigned to the tag.

g Select tag > Call up context menu > Select the appropriate display.

For further details on the context menu, please refer to Operation using the context
menu, page 25.

From the overview display

Alternatively you can select displays via the overview display.
To select a specific display, proceed as follows:

Q Left-click the appropriate symbol in the overview display
or
Select the appropriate symbol with the TAB key > ENTER

For further details on the overview display, please refer to Overview Display, page
83.

Operators Manual — Freelance Operations 47



Display selection Operating Philosophy

From a graphic display

In order to call up a display from a graphic display, a graphic object that features
the Show display action configured with a display in Freelance Engineering must
have been previously selected.

g Left-click the appropriate graphic symbol
or
Select the appropriate graphic symbol with the TAB key > ENTER

Via the default display

A default display can be assigned to each tag when configuring the display
assignment in Freelance Engineering, which provides quick access to plant status
information during operation and monitoring in case of emergency, for instance.
After selecting the tag, this display will be listed in top position of the context
menu so that you can call it up with both the mouse and the keyboard:

Q Call up context menu >Left-click default display
or
F11

Only one default display can be configured per tag. The following types are
available:

graphic display,

trend display,

group display,

SFC display,

time scheduler display,
WERB display,
operation log,

signal sequence log,
disturbance course log,
Excel report.
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Window Tabs

Favorites

Click the Favorite tab, and Favorite window is shown. Favorite window allows the
operator to configure quick access to the favorite displays, trends, logs and so on,
with which the operator can optimize personal usage with Freelance Operations
software.

Favorite window contains 24 buttons (4 by 6). Each of the buttons can be
configured to call up any display. In the following text, the term display is used as
generic term for all displays that can be selected in Freelance Operations: graphic,
group, WEB, and trend displays, logs as well as the overview or system display,
the message list, all faceplates, the SFC displays and time scheduler displays.

For each button in the Favorite window it is also possible to assign any keystroke
from the keyboard to each function. Therefore, the function keys F1 to F12 are
available for configuration - as single keystroke as well as in combination with the
CTRL, SHIFT or ALT key. Furthermore, the ASCII keys — with or without the
SHIFT key - can be used in combination with the CTRL or ALT key. In the
following text, all these keystroke combinations are called shortcuts.

Configuration of the Favorite window is performed in Freelance Operations. In a
display interface, right click and choose the option “Add Favorite” in the context
menu.

FreelanceDC5 (Owvery.)

Systern display (Sys.)

Message list (Msg.)

Back

Forward

Add Favorite

The Favorite window appears. Choose a position to place the display. Thus, a
Favorite file is added successfully. Each Freelance user selects its own favorite
display. Existing configurations can be imported and exported.

Operators Manual — Freelance Operations 49



Window Tabs

Operating Philosophy

Favorite n
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Each display that is assigned to a button is represented by a thumbnail picture with
the display name below it. The operator can move a display to another button by
long-pressing the mouse and dragging the thumbnail picture to the target position.
The operator can also change two displays position in this way.

Scope of the Favorite Window

The configuration of the Favorite window is according to the current logged-in
user. If User Management has not been enabled, the user NOLOCK is used.

The Favorite window is not part of a special project, but rather belongs to an
operator station. It is so there will be no modifications when loading a new project
or a whole station from Freelance Engineering.

Saving the Configuration of the Favorite Window

Every time the dialog box is closed, the Favorite window configuration is
automatically saved in the file <user name>.qck. This file is stored in the default
project directory:
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<FreelanceData>\proj.

Functions of the Favorite Window

All functions described for the Favorite window can be called up from its context

menu
g Right click on a position between the displays (do not position mouse pointer on
displays!).
Favorites FreelanceDCS_Page1 History
Clear function keys
= = Delete all
- = Import =
Export .
Reactor1 Formulation

Favorite Function.png

Clear function keys
All assignments of the function keys (shortcuts) will be deleted.
All functions of the soft buttons remain unchanged.

Delete all
All user-made assignments for the buttons and shortcuts will be deleted.
H If the operator selects Clear function keys or Delete all, all standard
keyboard assignments of the function keys, which had been pre-assigned
for the use of the menu and the display, will then be available again.
Import

The file ‘<username>.qck’ will be imported from
C:\<FreelanceData>\export\gselect\. If a configuration is already available on
the operator station for the Quick Select window, a security dialog will ask if
the operator really wants to delete the current configuration.
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Export

To make the configuration available for other PCs, this menu item can be used
to store configuration data as file:

C:\<FreelanceData>\export\gselect\<username>.qck.

Functions of a Specific Button

Proceed as follows to open the context menu for a button:

Q Right click appropriate button
or
SHIFT + F10
Favorites Formulation History
s ke ¥ ¥
- I : mmm
R Undo JI =
fn Delete o =
Cut i
Reactor1 Formulation
Copy
Paste
Properties
J 4 e —
-v_ ! -.'-;T_ = 4
Formul_SFC QvervBiomass
Favorite-specific button.png
Undo
The last button configuration will be undone.
Delete
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The assignment of the selected button is deleted. Pressing this button will no
longer call up a display.

Cut
The configuration of the selected button is deleted and stored in the clipboard.
Copy
The configuration of the selected button is stored in the clipboard.
Paste
The content of the clipboard is assigned to the selected button.
Properties
A new dialog box with the characteristic data of a Favorite file, but one will be
opened where the operator can specify additional properties.
Button Properties *
| oK |
Display name: |SecSeﬂF‘ond | Cancel
[Jinterpret as Tag name
Eiutton text: | SecSettPond |
Short cut: |
DTooITiponIy
ToolTip text:
Display name

Enter the name of the display or a tag in the edit field. With the Check box the
operator must indicate whether the name should be interpreted as a display or a
tag name.
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Button text
Any text can be entered to be shown on the selected button.
Short cut

Instead of using the Favorite buttons, the linked display can also be called up
via the keyboard. By pressing an appropriate combination of keys from the
keyboard, this key combination is entered as the short cut of this button.

The operator can call up the assigned display at any time using this combined keystroke.

A Caution!

For key assignment purposes it is also possible to define those combined keystrokes,
which are normally pre-assigned to the system (F1 for Help, CTRL + F5 for Tag list), thus
deleting the pre-assignments. There will be no system warning in such cases!

ToolTip text
The operator can enter any text in the edit field.
ToolTip only

[ Tooltip text will be displayed as follows
<Display name>, <Shortcut> <Tooltip text>
e.g. <Reactor> <ALT + F8> <Plant display>

v only the entered tooltip text will be displayed.

Active Window (middle tab)

The active window shows the current selected display.

History

The History window shows what the operator has accessed in Freelance Operations
during present time operation. Any display the operator opened has been added in
History window and would be displayed as one only with updated position.
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From History window, with context menu, the user can access the Overview
display, System display and Message list directly, as well as the displays opened
recently with the Back and Forward option.

! History |

Falrnint At n
g

FreelanceDC5s (Owverv.)
Systern display (Sys.)

Message list (Msg.)

Back

. Forward
Formulation

SingleLine WiWaterCQvervi

History overview.png

Scope of the History Window

The configuration of the History window is according to the current logged-in
user. If User Management has not been enabled, the user NOLOCK is used.

The History window is not part of a special project, but rather belongs to an
operator station. So there will be no modifications when loading a new project or a
whole station from Freelance Engineering.
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Section 3Messages and Hints

General description — Messages and hints

Errors and certain status deviations in the Freelance system are signaled by optical
and acoustic messages.

The Freelance system provides the following message types: system message,
fault message, switch message, hint and hint message. Depending on their
process-relevant importance, these message types have different priority levels:
namely one system level (subdivided into three groups S1-S3) and five user levels
(1-5).

During configuration in Freelance Engineering, a specific acknowledgement
strategy is assigned to each priority level. This acknowledgment strategy defines
how the transmitted messages are to be acknowledged.

Messages and hints are displayed in the message line, message list, and hint list and
can be acknowledged from the respective location. This does not apply to the plant
view in the message line. In addition, the messages can be acknowledged via the
context menu of the assigned faceplate and in a graphic display.

When Freelance Operations is restarted, the current project status is determined.
For this purpose, active messages on all connected process stations are read-out
together with the corresponding message time and displayed on the message page.
This ensures that the actual time when the message was generated is indicated in
Freelance Operations, even if the operator station was not active at that time.

Message types

In the Freelance system, messages are subdivided into the following message types
according to their process-relevant importance:
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System messages

System messages always have the highest priority level and are subdivided into
the message groups S1 to S3. These messages cannot be configured or changed by
the user. System messages are used to indicate a fault status of the system
(hardware) itself.

Fault messages

Fault messages have the priority levels 1 to 3. Messages of this priority level are
used to signal limit value violations, for instance.

Switch messages

Switch messages have the priority level 4. Messages of this priority level are used
to indicate switching operations, e.g. Valve Open/Closed.

Hints

For each fault and switch message, a hint for the user can be configured in
Freelance Engineering. A hint of this kind gives the operator the cause of the
message, options for eliminating the process anomaly and, if necessary, further
hints for operation. Hints appear only in the hint list.

Hint messages

Hint messages have the priority level 5. Hints are exclusively displayed in the hint
list and serve for information purposes only.

Priority levels

Messages generated by the process stations can be of different importance for the
smooth operation of the process. The Freelance system provides six different
priority levels for messages. Four display colors are assigned to these priority
levels:
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Priority level Message type Display color

S1, S2, S3 System message blue
1 Fault message red
2 Fault message orange
3 Fault message yellow
4 Switch message yellow
5 Hint message white or yellow *)

*) A hint message is shown with a white background, if the hint does

not belong to an alarm or if the accompanying alarm is inactive.
A hint is shown with yellow background, if the accompanying
alarm is active.

ﬂ The same color is used to indicate the priority level of a message in the message
line, message list and faceplates.

Message acknowledgement

Messages can be acknowledged in two different ways: by visual acknowledgment
and by point acknowledgment.

ﬂ Visual acknowledgment does not replace point acknowledgment; but provides
an additional function.

Visual acknowledgment

With visual acknowledgment, the messages are marked as “viewed”. This type of
acknowledgment has no effect on the current message status in the process station.
It is available in the message line and the hint list.

By visual acknowledgment in the message line all listed entries are deleted.
However, they are still present in the message list. Through the acknowledgment in
the hint list the hint or hint message is marked as acknowledged. Acknowledging a
hint does not affect the acknowledgement status of the associated message.

The visual acknowledgment is limited to the operator station on which it was
performed.
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Point acknowledgment

This type of acknowledgment is available in the message list, faceplates and
graphic displays. If configured accordingly, it is also provided in the message line.
It causes the message in the process station to be acknowledged. This changes the
status of the message. The point acknowledgment has a system-wide effect as it is
transmitted by the process station to all connected operator stations.

Acknowledgment level

There are three different acknowledgment levels (1-3) for acknowledging
messages.

Acknowledgment level 1

This is the highest acknowledgment level. Messages with this acknowledgement
level must be acknowledged for incoming and outgoing messages.

Acknowledgment level 2

Messages of this level must only be acknowledged if they are incoming.
Acknowledgment level 3

Messages of this level need not be acknowledged.

A message is qualified as incoming when the situation that caused this message
has just occurred. The message is newly added to the message line and the message
list.

Example:
A limit value violation is managed as incoming message until the monitored value
reaches again the “normal range”.

A message is considered as outgoing when the situation that caused this message is
no longer active. In some cases, acknowledgment must be used to remove these
messages from the message line and the message list.

Example:
A limit value violation is qualified as outgoing message if it is no longer active and
the relevant value has reached again the “normal range”.
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Acknowledgment in the message line and message list

Depending on the configuration, visual or point acknowledgment are available in
the message line. The active acknowledgement type can be recognized by the
following symbols:

L)

Visual acknowledgement of message or

Point acknowledgment of message.

Only point acknowledgment is available in the message list. The appropriate
buttons can be found in the operation line.

This type of acknowledgment affects the message status. Possible combinations

are:
Acknow- | Incoming | Incoming Outgoing Outgoing Outgoing
ledgment | message | message message message message
level not acknow- not acknow- acknow-
acknow- | ledged acknow- ledged ledged
ledged once ledged once twice
1 Full Full symbol | Empty Empty Not visible
symbol static symbol symbol
flashing flashing static
2 Full Full symbol | Empty Not visible | Not visible
symbol static symbol
flashing flashing
3 Full Not visible | Not visible | Not visible | Not visible
symbol
flashing

An incoming message is active on the process station.

An outgoing message is no longer active on the process station.

The full symbol is displayed at the left side of the message list. It is displayed as
white or black text on a colored background. The background color depends on the

priority.
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The empty symbol is also displayed at the left side in the message list. It is
displayed as colored text on a gray background. The text color (number and sign)
depends on the priority.

Acknowledgment in the Hint List

The hint list only features visual acknowledgment. Visual acknowledgment does
not affect the appearance of the messages or their acknowledgment level in the
message list. The display of hints depends on the visual acknowledgment and the
message status.

Message incoming Message Message Message

and not incoming and outgoing and not | outgoing and
acknowledged acknowledged acknowledged acknowledged
Black text on yellow | White text on Black text on Not visible
background black background | white background

Message with sound files

Several sound files can be configured for individual process messages and for
message priorities in general. As these sound files are played successively without
any interruption, they are referred to as the “sound file” in the following text.

The sound files for a message priority can be played during a status change from
inactive to active and vice versa. The sound file for a specific process message is
triggered when the message status changes from inactive to active.

There are three different options for processing sound files in the operator station:
e  priority-controlled, oldest message,

e  priority-controlled, newest message,

e chronological order.

One of these options is selected during configuration in Freelance Engineering.
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The following section provides more detailed information on the processing of
sound files:

Priority-controlled, oldest or newest message

In addition to the entry in the message list, all incoming messages at the operator
station are stored in a cache while the sound file of a message is being played.
When the playback of the sound file is completed, all newly received messages are
checked and the next sound file to be played as per configuration is determined. If
the cache does not feature a “more important” message with sound file, the last
sound file is played again. Once the sound file has been played, the message entry
is deleted from the cache and the sound file for the following message is played.

The current sound file is replaced by a newly received message in the operator
station if the latter is “more important” according to the following criteria:

a. Incoming message status
An incoming message (status transition from inactive to active) is more
important than an outgoing message (change from active to inactive).

b. Higher message priority
The ascending order of message priority is as follows: 5, 4, 3, 2, 1, S3,
S2, S1.

c. Customized sound file
An individually configured sound file is more important than sound files
configured for the priority.

d. Time
newest message: a new message is more important than the former
message;
oldest message: in the case of equal importance according to criteria a to
¢, the sound file of the oldest message is played again.

Using the HORN off button or F12 key, the current sound file can be stopped and
the sound cache can be cleared.
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Chronological order

In addition to being added to the message list, all incoming messages (message
status changed from inactive to active) are stored in a cache in the correct
chronological order. Outgoing messages are not processed.

The configured sound file of a message from the cache is played once. Once the
sound file has been played, the message entry is deleted from the cache and the
sound file for the following message is played.

This sound file sequence determined by the system can be interrupted by the
operator. You can select a message in the message list and start the configured
sound file. After the current sound file has finished playing, this user-selected file
is played without any effect on the sound cache. Once this sound file has been
played, the next file to be played is determined according to the configured
algorithm.

If the sound file to be played is not available, a system message (priority S1) will
be triggered and an entry will be created in the Windows event log. If the sound
file for a priority S1 message is not found, this will only trigger the creation of an
entry in the Windows event log without an additional S1 message.

The configured message filter is applied to the playing of sound files.

Sound files are not loaded by Freelance Engineering. These files must be copied

E into the following directory of the operator station PC:

<FreelanceData>\wave

Message line

The message line indicates faults in the process in the form of a message.

The message line is at the top of the screen. This display area cannot be overlaid by
other windows and, thus, is always visible.
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Structure

The messages occurring can be displayed in three different view types. The view
can be changed using the toolbar or the View menu. The number of available views
can be limited by the configuration in Freelance Engineering. The toolbar provides
the following icons:

AEI Standard view
Indicates each message in a separate field.
A Plant view
=
=
Displays the associated number of messages for each plant area.
A_ List view

Shows the four most important messages of the message list.

The following overview shows all possible components of the message line,
depending on the selected view:

Hint field

A DD The ABB symbol is active and marked with an i if messages arrive for
which hints have been configured. The hint list can then be displayed.

FAD»

% If there are no hints there is no I in the ABB field.

Message fields

These fields include the following information:

e Standard view: Incoming messages
e Plant view: Plant areas with the number of messages
o  Listview: List with the four most important messages
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If the number of active messages cannot be displayed on the
screen, this field is shown with yellow background. This field
is not available in the plant view.

The number indicated is the number of all active messages
in this operator station. This field is not shown in the plant

view.

@ Visual acknowledgment or normal acknowledgment,
@® depending on the configuration. This button is not available

in the plant view.

w The control room or field horn is shown in color, when it is in
\ operation. It can be switched off using this button.

The next sections provide more information about the different views.

Standard view

Iy arizes Foriiee
[T Low Lew

Each message is indicated in a separate field. The tooltip for this field contains the
same information as the message list. The number of fields depends on the screen
resolution.

Standard view.png

The message field display provides two lines: the first line includes the tag name
and the second the message text configured for this tag.

In addition, the message line contains the field for the display of the message line
overflow, the field with the number of all messages included in the message list,
the button for acknowledging the displayed messages (i.e. the button for visual
acknowledgment or the button for point acknowledgment, depending on the
configuration), and the button to switch off the signal horn.

Via the ABB button you can switch to the hint list. The hint list gives information
on the issued messages, provided these have been configured in Freelance
Engineering and hint messages are available.
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It is recommended to select visual acknowledgment for this view. This allows you
to empty the message line upon a quick check of the alarm priority and to
recognize newly incoming alarms immediately.

If you use point acknowledgment for the message line, make sure to select the type
of configuration with the latest alarm appearing in the top left corner. All newly
incoming alarms are thus immediately visible.

Area view

Batch Reactor it 12 astester ares ares F ares §
s 1 0 s 2 0 °

Each plant area is displayed in a separate field. In addition to that, a plant area
called No Area is displayed. All tag messages that are not assigned to a specific
plant area, are displayed in this field. There is also a field called System, where all
system alarms can be found.

Area view.png

Information on the most important message for the relevant plant area is provided
in the form of a tooltip. This message defines the color and the flashing status of
the button.

When you click a plant area, the display area shows the messages for this plant
area. Via the ABB button you can switch to the hint list.

List view

List view.png

This view shows a list of the four most important alarm messages. The information
about the messages corresponds to the information in the message list.

Moreover, the message line contains the field for the display of the message line
overflow, the field with the number of all messages in the message list, the button
for acknowledging the displayed messages, and the button to switch off the signal
horn. Via the ABB button you can switch to the hint list.
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Operating the message line

Message selection

Q Left-click message

Calling up a faceplate

Q Double-click message (only possible in the standard view)
or
Select message> ENTER (only possible in the standard view)
or
Call up context menu of message > Left-click associated faceplate

Calling up assigned displays

Q Right-click message > Left-click the appropriate display

Point acknowledging or visual acknowledging of messages

Selecting the button Point-acknowledge message or Visually acknowledge
message in the standard view point-acknowledges or visually acknowledges all
messages currently visible in the message line. There are two options in the list
view: if a message has been selected, only this message will be acknowledged. If
no message has been selected, all visible messages are acknowledged. If the
overflow field is displayed with a yellow background, the subsequent messages are
displayed when the operating button is pressed.

Q Left-click Point-acknowledge message or Visually acknowledge message
or
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Set focus to message line with ALT + CURSOR KEY > A key or ALT + A

c The visual acknowledgment will not acknowledge messages in the message list!

Switching off the horn

Whether or not the field horn is turned off with the control room horn or by a
separately configured binary signal is defined during configuration. Furthermore, it
is defined in the configuration of each control station if acknowledgement of the
field horn causes the control room horn to be turned off.
Q Left-click Horn off button

or

menu Operate > Horn off

or

Set focus to message line with ALT + CURSOR KEYS > O key or ALT + O

or F12

Opening the hint list

The hint list shows hints about the issued messages.
ﬂ The button is only active when current hints or hint messages are available in
this operator station.
Left-click the button ABB

g or

Set focus to message line with ALT + CURSOR KEYS > H key or ALT + H

Message list

The message list contains all system messages (priority S1 to S3) and all process
messages of priority levels 1 to 4. Depending on the messaging configuration in
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Freelance Engineering, the oldest message can be shown either at the top or the
bottom of the list. In addition, it is defined in Freelance Engineering whether the
display of messages from certain process stations or plant areas or of messages of a
specific priority is suppressed.

E The maximum number of messages in the message list is determined by the
configuration of the operator station; it ranges between 10 and 4000 messages.

To call up different message lists (for the various plant areas), the default setting of
the priority filters can be changed. Once you have changed the priority filter
settings in a message list, you can select if this new setting is used again when you
call up the message list the next time or if you want the settings to be reset.

Q > Tools > Options
or
ALT>T>P

In the following dialog you determine which priority filter presetting is valid. You
can choose between the settings use last and select all.

Options X

General Signal sequence log
Cyelic backforward display switch Detail view colors:

Background
Faceplates always on top

Show display selection list:

Oleft @) right

I

Graphic display Trend display

(®) Use whole screen width Operation panel:

(0 Use whole screen height
® at top () at bottom

O Centered

Meszage list SFC display

Priority filter preset: 0 O Conrol Aec o

®) use last ) select all double click

Canca
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Options.png

Calling up the message list

v

AEAO «»

Left-click the symbol

or

> Display > Message list

or

Call up context menu > Messages

Clicking this symbol always calls up the entire message list containing all
messages of all plant areas.

In addition, it is possible to call up the area-specific message lists that can be
accessed from the message line in the respective area view only. Here, the plant
area filters are set such as to ensure that only the messages of the selected plant
area are displayed.

For calling up different message lists, the priority setting is evaluated.

Structure of the message list

The message list consists of a header, the list with the actual messages and the
operating element area for message acknowledgment, operation of sound files and
changing the display of the messages.

AC ¢ » BEMERFGGEE T 4 4 4

o EED FEFR

Message list overview.png
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Header

The header line contains information about the message list. The total number of
messages is indicated on the left hand side. On the right hand side colored boxes
indicate if any messages exist outside the currently displayed page. If a box is
highlighted with its priority color, messages of that priority are not visible on the
screen.

Several checkboxes are available to filter the messages. When you tick a checkbox,
the associated messages are shown. By a left-click on the non-indented checkboxes
on top of a list, all indented checkboxes arranged below are ticked/unticked.

The following options are available:

Priority Apart from selecting all messages, messages assigned to a certain
priority level can be hidden.

System message
Apart from selecting all messages, messages assigned to certain
system messages can be faded out.

Plantarea  Apart from selecting all messages, messages assigned to a certain
plant area can be faded out.

The messages are filtered as follows:

Left-click appropriate option

or

> Operate > Select filter > Select level

or

ALT > O > Use CURSOR KEYS to select filter > ENTER > Use CURSOR
KEYS or appropriate number keys to select level

or

Focus in display area > Use TAB KEY to select checkbox > Use SPACE BAR
to change checkbox

If there are more messages than can be displayed in the display area, this is
indicated by a scroll bar on the right edge of the area. The assigned priorities or
assigned system messages of the messages in the non visible display area are
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indicated by a color code under Further messages. The color corresponds to the
priority level.

List with messages

The display of process messages can be changed in the operating element area. The
Value, Long text and Long text / Message type formats are available for this
purpose. The formats differ in the type of information presented to the operator.
For system messages only a fixed display format is available.

The following overview shows the explanations of the individual formats. The
terms used are explained below the overview table.

Value Sound Prio | Time | Area | Tag S text ST text | Measured Type | Date
value, Dim.

Long text Sound Prio | Time | Area | Tag S text L text ST Text Date
Long text/ | Sound Prio | Time | Area | Tag S text L text Type Date
M.type
System Sound Grp | Time | Area | Tag Fault
message text

Sound Field specifying whether the message is associated with a

configured sound file. Only messages for which a sound file has
been configured during configuration are marked with the sound
symbol. General sound configurations for all messages of identical
priority in the local message configuration are not visualized here.

Prio Priority of the message with (+) prefix for incoming or (-) prefix
for outgoing. Indicates the priority level by appropriate digit and
associated color.

Grp System message group defined by the system (S1-S3).
Time Time of occurrence of the message; 1/1000 s resolution.
Area Plant area to which the tag is assigned.

Tag Designation of the tag that released this message.

S text Short text of the tag.

L text Long text of the tag.
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ST text Status text of the message.

Measured valueMeasured value recorded when the message was generated (e.g.
limit value).

Dim Dimension of the measured value.

Type A message type is assigned to each message. For limit values, the

message type corresponds to the configured limit value type (e.g.
HH for the second high limit value).

Date Only shown with the first message and after a date change. A date
change is indicated by a horizontal red line.

Operate menu

The Operate menu for the message list contains the following menu items:
- Priority filter
- System alarm filter
- Plant area filter
- Acknowledge block
- Acknowledge page
- Play sound file
- Stop sound file
- Horn off
- Format: Value
- Format: Long text
- Format: Long text/message type

Operating panel

The operating element area contains the followings buttons:
B
A
Acknowledge page
Point acknowledgment of all messages shown in the display area.
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5@%cknowledge block
Point acknowledgment of all messages previously selected in the display area.

€

Play Audio
Plays the audio file configured for the message.

ﬂ The Play audio file button can only be activated when an audio file has been
configured for the selected message. Once the button has been pressed, the
selected audio file is played on a cyclic basis.

Y
Stop Audio
Stops playing the audio file

Format: Value, Format: Long text, format: Long text/message type
These check boxes allow the display of the process messages to be
changed. See also List with messages, page 73.

ﬂ When the format is toggled, any empty lines in the list are deleted.

Messages with configured audio files

Messages with configured audio files are identified in the message list by the bell
symbol.

The assigned audio file can also be started manually.

Display of different priority levels

The different priority levels are displayed at the beginning of each list entry. The
following symbols are used:

Iﬁ
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The priority levels differ in background color and the appropriate digit.

Display of incoming and outgoing messages

The priority level of a message is indicated with a sign. The sign indicates the
incoming (+) or outgoing (-) status of the message. Incoming messages can also be
recognized by their colored background. Outgoing messages are marked by colored
text on a gray background. The symbol of unacknowledged messages is shown in
color and is flashing.

Operation of the message list

Calling up Faceplates

After selecting the message of a tag, the associated faceplate can be called up.

Q Double-click message
or
Call up context menu of message > Left-click associated faceplate
or
Set focus to message list with ALT + CURSOR KEYS > Use CURSOR KEYS
to select message > Use SPACE BAR to select message > ENTER

Calling up assigned displays

After selecting the message of a tag via the context menu, the displays assigned to
this tag can be called up.

Q Call up context menu of message > Left-click appropriate display
or
Use CURSOR KEYS to select message > Use SPACE BAR to select message >
SHIFT + F10 > Select display
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Acknowledging messages by page
B
A

All messages shown on the current page will be point acknowledged.

Q In operating element area: click Acknowledge by page
or
Operate > Acknowledge page
or
Alt, O, C

Acknowledging messages by block

................

All previously selected messages are point acknowledged.

Q Select messages > In operating element area: click Acknowledge by block
or
Select messages > Operate > Acknowledge block
or
Select messages > Alt, O, B

To provide a better overview, the gaps of the outgoing or deleted message in the
display area are only filled when the message list is scrolled.

Hint List

Each operator station has a hint list. The hint list provides information on messages
that may occur, provided these have been configured in Freelance Engineering.

When configuring the hint list, the configurator defines in Freelance Engineering
whether only the hints for process messages of priority 1 to 4 or also the hints with
message priority 5 are displayed. The hint list can be configured to show the latest
hints either at the top or the bottom of the list.
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Calling up hint list

The button for the hint list in the toolbar is only active if one or more hints or hint
messages are active.

AO® « »

Q Left-click toolbar icon

or

> Display > Hint list

or

In the message line: Left-click the ABB logo
or

Set focus to message page with the CURSOR KEY'S > H key and/or ALT+H

Structure of the hint list

The hint list consists of a header, the list with the actual hints, and the operating
element area with three buttons.

AEAQ «» BELERFEOLRE B 8|44 4

Favorites Hint list History
Hints total 1 Further messages: F E E F E
[~ Priority: [ Area:
[ [ Batch [ wastewater [FArea G J [A1Bio Mass A No Area
b2 Reactar [ AreaE H K N
13 [ Unit 12 A AreaF 1 L o}
14
5
89:57:86.7285 low low 86/29/18
Potilee
Hint list.png
Header

The header line contains information about the hint list. The total number of hints
is indicated on the left. On the right, priority boxes show whether hints overflow
the current page. If a box is highlighted with its priority color, messages of that
priority are not visible on the screen.
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Several checkboxes are available to filter the hints. When you tick a checkbox, the
associated hints are shown.

The following filters are available:

Priority

Apart from selecting all hints, hints assigned to a certain priority level can be faded
in or out.

Plant

Apart from selecting all hints, hints assigned to a certain plant area can be faded in
or out.

Q The messages are filtered as follows:

Left-click appropriate option

or

Operate > Select filter > Select level

or

Focus in display area > Use TAB KEY to select checkbox > Use SPACE BAR
to change checkbox

If there are more hints than can be displayed in the display area, this is indicated by
a scroll bar on the right edge of the area. The priority assigned to the hints in the
non visible display area is shown by a color code under Further messages. The
color corresponds to the priority level.

List with hints

All hints in the hint list are displayed in a uniform three line format.

Example:

@9:57:86.728S low low 86/29/18
Potilee

List with hints.png

The following information is available:
Line 1: Time Text
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Line 2: Tag Text
Line 3: Display name Text

The time field can be highlighted in yellow. Then the message has incoming
E status. If it is on a white background, it has outgoing status.

The terms used are explained as follows:

Time Time stamp of occurrence of the message. 1 ms resolution.
Tag Designation of the tag that released this message.
Text Configured hint text of up to three lines.

Display name The display assigned to the hint; can be called up via the button

in the operating area.

Operating the menu

The Operate menu for the hint list contains the following menu items:
e  Priority filter

Plant area filter

Acknowledge block

Acknowledge page

Display

Operating panel

The operating element area contains the followings buttons:

2 _ _ _
(@ Visually acknowledge page: Visual acknowledgment of all hints
shown in the display area.
RO Visually acknowledge block: Visual acknowledgment of all hints
selected in the display area.
Ly Display: Calls up the display configured for a hint.

80 Operators Manual — Freelance Operations



Messages and Hints Hint List

The Display button is only active if a display was configured for a hint in
Freelance Engineering.

Operating the hint list

Calling up faceplates

After selecting the hint of a tag, the associated faceplate can be called up.

Q Double-click appropriate hint
or
Call up context menu > Left-click tag name
or
Set focus to hint list with ALT + CURSOR KEYS > Use CURSOR KEYS to
select hint > Use SPACE BAR to select hint > ENTER

Calling up Assigned Displays

After selecting the hint of a tag via the context menu, the displays assigned to this
tag can be called up.

g Call up context menu of hint > Left-click appropriate display
or
Use CURSOR KEYS to select hint > Use SPACE BAR to select hint > SHIFT

+ F10 > Select display

Acknowledge Hints by Page

The acknowledgment of hints in the hint list is a visual acknowledgment only. It
does not affect the display of messages in the message list.

Q . By
In operating element area: Left-click &
or
Operate > Acknowledge page
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or
ALT>0>C

Acknowledge hints by block

All selected hints are acknowledged.

v )
Q Select hint > In operating element area: Left-click CQ)
or
Select hint > Operate > Acknowledge block
or
ALT>0O>B
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Section 4 Overview Display

General description — Overview display

The process information for the entire plant can be presented in concentrated form
in an overview display.

In the Freelance system, one overview display can be configured for each operator
station. When configuring the operator station, you can specify whether the default
display or a user-configured display is to be used as the overview display.

In the standard overview display the following display types can be selected: group
display, trend display, graphic display, time scheduler display, SFC display and
WEB-display. Logs can also be called up directly from the overview display. An
overview display comprises 16 lines of 6 columns; therefore up to 96 entries can be
configured.

Calling up an overview display

Via the toolbar:

AEAO

vh_e0013_us.png

Q Left-click the toolbar icon
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Via the Display menu item
Q Display > Overview display

or
ALT+I1>V

Via the context menu

Q Call up context menu > Select overview display

From a graphic display

Q Left-click graphic object with appropriate configuration
or
Use TAB KEY to select appropriate graphic object > ENTER
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Operation in the overview display

AEAD «-» BLNEIEGEEE R D E 44 L&
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]

Formulabon Fomul_SFC Mi1212Group

Reactor

Bio Mass Plant

Overview Display.png

If available, additional overview displays can be called up on additional pages
(tabs).

Display selection from the overview display

Q Left-click a display type symbol (group display, trend display, etc.)
or

Use CURSOR KEYS to select a display type symbol > ENTER
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Overview Display

Display type symbols

Group display

grp.png

Graphic Display

(the configured graphic is shown in miniature)

Bcrnas Pk

Graphic.png

Trend display

Trend.png
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Display type symbols

SFC display

sfc.png

Logs

=4

Log.png

Excel reports

A
v

Excel.png
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Dynamics in the group display symbol Overview Display

Time Scheduler Display

o]

Time Scheduler.PNG

WEB display

Web.PNG

Dynamics in the group display symbol

The group display symbol is the only dynamic symbol in the overview display.
Even in the overview display, this symbol makes it possible to gain rough
information on the types and statuses of the tags in the subsidiary group display.

General

Displays in red indicate that there is a message for the corresponding tag. If a
counter overflow occurs or measured values have passed out of their measuring
range, a yellow arrow is displayed for the tag in question.

88
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Controller

A bargraph depicts the control deviation in both positive and negative directions.
The bar graph display normally appears in green. If there is a message, it is shown
in red and in case of a deviation of more than 25% between setpoint and actual
value, a yellow overflow arrow is shown pointing up or down.

HIIH.H
N

vh_e0118.png

IDF

The small rectangle at the top, bottom or in the middle indicates the status of the
final control element (Off, Stop or On). The even smaller rectangle above and
below the center is always shown in color if a run arrow is displayed in the
subsidiary faceplate.

vh_e0117.png
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Mixed

Constants and user-defined function blocks

There are no dynamics for these function block types. A gray rectangle is displayed
to mark the used area in the group display.

]

]
e
2l &

vh_e0115.png

Counter and analog monitoring

A bargraph indicates the current counter position or analog value. An overflow or
undershoot is indicated by a yellow arrow in the bargraph.

vh_e0116.png
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FPX and PLI

The Freelance PhaseX (FPX) and Phase Logic Interface (PLI) function blocks are
interfaces between the 800xA Batch recipe package and the Freelance process

stations. The current state is indicated by colored rectangles and their position. For
more detailed information, please refer to Batch control function blocks, page 180.

vh_e0119.png
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Section 5 Group Display

General description — Group display

A group display is a combination of several faceplates. It offers the user the
opportunity of displaying related functions in one display. After selecting one of
the displayed faceplates the corresponding function is operable. The composition
of the group display is defined during configuration in Freelance Engineering.

In the group display, the faceplates are arranged in a grid. If it is not possible to
show all faceplates completely in the display area, scrollbars are provided.
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Calling up the group display

Via the toolbar

B [ [IF
= it [
vh_f0003_us.PNG

Q Left-click toolbar icon > Double-click the appropriate group display in the
display explorer

94 Operators Manual — Freelance Operations



Group Display

Calling up the group display

v

v

¥

¥

Via the Display menu item

Display > Group displays > Double-click the appropriate group display in the
display explorer

or

CTRL + F7 > Use CURSOR KEYS to select the appropriate group display >
ENTER

or

CTRL + F6 > Enter first letters of the display name > ENTER

Via the context menu

In order to call up a group display via the context menu, you must first select a tag
to which a group display has been assigned in Freelance Engineering using the
Display access function.

Select tag > Call up context menu > Select the appropriate group display

From the overview display

Left-click appropriate group display symbol

or

Use CURSOR or TAB keys to select appropriate group display symbol >
ENTER

From a graphic display

In order to call up a group display from a graphic display, a graphic object that
features the Show display action configured with a group display in Freelance
Engineering must have been previously selected.

Left-click graphic object with appropriate configuration
or
Use TAB KEY to select appropriate graphic object > ENTER
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Operating procedures in the Group display

You can directly operate the tags shown in the group display by clicking the
appropriate faceplate. All user actions can be performed as required, provided that
this has been enabled.

In addition, all tags of the group display are listed in the Operate menu. They can
be operated in the faceplate via the keyboard using the Alt + O key combination
and the CURSOR KEYS.

For more detailed information on operation in the faceplates, please refer to
Faceplates, page 133.
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General description — Graphic display

General description — Graphic display

Section 6 Graphic Display

In addition to standard displays such as overview display, group display or trend
display, it is possible to create plant-specific graphic displays. These graphic
displays can comprise a combination of static and dynamic elements and are

designed according to the requirements of the user.

The static part can be, for example, the schematic structure of the plant as
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Calling up a graphic display Graphic Display

Current process data and process state information can be presented in digital or
analog form (e.g. bar graph, fill level or trend) in the required position as a
dynamic foreground display.

Depending on the process status the graphic symbols can be alternated, the colors
or positions in the display can be changed or colors can flash.

With configurable display selection buttons and areas, a selection hierarchy for
operation can be created within the free graphic displays.

The shown graphic display together with an additionally called up faceplate
contains some options of displaying current process data in plant-specific form in
the Freelance system.

Calling up a graphic display

Via the toolbar

] |i8d] [127] LA [57]

vh_f0003_us.PNG

Q Left-click toolbar icon > Double-click the appropriate graphic display in the
display explorer

Via the Display menu item

Q Display > Graphic displays > Click the appropriate graphic display in the
display explorer
or
CTRL + F6 > Use CURSOR KEYS to select the appropriate group display >
ENTER
or
CTRL + F6 > Enter first letters of the display name > ENTER
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Via the context menu

In order to call up a graphic display via the context menu, you must first select a
tag to which a graphic display has been assigned in Freelance Engineering using
the Display access function.

g Select tag > Call up context menu > Select the appropriate graphic display

From the overview display

g Left-click the appropriate graphic display
or
Use CURSOR or TAB keys to select appropriate graphic symbol > ENTER

From a graphic display

In order to call up a graphic display from another graphic display, a graphic object
that features the Show display action configured with a graphic display in Freelance
Engineering must have been previously selected.

Q Left-click graphic object with appropriate configuration
or
Use TAB KEY to select appropriate graphic object > ENTER

Displaying a graphic display

The display of a graphic can be configured according to the monitor screen
resolution. The area available to display of a graphic varies due to different heights
of the menu and status bars, for example. A configured graphic display designed
for another resolution is scaled for display, keeping the aspect ratio unchanged.
Thus, either the full height or the full width of the available area can be utilized.

These settings can be made under Tools in the Options dialog box in the Graphic
display group.
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Show display over full screen width

Tools > Options > full screen width

The graphic display is shown over the entire width in the available graphic area
with the aspect ratio remaining unchanged. Depending on the display size and the
used monitor, the lower or right screen area may not be used or a part of the display
is clipped and can only be reached by using the scrollbar.

Show display over full screen height

Tools > Options > full screen height
The graphic display is shown over the entire height in the available graphic area
with the aspect ratio remaining unchanged. Depending on the display size and the

used monitor, the right screen area may not be used or a part of the display is
clipped and can only be reached by using the scrollbar.

Show display centered

Tools > Options > Centered

The graphic display is centered on the screen.

Operating procedures in the Graphic display

Additional to the visualization of process data each dynamic graphic object can be
configured with an action. This action is performed by a single click.

Four types of action are available for each dynamic graphic object alternatively:
e Display or log selection

e Faceplate selection
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e  Writing of process variables

¢  Message acknowledgement

Selecting a display via a graphic display

It is possible to jump to other graphic displays using a configured dynamic graphic
object. This display change is initiated by left-clicking the graphic object.

Selecting a faceplate

It is possible to call up any faceplate using a configured dynamic graphic object.
This faceplate is called up by double clicking the graphic object.

Writing of Process Variables

Using a dynamic graphic object, the analog and binary process variables can be
changed. There are different options to manipulate process variables:

e You can write a new process variable in an edit field. Confirm the writing
action with OK or ENTER. You can cancel the writing action at any time with
ESC.

¢ You can continuously manipulate process variables by permanently clicking
graphic elements (e. g. arrow keys).

e You can manipulate process variables within a certain range by shifting a
graphic element (e. g. a cursor in a bargraph).

Acknowledging messages

Depending on the configuration, a single left mouse click will acknowledge one or
several messages.
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Dynamic display elements

mr| 400

IDF

Dynamic.png

Displaying analog values

Analog values can be displayed using bar graphs, fill levels, graphic symbol
positioning and, of course, alphanumeric displays.

Bargraph

Display of analog values by filling a rectangular form, with the rectangle being
filled horizontally or vertically.

Fill level
Similar to a bar graph, but the area to be filled may be of any shape.
Symbol position

Symbols can be moved continuously based on an analog value.
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Alphanumeric display

Display of analog values in numerical form in different sizes and colors.

Changing analog values

¥

Left-click the adjustable numerical value > Change value > J

or
Controllable values can also be changed by scrolling the appropriate cursor.

Subsequently confirm with
or

Use the TAB key to select appropriate numerical value > ENTER > Change
value > ENTER

Displaying binary signals

If configured, the color of graphic objects will change depending on the values of
binary signals; depending on binary states, graphic objects may also be displayed
in different positions.

Trend window in the graphic display

The temporal progression of up to six measurement values can be followed in a
trend window. Unlike the trend display, the trend window in the graphic display
does not include a history. This means that the trend window does not start
displaying curves until the graphic display is called up.
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Trend window in graphic.png

Operations in the trend window can always be performed via the context menu,
and in some cases via the toolbar icons — however the toolbar icons are only visible
if configured accordingly in Freelance Engineering. Below you can see the toolbar
icons, next to the menu items.

Selecting tracks

[SetPoint TiC1] By pressing the button with the variable name, the respective track
is selected and can be operated in the Operate selected track menu.

Operating tracks
Call up context menu > Operate selected track
Here you will find all operating options for a track. The associated five buttons

(bottom left corner in the trend window) change color depending on the track
selected in the upper left section of the trend window.
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JUp Shifts the selected trend upwards.

ﬂ Down Shifts the selected trend downwards.

ﬂ Zoom +  Reduces the displayed measuring range for the selected trend by
half (curve increase)

ﬂ Zoom Doubles the displayed measuring range for the selected trend
(curve decreases)

[ setPaint TIE1I Show

The track selected in the context window or marked in the symbol
is displayed in the trend window - in the example track LI704.

- Select color
Here you can modify the trend color.
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Time axis

Q Call up context menu > Operate time axis

Here you can find all operating features of the time axis.
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These buttons (bottom right corner in the trend window) always remain the same.

ﬂ Time scroll right>>
Scrolls the selected trend to the right (towards the present).

ﬂ << Time scroll left
Scrolls the selected trend to the left (toward the past).

ﬂ Zoom + Reduces the displayed time range by half (stretches the curve in
horizontal direction).
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ﬂ Zoom — Doubles the displayed time range (compresses the curve in
horizontal direction).

ﬂ The trend window in the graphics display does not save the settings specified
in the operating dialog. Each time it is called up the display commences with
the originally configured settings.
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Trend Display General description — Trend display

Section 7 Trend Display

General description — Trend display

A trend display is the visual representation of a trend recorder. It shows the
chronological progression of analog and binary process variables as trend curves in
an X-Y coordinate system, where up to six process variables can be graphically
represented in a display. Trend displays can be configured in Freelance
Engineering and defined by an operator station user. In order for a trend display to
be defined by an operator, a trend server must have been configured in the project.
In a trend display, the operator can zoom in and out, show and hide, and scroll the
display of the measured values.

There a two types of trend acquisition: the Trend server is used for the acquisition
of any variable — even for a trend from different process stations. This trend server
makes all the variables in the project available to the trend displays in the operator
stations. The minimum acquisition time for this is 1 second. The trend server does
not store any historical values, but provides instantaneous values only. The
archives are created and saved on the operator station.

The trend acquisition block allows process values with extremely fast data changes
to be acquired directly in the process stations. Thus, the acquisition time is the
same as the task cycle time. Two types of archives are available: a short-term and a
long-term archive:

Short-term archive with trend acquisition block

When selecting a trend display associated with a trend acquisition block, the short-
term history of the individual trends is displayed. In this moment, 200 process
values per trend are read from the process station. Then - per second - the 30
current process variables are written into the short-term archive.
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Short-term archive with trend server

Upon selection of a trend display associated with a trend server, no historical data
are available. One value per track is read in the data acquisition cycle. If the trend
display remains switched off, it will increase continuously due to newly acquired
values. The short-term history can be stored for a short time only. After this period,
older values are cleared from the memory when new values are received. When the
short-term archive with trend server is closed, all historical data are lost.

Long-term archive

The long-term archive saves data for display of historical information that go
beyond the short-term archive time, regardless of whether or not the associated
trend display has been called. With a long-term archive associated with a trend
acquisition block, the data are recorded in a trend acquisition block of the process
station. A maximum of 200 process values with time stamp are transferred from the
process station to the long-term archive in each archiving cycle. The data for the
long-term history are stored in the form of archives on the operator station's hard
disk. This archive can also be copied by FTP (File Transfer Protocol) to an FTP
server. The target can also be a disk drive of an operator station. Using the Archive
Browser add-on program, these files can subsequently be displayed and converted
into CSV format for further processing.

For data acquisition with a trend server, the process data is read in the configured
cycle time of the trend server and saved in the operator station. Long-term
archiving corresponds to the long-term archiving of trends from an acquisition
block, with the exception that only one value per track is archived in each
archiving cycle.

E Although the number of trend server based long-term trends is not limited by

the configuration, it depends on the PC’s performance. Missing track parts or
slow reactions of Freelance Operations — up to inoperability of the system —
may indicate that the system is overloaded. In this case, it is recommended to
reduce the number of long-term archives or to extend the archiving cycle
(acquisition cycle).
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Start-up characteristics

After changes have been made in Freelance Engineering and downloaded to the
operator station, the trend display appears with the configured values. Previous
changes of the display characteristics made by the operator after the last download
are lost and replaced by the configured values. Operator-made changes of the
visualization are stored in Freelance Operations. The next time it is called up, the
trend display appears again with these settings until the next download to the same
trend.

ﬂ If the system time is set back by a time that is longer than the trend acquisition
cycle (task cycle time * scan-down factor), the current trend archive file is
closed and a new trend archive file is created.

Operating the menu

The Operate menu for the trend display contains the following menu items:

e Select
- <List of process variables>
e  Operate selected track
- Up
- Down
- Zoom +
- Zoom -
- Show
- Select color
- Select marker
e Time axis
- Time scroll right >>
- Time scroll right >
- < Time scroll left
- << Time scroll left
- Zoom +
- Zoom -
- Cursor >
- <Cursor
e  Options...
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e Reset
e File transfer

Calling up atrend display

Via the toolbar:

Call up trend.png

Q Left-click toolbar icon > Double-click appropriate trend display in display
explorer

Via the Display menu item

Q Display > Trend displays > Double-click appropriate trend display in display
explorer
or
CTRL + F8 > Use CURSOR KEYS to select the appropriate trend display >
ENTER
or
CTRL + F8 > Enter first letters of the display name > ENTER

Via the context menu

In order to call up a trend display via the context menu, you must first select a tag
to which a trend display has been assigned in Freelance Engineering using the
Display access function.

g Select tag > Call up context menu > Select the appropriate trend display

112 Operators Manual — Freelance Operations



Trend Display

Defining the trend display

v

¥

From the overview display

Left-click appropriate trend display symbol

or

Use CURSOR or TAB keys to select appropriate trend display symbol >
ENTER

From a graphic display

In order to call up a trend display from a graphic display, a graphic object that
features the Show display action configured in Freelance Engineering must have
been previously selected.

Left-click graphic object with appropriate configuration
or
Use TAB KEY to select appropriate graphic object > ENTER

Defining the trend display

In Freelance Operations, the operator can define up to 20 own trend displays. Each
display can comprise up to six user-defined project variables. For this purpose, a
trend server must have been configured and installed in Freelance Engineering.
User-defined trend displays are intended for short-term records / analyses related to
a specific situation or for optimization purposes. If you need a trend for a longer
period of time, please contact your configuration engineer to have the trend
configured in Freelance Engineering.

User-defined trend displays can be changed, exported, or deleted at any time. A
trend display that was previously exported can be imported again as new display.
All these operations are carried out in the operation dialog for user-defined trend
displays. In this dialog, all existing user-defined trends are displayed.

ﬂ When loading data from Freelance Engineering into an operator station, the

user-configured trend displays may be deleted. For this reason, it is
recommended to export user-defined displays and then re-import them, if
required.
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Opening the operation dialog for user-defined trend displays

F O] 3 [

Call up UDT.png

Q Left-click toolbar icon
or
Tools > Define trend displays

The operation dialog is opened. The list of the existing user-defined trend displays
and all operating options are displayed.

User Defined Trends >
Insert Edit Delete
=] (=

User defined trend.png

Create new trend display

Open the operation dialog for user-defined trend displays.
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Q Tools > Define trend displays > INSERT > Enter name > OK

The new trend display is defined in the subsequent dialogs:

Parameters: User Trend Display *
Name: Reactor3
Long text:

Acquistion  Archive

Variable MName: Short text: Dimension: Allocated tag:
Trend 1: |

Trend 2: |
Trend 3: |
Trend 4: |
Trend 5: |
Trend &: |

Cancel Help

Define trend display.png

Name Max. 12 characters (without spaces)
Long text Max. 30 characters for free-form text

Acquisition tab
Display cycle time
This cycle time is used for refreshing the trend display.

Sample time  Cycle time for the acquisition of new trend values.

Variable Name of the variable whose values are acquired in the trend.
Pressing function key F2 displays the list of variables known in the
system for selection.

Name, Short text, Dimension
These texts are displayed with the trend curve in the display. After
a variable is selected from the list, the variable name is used as
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name and the first 12 characters of the variable comment as short
text. The text can be modified freely.

Allocated tag A tag can be assigned to each trend curve. Using the F2 function
key the available tags are displayed in a list for selection.

Archive tab

On this tab you define whether and how trend data is to be archived.

Parameters: User Trend Display x

Name: Reactord

Long tex: |

Acquisition  Archive

Enable archiving:
Delete old archive:  []

Archive name: Reactor

Archive duration: TH1d Disk space req. KByte

Concdl |t

Archive Trend.png

Enable archiving
Tick this check box to archive trend data. Please also refer to
archive name and archive duration.
If this check box is not ticked, no archive file will be created; the
trend data are acquired and displayed as long as the trend display is
shown.

Delete old archive
Tick this check box to delete the old archive when the operator
station is rebooted (restart of Freelance Operations).

Archive name The name of the trend is automatically entered as the archive name.
This name cannot be changed.
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Archive duration
Enter the archive duration according to IEC 61131-3 time format.
The period can be entered in days, hours, minutes and seconds.
Minimum value 1 s, maximum value: 1d = 1 day.
Examples: T#1d or T#20h31m23s

ﬂ The archiving duration defines the size of the archive file. This size cannot be
exceeded as the data are stored in a ring buffer. This means that once the
archival period has been reached the current data always overwrites the oldest
data.

User-defined trend displays are intended for short-term records / analyses

ﬂ related to a specific situation or for optimization purposes. If you need a trend
for a longer period of time, please contact your configuration engineer to have
the trend configured in Freelance Engineering.

Disk space req.
The space required for the archive is automatically displayed in
kilobytes next to the edit field for the archive duration.

Saving trend display

After all dialogs are edited, the definitions are saved with OK. The data that has
been entered is checked and tested for plausibility. If any errors are encountered,
these will be displayed.

ﬂ When loading data from Freelance Engineering into an operator station, the
user-configured trend displays may be deleted. For this reason, it is
recommended to export user-defined displays and then re-import them, if
required.

Edit trend display

Open the operation dialog for user-defined trend displays.
g Select appropriate trend display > EDIT
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The same dialogs as for creating a trend display are shown. All entries can be
changed.

Q Save the changes with OK.

Deleting a trend display

Open the operation dialog for user-defined trend displays.

Q Select appropriate trend display > DELETE

The selected trend display is deleted without security dialog.

Exporting a trend display

Open the operation dialog for user-defined trend displays.

Q Select appropriate trend display > EXPORT

Path: C\FreelanceData\projUDT1.UTR

OK Cancel

Export a trend.png

You can change the displayed directory and file name. The definition of the
selected trend display is stored in a *.UTR file.

Importing a trend display

Open the operation dialog for user-defined trend displays.
Q > IMPORT
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Import user-defined trend >
Path: | ‘\FreelanceData\proj.UTR
Conce

Import a trend.png

In the displayed path, enter the name of the file to be imported and click OK.

The system checks whether a trend display with the same name as the import file
already exists on the Freelance Operations station. If a trend display exists you can
decide whether to overwrite the existing trend with the imported data or whether to
create a new trend display with a new name.

Operations in the trend display

AGA D+ » BEEDDEERE % A& 4D

Trend display.png

After having accessed the trend display, three new icons are shown on the right
side of the toolbar.
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In the Tools / Options menu of Freelance Operations you can define whether the
value and dialog area is shown above or below the curve.

Value area and dialog area

Name 8CS SCE Actual Cursor  Unit Short text Allocated tag

1Toe B @A ¥ ¢+ | Level 000 100.00 4417 4417 cm LT1 Lic1
2, m @A ¥ T Feedwater 000  100.00 059 059 th FT1 FIC1
EREC Q a + 1t Setpoint TIC1 0.00 100.00 30.00 3000 °C ASP_T TIC1
Ly Q Q + 1t ProcessValueTIC1 0.00 100.00 28.86 2886 °C PV_T TIC1
The value area lists all variables with trends in this display and the associated
information:
Name Name of the variable
SCS Scale start for this trend on the Y axis
SCE Scale end for this trend on the Y axis
Actual The current value of the process variables
Cursor The present value of the process variable at the position of the
cursor
Unit Unit of the process variable
Short text Configured short text for this trend
Allocated tag Name of the assigned tag
The operation buttons are located on the left in the dialog area:
Switch cursor on/off
LS Color selection for the trend curve
Ol Zooms in trend curve (value range)
Sl Zooms out trend curve (value range)
b4 Scroll trend curve downward
B A Scroll trend curve upward
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Showrhide trend curve

Selecting a trend in the value area

g Left-click the appropriate trend in the value area

or
Use TAB KEY to go to value area list > Use CURSOR KEYS to select
appropriate trend

When the trend is selected in the trend area, the scaling configured for the trend is
displayed on the left of the X-Y coordinate system. The scaling is shown with the
same color as the trend curve.

Switching the cursor on and off

g In the dialog area left-click ==
or

Use TAB KEY = to select > Toggle with SPACE BAR

Setting the color of the trend curve

Q In the dialog area, left-click color symbol
or
Use TAB KEY to select color symbol > Toggle with SPACE BAR

The color selection dialog is opened.

This dialog window shows all available colors in a list. The colors are sorted by
usage groups that can be shown/hidden.

The individual color groups can be selected by a left-click on the switches
STATIC, MESSAGE, SIGNAL, MEDIA and FREE (keyboard: TAB key and
ENTER).

To reduce the number of colors displayed in the list, mark only the color groups to
be shown.
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Q Left-click appropriate color in color selection list > OK
or
Use CURSOR KEYS to select appropriate color > ENTER

Zooming the trend curve infout

The zoom function affects the scaling of the Y axis.

Q In dialog area, left-click @\ or El

This will produce the same effect as the change of the band start % and band
end %.See also Trend curve settings, page 128.

Scrolling the trend curve vertically

Q In dialog area, left-click x or 23

The zero point of the trend is moved upward or downward along the Y axis. This
will produce the same effect as a simultaneous increase or decrease of the band
start % and band end %. See also Trend curve settings, page 128.

Showing/hiding the trend curve

Q In dialog area, left-click or [

The trend curve is shown or hidden.

Calling up assigned displays

If the appropriate tags are assigned, a trend can be selected in the value area and
the displays associated with is tag can be called up via the context menu.
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Operations in the trend display

V

¥

Trend area

Select appropriate trend in value area > Call up context menu > Select
appropriate display

To open the faceplate of the assigned tag:

Double-click selected trend in value area
or
Select appropriate trend in value area > Call up context menu > Select tag

The individual trends are displayed as curves in an X-Y coordinate system. There
are two scale settings for the Y axis: on the right hand side it is always a scaling
in %. On the left hand side it is scaling of a selected trend in physical units. The
scaling is displayed in the same color as the trend curve.

The X axis represents the time line. Depending on configuration or operation, the
time display can be relative or absolute.

Below the coordinate system is a horizontal scroll bar, to adjust the visible time
window backward in time to analyze the trends.

By using an adjustable cursor, past behavior of trends can be evaluated and
compared.

The trend values are always acquired with the system time. The displayed time axis
is

labeled with the current time. Times during daylight saving time period are marked
with an S. This ensures that no time gaps or double curves in the trend display
result from the changeover from

normal time to daylight saving time or vice versa.

Time gaps within a trend curve are displayed by vertical red lines at the beginning
and end. The size of a gap can be configured in the parameter definition mask of
the trend display (see Engineering Manual, Operator Station, Standard
Display, Trend Display). If no time gap detection, is configured, the threefold
cycle time is displayed as a gap. Example: With a cycle time of 10 seconds, a data
gap of 30 seconds is shown as a gap in the trend, even if no gap detection has been
configured.
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Trend area.png

Cursor adjustment

B8:23:17.6645

Cursor adjustment.png

After calling up a trend display the cursor appears at the top of the right side Y
axis. The time-of-day or the deviation to local time is shown in the cursor area.

Q In trend area, left-click the X-Y coordinate system at the height of appropriate
time
or

Repeat left-click switch &%=
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Operations in the trend display

time

or

Repeat pressing ALT + < or ALT + > until cursor is positioned at appropriate
time

Scrolling the displayed time range in the trend display

The time window for the trend display can be scrolled by the horizontal scroll bars
or switches below the X-Y coordinate system. When the trend display is opened,
the zero point (current time) is always located at the right edge of the time line.

The time window can also be scrolled with the buttons below the X-Y coordinate
system:

ALT + Z; Scroll time window in small steps to the left (step width
one scale unit)

ALT + T; Scroll time window in small steps to the right (step
width one scale unit)

ALT + C; Scroll time window in large steps to the left (step width
one screen width)

ALT + S; Scroll time window in large steps to the right (step width
one screen width)

When the time window is scrolled to the left, the time display on the X axis
changes automatically from relative to absolute.

Scaling the displayed time range in the trend display

To facilitate the analysis, the X axis (time axis) can be expanded or compressed.
This alters the resolution of the time axis.
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ALT + +; Expands the time axis (each click doubles the display
width, which means that the time segment is cut in half)

ALT +—; Compresses the time axis (each click cuts the display
width in half, which means that the time segment is doubled)
Trend Display Options

In the Trend display options operation dialog, the displayed trend can be set. These
settings refer to the general layout of the trend display as well as to the adjustment
of individual trend curves.

Opening the options operation dialog

After having accessed the trend display, three new icons are shown on the right of
the toolbar.

b 4 [BHO

Operation in trend.png

Q Left-click the toolbar icon
or
Operate > Options
or
ALT+0>0
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Operations in the trend display

Setting and changing options

Trend Display Options

Time interval

Duration: Units:
720 s =
Position at: Set

|5.I'1 212015 14:43:27.363

¥ Currentvalues

Value window

=
-~

oK

Colors
Foreground Produkt A ==
Background

Window

Archive status:

Cancel

On

LI720(Sinusg) ==

PHEER

Reset |

SET
Current values Current process values are shown on the right border of the X axis.

Operation in trend.png

Trend display settings

Time interval
Duration

Range of the time window on the X axis for the trend display.

Position at:  Enter point in time (for positioning window at a specified time on
the trend curve).

Set the window to the specified position.

The x axis shows relative time values.

Colors

You can adjust the colors for Foreground, Background and Window of the trend
display.

A click on the appropriate color field opens the color selection list.

A click on Reset restores the default colors.
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Archive status Archive status display
On Archive is running

Idle Archive status is controlled by the SEN function block input
of the assigned trend data acquisition unit

Emergency stop
Internal emergency stop; the archive was stopped due to an internal

fault.
Off No archive
OK All inputs are accepted and checked for plausibility.
Cancel All inputs are rejected; the dialog window is closed.
Reset All settings are reset to the configured values:

Trend display colors,

trend curve colors,

value window settings,

start of band, end of band,

start %, end %,

time range (jump to present = current time).

Trend curve settings

Product <A> >>
This button label is an example for the variable, here “product
<A>”. The number of buttons corresponds to the number of trends
configured for this trend display. These buttons are used to open
the respective operation dialog for the trend specific settings:
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Options TempLight900_PV
Y- li
-scaling OK
Band start Band end
| | |35.D | - Cancel
o | 100 - o
Interpolation Marker Color
(_) Mene (®) None
(®) Linear O Pixels
O Steps )] Rectangle
Trend curve settings.png
Y-scaling

The options Band start and Band end define the scaling of the Y axis for this trend.
The position on the Y axis of the band start and band end can be set between 0%
and 100% using band start % and band end %.

The band start setting must always be less than the band end. This also applies
H to the band start % and band end %. The percentage values can be less than 0%

and more than 100%. In this case, the part of the trend outside the range

between 0% and 100% will be displayed as a line above 100% or below 0%.

Band start and band end must be entered as real values. The value range is between
0.0 and £999999999.9. The percentage values for band start and band end must be
entered as integer values. The value range is between -5000 and +5000%.

Interpolation Select None, Linear and Steps.
Marker Select None, Pixel or Rectangle for the display of the cursors.

ﬂ If you select both for Interpolation and Marker the option None, the trend curve
is not visible!
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Marker

Interpolation Mane Foint/Fixels | Rectangle

Mone invisikle

e
.

Steps

di0559us.png

Trend color  Define the color of the trend curve display. See also Setting the
color of the trend curve, page 121.

RESET This button resets all settings for this trend curve to the default
values including the Y-scaling, the markers, the interpolation, and
the
color.

Resetting all settings

The changed settings of all trends can be reset to the default values.
b £ 133O

Left-click the toolbar icon
or
Operate > Options > Reset

Saving the trend file

A copy of the trend archive file can be saved on the configured disk drive.

This is only possible for trend displays that have been configured accordingly in
Freelance Engineering.
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4

File transfer.png

3 O[]

Q Left-click the toolbar icon
or
Operate > File transfer

Operators Manual — Freelance Operations 131



Operations in the trend display Trend Display

132 Operators Manual — Freelance Operations



Faceplates General description — Faceplates

Section 8 Faceplates

General description — Faceplates

In a faceplate you can observe and operate the associated tag. The information
shown in the faceplate is cyclically polled and updated. This means, the faceplates
always indicate the current state of the connected process.

Faceplates provide both overview and detail information on tags. They can appear
on the screen combined with either pre-configured or freely configurable displays.

The time scheduler and the SFC have their own pre-configured full-screen
operation displays. Each other operable function has a preconfigured faceplate. In
addition, some non-operable functions also have preconfigured faceplates to
support the observation of the current process state.

Programming, configuration or display access are not required, as the faceplate
becomes available immediately after the function block is defined.
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Faceplates
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A faceplate can be moved freely around the display area of the screen. For safety
reasons, the faceplate cannot overlap the message line. In dual monitor mode, it
cannot be shifted from one screen to the other either. In this case, the cursor must
be moved to the second monitor in order to call up the appropriate faceplate on this
monitor. A displayed faceplate stays on the screen until it is closed or replaced by
another faceplate. A faceplate will thus remain on screen even when the display in
the background is changed, such as during a change from an overview display to
the message list.

A maximum of 5 faceplates can be displayed simultaneously on the screen. If you
open an additional faceplate, the system simultaneously closes the faceplate which
had not been activated for the longest period.

For further general information on the handling of faceplates, please refer to
Operating Philosophy, page 19.
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ﬂ For more detailed information on function blocks of the Freelance system,
please refer to the Engineering Reference Manual, Functions and Function
Blocks.

Calling up a faceplate

A faceplate can be displayed by several methods. When the appropriate tag is
selectable on the screen (e. g. in a graphic display), the associated faceplate can be
called up directly via the context menu. A tag in the tag list of the graphic display
explorer can be selected and displayed with the associated faceplate in any
operating situation, please also refer to Operating Philosophy, page 19.

Via the toolbar:

| e [1FY] [A

Call up faceplate.png

Q Left-click toolbar icon > In display explorer double-click the appropriate tag

Via the Display menu item

Q Display > Via tag list > In display explorer double-click the appropriate tag
or
CTRL + F5 > Use CURSOR KEYS to select the appropriate tag > ENTER
or
CTRL + F5 > Enter first letters of the tag > ENTER

Via the context menu

To call up a faceplate via the context menu, a tag must be selected first.

Q Right-click the tag or an area in the current display to which a tag has been
assigned > Left-click tag name in the context menu
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From a group display

The group display is a configured collection of several faceplates (see Group
Display, page 93.

g Double-click the appropriate faceplate
or
ALT + O > Use CURSOR KEYS to select the appropriate faceplate > ENTER

From a graphic display

In order to call up a faceplate from a graphic display, a graphic object that features
the Open faceplate action configured in Freelance Engineering must have been
previously selected.

g Double-click graphic object with appropriate configuration
or
Use TAB KEY to select appropriate graphic object > ENTER

From the message list

Q Double-click appropriate message
or
Use CURSOR KEYS to select the appropriate message > ENTER

Structure and operation of faceplates

Basic structure and operation of faceplates

All faceplates have an identical basic structure. This provides important
information about the displayed tags which can be instantly recognized.

The faceplates feature an identical width; there are two types that differ in height:
the normal height faceplates occupy half the height of the display area, for function
blocks with minor information content, there are small faceplates that only require
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1/2 of this height. Thus, two small faceplates can be placed in the group display in
the space required by one normal faceplate.

ﬂ User-defined faceplates, especially those taken over from older program
versions, can deviate from this scheme.

All normal-height faceplates are built up as follows:

C_CS: FICe01
FIC601
Value5| Limits |
100.00
T PV 0.0000
Ll sP 0.0000
Out 0.0000

!ﬁ

VIA[®
aj D|J|

The small faceplates only consist of title line, faceplate header, and display of
actual value, combined with an operating element area, if necessary.

vh_i0009_us.png

M_BOUT : Conveyor

vh_i0009a_us.png
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Title line and faceplate header

DOS : DOS2

DOS2
Dosing 2

Faceplate header.png

The title line of the faceplate contains the abbreviation of the corresponding block
type (e.g. DOS) and the tag name. On the right edge, the pin button to fixate the
display and the close button are located. When a faceplate is selected, the title line
and the entire frame around the faceplate have a dark blue background.

While the tag name is displayed in the faceplate header, the short text of the
respective function block is shown below. Further information can include a tooltip
with the configured long text.

For messages the faceplate header is displayed with a colored background
according to the configured priority and a caution icon. Similar to the message line,
this colored background flashes as long as the message has not been acknowledged
(see Messages and Hints, page 57).

In each faceplate you can acknowledge all present messages of a tag by left-
clicking the caution icon.

Message area

%,
Faceplate message.png

In the message area all configured messages of the tag, for which a message
priority has been assigned, are displayed as icons. In the event of a message, the
color changes or the icons flash depending on the priority. There is a tooltip for
each icon that shows the configured message text.

In addition to the messages, the tag status like the track mode can be visualized in
the message area.
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The messages for the tag are always shown in the faceplate, even if these
messages are not visible in the message line and message page because of the
filters that been configured for the station.

Icons in the message area of faceplates

The following table lists all icons available in the message area of faceplates. The
designations of the limit value types are shown in the message list.

Icon Limit type; Meaning

M
b~ =

HL; Process value is greater/smaller than configured limit value

HH or LL; Process value is greater/smaller than configured limit
value / high priority

; H_XD or L_XD; Monitoring of maximum/minimum control
difference

ﬁ E HH_XD or LL_XD; Monitoring of maximum/minimum control
difference / high priority

Z LH_XD; Monitoring of the size of control difference

f& DHs, DHm, DHh or DLs, DLm, DLh; Monitoring a

maximum/minimum change

M DHHs, DHHm, DHHh or DLLs, DLLm, DLLh; Monitoring a
maximum/minimum change rate / high priority

&)
o H_V or L_V; Monitoring of a ratio limit value
L20
o OF HH_V or LL_V; Monitoring of a ratio limit value / high priority
4
e BREAK; Cable break
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TEMP; Overtemperature
ERROR; Error (only function block types IDF_1, IDF_2, IDF_A)

FLT_TIME; Runtime error (only function block types IDF_1,
IDF_2, IDF_A)

END_POS; End position error (only function block types IDF_1,
IDF_2, IDF_A)

PROTECT; Safety intervention (only function block types IDF 1,
IDF_2, IDF_A)

LOC_OP; Local intervention (only function block types IDF_1,
IDF_2, IDF_A)

TORQUE; Torque (only function block type IDF_A)

S H 2> OFe

=
=

BINARY:; Monitoring a binary state
TIME; Monitoring a time overflow or underflow
LV; Monitoring a limit value

US; User-defined alarm message (only function block type
M_GEN)

TIME_OV; Time overflow (only function block type TUNE)

& BWO!

NOISE; Noise level (only function block type TUNE)

MOVE; Excessive movement (only function block type TUNE)

— STAT; Not enough movement (only function block type TUNE)
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Y_LIMIT; Internal or external limit of the correcting variable
(only function block type TUNE)

Be ¥

TRACK; Tag is working in track mode

Graphic field

Overview

500.00

il Out 239.14

il IR 0..20 mA

L DV 0.0000
00000

vh_i0103_us.png

The graphic field of a faceplate displays the current values and states of the
function block in the form of an overview.

The most important analog variables in a block are displayed along with their
associated limit, basic or overflow values as scaled bargraphs with corresponding
markers. They may also feature the corresponding engineering units. Two related
values, e. g. set point and actual value or current and previous counter value are
indicated through two nested bargraphs; the changing actual value is generally
framed within the usually static set point. If the operator can change the external
value, a green rectangle is shown to the right of the bargraph. You can shift this
triangle along the bargraph as required using the mouse to set the displayed process
variable to a new value.
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v

Faceplates for functions monitoring the limit values of an analog value show these
limit values as small triangular markers on the left side of the actual value
column. The limit value marks always relate to the analog value displayed in the
actual value column.

For blocks with discrete current statuses, texts for identifying the current status are
displayed in the graphic field instead of the bargraphs. A current status is
highlighted in yellow.

Depending on the function block, the displayed process variables can be arranged
in the graphic field on up to three tabs labeled Values and Limits or Absolute, Ratio
and Limits.

Display and operation in the graphic field

All numerical values that can be changed or set by the operator (operator-
controllable values) are denoted by gray highlighting.

Selecting tabs

Left-click appropriate tab (Values, Limits, etc.)

or

Use TAB KEY to select current tab > Use CURSOR KEY to select appropriate
tab

Changing values in the graphic field

Left-click adjustable numerical value> Change value > OK

or

Use TAB KEY to select appropriate numerical value > ENTER > Change value
> ENTER

or

Move appropriate marker of the adjustable value using the mouse > confirm

new value with

E If the entry confirmation button is not actuated within 5 seconds, the input

field is closed automatically and the previous value is restored.
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For further operations, please refer to Operating element area, page 144.

Symbols and Abbreviations in the Graphic Field

The display of the actual value in the graphic field uses the same symbols as the
message area (see Message area, page 138). The used abbreviations and their
meaning are listed in the following table.

Abbreviation Description

A Function block output

B Bias

BA Batch ID

BV Basic value

CA Counter actual value

CD Derivative gain

CID Campaign ID

Constant Function block output

CP Counter last period

Cyc Number of program cycles
DH Configured default value High
Dim Engineering unit (dimension)
DL Configured default value Low
DT Delay time, Switch-on time
DV Default value

EM Execution mode

F Failure register

FB Feedback

IN Function block input

LO Lot ID

MV Manual value

Off Time scheduler offset

OR Output range (signal range)
Out Output variable

PC Proportional coefficient

PD Pulse duration

PS Pre-threshold value

PV Process value

R Ratio

RP Recipe ID
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RQ Request command

RT Runtime

RV Resetting value

S Shut-off value

Scale end High scale limit

Scale start Low scale limit

Sec Time scheduler sections
Sl Step index

SP Set point

ST Status register

T Runtime since start resp. configured time in time scheduler
TC Time, current value
Type Configured timer type

Operating element area

LAMQJ
_|_ @0

The current operating modes of the function block are displayed in the operating
element area and can be toggled. The counter blocks can be reset by pressing a
button.

vh_i0104.png

All operable buttons are marked with black icons, those that cannot be operated
with gray icons. Current states are denoted by yellow buttons.

Terminating operation

Operations in the faceplate must generally be terminated by the ENTER key or by

the J button in the operating element area, to ensure that value changes are
effective in the process station.
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Faceplates Structure and operation of faceplates

Continuous change of controller correcting variable and set point

The controller function blocks enable continuous adjustment of set point and
correcting variable. For this purpose, the buttons feature colored triangles, the color
of which corresponds to the associated bargraph: green for the set point and yellow
for the correcting variable.

VA

arrow_yelllowgreen.png

Q Left-click appropriate controller button > Keep left mouse button pressed or
repeat clicking until the appropriate value is reached.

The current value is shown as tooltip.

ﬂ A value change made with these buttons is directly written into the process
station. No confirmation (with ENTER) is required.

While the button is pressed and held, changes are written into the operation log on
a cyclic basis.

Buttons in the operating element area of faceplates
Button Description

I Status toggle: 0/1 or operating mode Off/On for time scheduler
function block

Status toggle, stop or operating mode stop for time scheduler
function block

Toggle permanent/cyclic

Toggle manual/automatic

E&[] @ O
kAo

Toggle internal/external
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Structure and operation of faceplates Faceplates

@ @ Toggle run/stop

O Reset actual counter value to basic value or 0 or reset running time
to0
J-L Triggering scan pulse

Toggle internal/external ratio

@ @ Toggle ratio/fixed value

(yellow); Decrease/increase correcting variable

' “ (green); Decrease/increase set point
AL

Coarse dosing/fine dosing/close valve

TUNE function block: Use PID parameter set of TUNE function
block or user parameters

o be

TUNE function block uses internal or user program
Stationarity

Scheduling off/on

Definition of controller dynamics: high, medium, low

Abort mode for batch function blocks FPX and PLI

“= X <25 ol o D

14
i Hold/Restart mode for batch function blocks FPX
and PLI
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Faceplates Structure and operation of faceplates

I I I ’ Pause/Resume mode for batch function blocks FPX and PLI

1
@ oo Skip/Scroll mode for the time scheduler block
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Analog function blocks

Faceplates

Analog function blocks

Counter with analog input, CT_ANA

CT_ANA
AnalogCount A

~] =
120.00 ppm
cA 64.00
= cP 100.00
BV 0.0000
[ 99.00
= 0.0000

CT_ANA_us.png

Set point controller, C_ANA

C_ANA
SetPointCtr

C_ANA_us.png

Display: Message area

Icons for the configured high and low limit values, if they are
configured as messages.

Display: Numerical values

CA Counter actual value
CP Counter last period
BV Basic value

2 Limit values with icons for the configured

limit value types

Display: Graphical display

CA actual counter value as actual value bargraph

CP last counter period as set point bargraph

The scale range and engineering unit are valid for both
bargraphs. Limit values as marks on counter position bargraph

Operator interventions

Changing basic value and limit values.
Resetting counter.

Acknowledging of messages.

Display: Numerical values
Out Output value

MV Manual value
R Ratio
B Bias

Display: Graphical display
Output value as actual value bargraph with scale range and
engineering units

Operator interventions

Operating mode for input

or manual value: toggle manual/automatic

Operating mode for ratio and bias: toggle internal/external
Changing manual value MV (only in manual mode)
Changing internal values of ratio R and bias B
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Faceplates Analog function blocks

Time scheduler, TS

Display: Numerical values
Tab Act show the current values:

Out Current output value

Sec Current section

T Runtime since start

Cyc Number of program cycles

EM Execution mode (Off, Stop, On, Skip, Scroll)
Tab Nom shows the nominal values:

Out Current output value

Sec Number of configured sections

T Runtime in time scheduler, time marker on set trend
Cyc Number of configured program cycles

OFF Offset set point
Display: Graphical display
Current output value Out as bargraph with scale range

Operator interventions

Changing the number of set cycles and offset values
Operating mode for output value: toggle manual/automatic
Toggling between permanent/cyclic mode

Changing execution mode Off/On/Stop/Skip/Scroll

For further details on operation, please refer to SFC Display,
page 185

TS_2_us.png
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Analog function blocks

Faceplates

Analog input transformation,

AI_TR_us.png

Analog input transformation,

AI_TRT_us.png

Al_TR

Display: Message area

Icons for overflow and underflow, if they are configured as
messages.

Icon for cable break message

Display: Numerical values

Out Converted analog value

OR Output range (0...20 mA or 4...20 mA)
DH Default value

DL Default value

If a default value is effective, the analog value

A will be displayed in red.

Display: Graphical display

Analog value A as bargraph with scale range

DH and DL default values as horizontal cursors at the left side of
the bargraph

Operator interventions
None

transient Al_TRT

Display: Message area

Icons for measuring range violation (Low) and transient violation
(High), if they are configured as a message.

Icon for cable break message

Display: Numerical values

Out Converted analog value

OR Output range (0...20 mA or 4...20 mA)
DH Default value

DL Default value

If a default value is effective, the analog value
A will be displayed in red.

Display: Graphical display

Converted analog value A as bargraph with scale range and
engineering unit, DV default value as horizontal cursor on the left
side of the bargraph

Operator interventions
None
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Faceplates Binary Function Blocks

Analog output transformation, AO_TR

Display: Numerical values
Out Converted analog value
OR Output range (0...20 mA or 4...20 mA)

Display: Graphical display
Analog value IN as bargraph with scale range

Operator interventions
None

J

AO_TR_us.png

Binary Function Blocks

Binary output, M_BOUT

Display: Display
Current status with configured status texts

Operator interventions

Operating mode for function block output: toggle manual/automatic
Toggling output between state 0 and 1 (only in Manual mode)

MBOUT_us.png
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Binary Function Blocks

Faceplates

Monoflop, MONO_F

[ 00:00.000|

MONO_F_us.pngg

Display: Message area
Icon for time message, if a message has been configured for the
set output.

Display: Numerical values
TC Time, current value
PD Pulse duration

Display: Graphical display
Pulse duration and elapsed time as bargraphs with scale range
Status of the output ON (logic-1 signal)/OFF (logic-0 signal).

Operator interventions
Change PD pulse duration within the valid scale range
Premature abort by reset (output Out is set to logic-0 signal)

Timer, switch-on/off delay, TONOF

[ 00:00000

TONOF_us.png

Display: Message area
Icon for time message, if a message has been configured for the
set output.

Display: Numerical values
TC Time, current value
DT Switch-on time

Display: Graphical display
Pulse duration and elapsed time as bargraphs with scale range
Status of the output ON (logic-1 signal)/OFF (logic-0 signal).

Operator interventions
Change DT switch-on time within valid scale range
Premature abort by reset (output Out is set to logic-0 signal)
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Faceplates

Binary Function Blocks

Timer, switch-on delay, TON

TON_us.png

Timer, switch-off delay, TOF

TOF_us.png

| 00:00.000

| 00:00.600|

Display: Message area
Icon for time message, if a message has been configured for the
set output.

Display: Numerical values
TC Time, current value
DT Delay time

Display: Graphical display
Pulse duration and elapsed time as bargraphs with scale range
Status of the output On (logic-1 signal)/Off (logic-0 signal).

Operator interventions
Change DT delay time within valid scale range
Premature abort by reset (output Out is set to logic-0 signal)

Display: Message area
Icon for time message, if a message has been configured for the
set output.

Display: Numerical values
TC Time, current value
DT Delay time

Display: Graphical display
Pulse duration and elapsed time as bargraphs with scale range
Status of the output On (logic-1 signal)/Off (logic-0 signal).

Operator interventions
Change DT delay time within valid scale range
Premature abort by reset (output Out is set to logic-0 signal)
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Binary Function Blocks Faceplates

Timer with external time input, TIMER

Display: Message area

%EE Icon for time message, if a message has been configured for the
© set output.
_ Display: Numerical values
— . e Time, current value
pT | oo:30000| DT Switch-on resp. delay time
Typ | MONOF| Type Indication of timer behavior MONOF, TON, TOF, or
< TONOF
Display: Graphical display
0 Switch-on or delay time and elapsed time as bargraphs with scale
0 J range
[CR Status of the output On (logic-1 signal)/Off (logic-0 signal).

TIMER_us.png
Operator interventions
Changing switch-on resp. delay time DT
Premature abort by Resetting
Toggling between internal/external
mode for the switch-on or delay time

Timer counter, CTT

Display: Message area

Time((:i-lo-{mter Icons for the configured high and low limit values, if they are
I~ configured as messages.
Display: Numerical values
02:00:00
_ o CA Counter actual value
cP CP Counter last period
2 limit values with icons for the configured
B limit value types (for the meaning of the symbols, please refer to
= Icons in the message area of faceplates, page 139)
T Display: Graphical display
0 J Current counter value as bargraph with scale range
Counter value of the last period as bargraph with scale range
CTT_us.png Scale range limit values as marks on position bargraph

Operator interventions
Changing limit values
Resetting time value output to
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Faceplates

Binary Function Blocks

Up/Down counter, CTUD

CTUD

=
0.0000

Up_and_Down
==
1000.00 WXWXWXWX
- cA
eV
B
=

CTUD_us.png

Pulse counter, CT_P

|

=

CP
PD

CT_P
ImpulseCount
= b~
Valuesl Lirmits |
500.00 IMPULSE
CA
e RV

CT_P_1_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.

Display: Numerical values

CA Counter actual value

BV Basic value

2 limit values with icons for the configured limit value types (for the
meaning of the symbols, please refer to Icons in the message area
of faceplates, page 139)

Display: Graphical display
Counter actual value as bargraph
Basic value as bargraph

Scale range and engineering units
Limit values as marks on bargraph

Operator interventions
Changing limit values
Resetting counter

Display: Message area
Icons for the configured high and low limit values, if they are
configured as messages.

Display: Numerical values

Values tab

CA Counter actual value
RV Resetting value

CP Counter last period
PD Period length

Limits tab

CA Counter actual value

2 limit values with icons for the configured limit value types (for the
meaning of the symbols, please refer to Icons in the message area
of faceplates, page 139)

Display: Graphical display
Counter actual value as bargraph
Counter last period as bargraph
Scale range and engineering units
Limit values as marks on bargraph
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Binary Function Blocks Faceplates

Operator interventions
Changing limit values
Resetting counter

CT_P_2_us.png

Operating time counter, CT_LT

Display: Message area
Icons for the configured limit values, if configured as messages.

Display: Numerical values

CA Counter actual value
CP Counter last period
Dim Engineering unit; seconds (sec), minutes (min), hours

(hour), 2 limit values with icons for the configured
limit value types Icons in the message area of faceplates, page
139)

Display: Graphical display
Counter actual value as bargraph
Counter last period as bargraph
CTLT us.png Scale range

Limit values as marks on bargraph

Operator interventions
Changing limit values
Resetting counter

156 Operators Manual — Freelance Operations



Faceplates Binary Function Blocks

Frequency/analog converter, FAC_D
Display: Display
Analog output signal as numerical value with engineering units.

Operator interventions
None

FAC_D_us.png

TOUCH button

Display: Display
Current button state with configured status texts.

(CoPEN | Operator interventions
Trigger scan pulse

4

TOUCH_us.png
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Controller function blocks

Faceplates

Controller function blocks

Continuous standard controller, C_CS

C_Cs
Contin Stand

AN X
Vaies)| Limits |
110.00 %
PV 0.0000
SP 0.0000
oo
Qut 0.0000
u.uuuu< pay % 100

LAﬂﬁJ
o] imliad

C_CS_1_us.png

A

A X
Values i—'"’"tg
110.00 %
PV 0.0000
- 100.00
A 0.0000
P 80.00
X 10.00
Eee—
0.0000 A % o
VAMWJ
[l 7Rt

C_CS_2_us.png

Display: Message area

Icons for the configured limit values, if configured as messages.

Display: Numerical values

Values tab

PV Process value

SP Set point

Out Qutput variable

Limits tab

PV Process value

4 limit values with icons for the configured

limit value types (for the meaning of the symbols, please refer to

Icons in the message area of faceplates, page 139)

Display: Graphical display

Process value as bargraph

Set point as bargraph

Scale range and engineering units
Qutput variable as horizontal bargraph
Limit values as marks on bargraph

Operator interventions

Operating mode for output variable: toggle manual/automatic

Operating mode for set point: toggle internal/external

Changing set point SP

Changing output variable Out (in manual mode, only)

Changing limit values
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Faceplates

Controller function blocks

Continuous universal controller, C_CU

c_cu
ContinUniver
= A
Valuesl Limits |
500.00 kg/m®
PV 0.0000
- sp 0.0000
Out 0.0000
-« =
00 A % 100
VA0 J
[ol;=
C_CU_1_us.png
c_cu
ContinUniver
M~ A Y
Values | Limits|
500.00 kg/m®
PV 0.0000
- [y 400.00
= 0.0000
A 50.00
8 0.0000
-l « B
400 A % o]
Y|A|a]o J
_ 1=k

C_CU_2_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.
Icon for operating mode Track, if this mode is active.

Display: Numerical values
Values tab

PV Process value

SP Set point

Out Output variable
Limits tab
PV Process value

4 limit values with icons for the configured
limit value types (for the meaning of the symbols, please refer to
Icons in the message area of faceplates, page 139)

Display: Graphical display

Process value as bargraph

Set point as bargraph

Scale range and engineering units
Output variable as horizontal bargraph
Limit values as marks on bargraph

Operator interventions

Operating mode for output variable: toggle manual/automatic
Operating mode for set point: toggle internal/external
Changing set point SP

Changing output variable Out (in manual mode, only)
Changing limit values
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Controller function blocks

Faceplates

Continuous ratio controller, C_CR

s
]
Ahsnlulel Ratin |L\mm; |
100.00 bar
PV 50.00
SP 50.00
Out 50.00
R 1.0000
B 0.0000
[SSes===
u.mmu< o Py 100
YAl® ol J
ofE-o
C_CR_1_us.png
CCR
RatioContin
?.
S|
Absolute |Rﬂtlﬂ| Limits |
11.00 °C
RV 1.0000
SP 50.00
Out 50.00
R 1.0000
B 0.0000
===
5000 o Fa i
YA[® of J
ol Ok}
C_CR_2_us.png
A
¢
]

C_CR_3_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.
Icon for operating mode Track, if this mode is active.

Display: Numerical values
Absolute tab

PV Process value

SP Set point

Out Output variable

R Ratio

B Bias

Ratio tab

RV Current ratio value

SP Set point
Out Output variable

R Ratio

B Bias

Limits tab

PV Process value

4 limit values with icons for the configured
limit value types (for the meaning of the symbols, please refer to
Icons in the message area of faceplates, page 139)

Display: Graphical display

Absolute and Limits tabs

Actual value and set point as bargraph

Scale range and engineering units

Output variable as horizontal bargraph

Limit values as marks on bargraph

Ratio tab

Current ratio value and set ratio as bargraph with ratio scale range
and engineering units

Ratio limit values as marks on bargraph

Operator interventions

Operating mode for output variable: toggle manual/automatic
Operating mode for set point: toggle internal/external
Changing set point SP

Changing output variable Out (in manual mode, only)
Toggling between ratio control and fixed value

control

Changing ratio and bias

Changing limit values
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Faceplates Controller function blocks

Standard step controller C_SS

Display: Message area

658 Icons for the configured limit values, if configured as messages.
= =
Vatues| Liits | Display: Numerical values

400000 Values tab

- pv | 628002 PV Process value

SP 500.00 SP Set point

‘F’: :ggg Out Output variable

: FB Feedback*

= Limits tab

« === PV Process value .
W s w8 @ 4 |imit values with icons for the configured
Y AO|® 2 J limit value types (for the meaning of the symbols, please refer to
&0 Icons in the message area of faceplates, page 139)

C_SS_1_us.png

c 88 Display: Graphical display
Process value as bargraph
N = Set point as bargraph

Values | Limits| Scale range and engineering units
9000.00 Limit values as marks on bargraph

PV 628002) Feedback as horizontal bargraph*
=~ [ 20000  The current direction of action of the output variable is indicated by
2 aogos  arrows above the horizontal bargraph.
<

(=

8000.00 . ] o . .
Bo00To0 Right arrow: positive step output is active

= Left arrow: negative step output is active

< E%é] _ _
S e 2 W Qperator interventions
Y|A[O]# EJ Operating mode for output variable: toggle manual/automatic
__ =gl Operating mode for set point: toggle internal/external
c_sS_2_uspng Changing set point SP
Changing output variable Out (in manual mode only)
Changing limit values

=

*With activated feedback, the FB position feedback appears as a bargraph and as a
numerical value. If feedback is interrupted, i.e. if the FBF signal is 1, an empty
field appears instead of the numerical value. The FB column than also disappears.

** |f external position feedback has been configured

and is active, you can change the output value by entering a value in the

number field or moving the slider. Without effective external feedback (external
feedback in Freelance Engineering is disabled or FBF signal is set to logical 1), the
output variable can be changed only incrementally using the yellow triangle
buttons. The Open and Close buttons are end position commands that cause the
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Controller function blocks

Faceplates

actuator to move in the respective direction for the motor positioning time plus the
max. runtime factor. This movement can be stopped by briefly pressing one of the
yellow triangle buttons.

c_su

Vﬂlu55| Limits |

9000.00

PV 2965.01
SP 500.00
Qut 29.00
FB 29.00

L

=

500.00 [T 100

LAQWQJ
Nl [clEs!

C_SU_1_us.png

c_su

Values |Limi|s|

2965.01
2500.00

500.00
8000.00
8000.00

C_SU_2_us.png

Universal step controller C_SU

Display: Message area
Icons for the configured limit values, if configured as messages.
Icon for operating mode Track, if this mode is active.

Display: Numerical values
Values tab

PV Process value

SP Set point

Out Output variable
FB Feedback*
Limits tab

PV Process value

4 limit values with icons for the configured limit value types (for the
meaning of the symbols, please refer to Icons in the message area
of faceplates, page 139)

Display: Graphical display

Process value as bargraph

Set point as bargraph

Scale range and engineering units

Limit values as marks on bargraph

Feedback as horizontal bargraph*

The current direction of action of the output

variable is indicated by arrows above

the horizontal bargraph.
Right arrow: positive step output is active
Left arrow: negative step output is active

Operator interventions

Operating mode for output variable: toggle manual/automatic
Operating mode for set point: toggle internal/external
Changing set point SP

Changing output variable Out (in manual mode only)
Changing limit values

*With feedback switched on, the position feedback FB appears as a bargraph and
as a numerical value. If feedback is interrupted, i.e. if the FBF signal is 1, an empty
field appears instead of the numerical value. The FB column than also disappears.

Operators Manual — Freelance Operations



Faceplates

Controller function blocks

** |f external position feedback has been configured and is active, you can change
the output value by entering a value in the number field or moving the slider.
Without effective external feedback (external feedback in Freelance Engineering is
disabled or FBF signal is set to logical 1), the output variable can be changed only
incrementally using the yellow triangle buttons. The Open and Close buttons are
end position commands that cause the actuator to move in the respective direction
for the motor positioning time plus the max. runtime factor. This movement can be
stopped by briefly pressing one of the yellow triangle buttons.

Ratio step controller

C_SR

A

SEES
Absolute | Ratia | Limi

[

- BPVF—==

ts|

V| A|O[®

C_SR_1_us.png

10.00

C_SR
SEE o

Absolute |Rﬁli\1|L\mns |

i

C_SR_2_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.
Icon for operating mode Track, if this mode is active.

Display: Numerical values
Absolute tab

PV Process value

SP Set point

Out Output variable

FB Feedback*
Ratio tab
RV Ratio value

SP Set point
Out Output variable

R Ratio

B Bias

Limits tab

PV Process value

4 limit values with icons for the configured
limit value types (for the meaning of the symbols, please refer to
Icons in the message area of faceplates, page 139)

Display: Graphical display

Absolute and Limits tabs

Process value as bargraph

Set point as bargraph

Scale range and engineering units

Limit values as marks on bargraph

Feedback as horizontal bargraph*

The current direction of action of the output variable is indicated

arrows above the horizontal bargraph.
Right arrow: positive step output is active
Left arrow: negative step output is active

by
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Controller function blocks Faceplates

—— Ratio tab
> Current ratio value and set ratio as bargraph with ratio scale range
M= s and engineering units

Ratio limit values as marks with bargraph

Absolute |Ratm |Lim“3|

4069.99 Operator interventions
250000,  Operating mode for output variable: toggle manual/automatic
50000)  Qperating mode for set point: toggle internal/external
8.7000 . .
Changing set point SP

- 1300 Changing output variable Out (in manual mode only)

_ < =1 Toggling between ratio control and fixed value

5w 5 smw  control
Y/ AlQO[®[® J Changing ratio and bias
@)= Changing limit values

C_SR_3_us.png

P

<

4

olo
»

e

0O

*With feedback switched on, the position feedback FB appears as a bargraph and
as a numerical value. If feedback is interrupted, i.e. if the FBF signal is 1, an empty
field appears instead of the numerical value. The FB column than also disappears.

** |f external position feedback has been configured and is active, you can change
the output value by entering a value in the number field or moving the slider.
Without effective external feedback (external feedback in Freelance Engineering is
disabled or FBF signal is set to logical 1), the output variable can be changed only
incrementally using the yellow triangle buttons. The Open and Close buttons are
end position commands that cause the actuator to move in the respective direction
for the motor positioning time plus the max. runtime factor. This movement can be
stopped by briefly pressing one of the yellow triangle buttons.
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Faceplates

Controller function blocks

Standard two position controller C_OS

c_os
TwoPos Stand &

[ E L
Valu95| Limits |
100.00 kcal
PV 50.00
= SP 50.00
Out 50.00
« Qutputi
= [m===—==]
=
0.0000 0 iy 00
VA&
o) i
c_os

1_us.;;
ng

c_0S
TwoPos Stand M

> [
Values | Limits
100.00 keal
PV 50.00
& B 85.60
e 3.4000
q = 90.00
= 10.00
= [===="I
0.0000 0 2 100
Y|A|8[S J
| 1=fO e

C_0S_2_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.

Display: Numerical values

Values tab

PV Process value

SP Set point

Out Output variable

Current status of output variable OB Gray background: output is
passive, yellow background output is active (activated).

Limits tab

PV Process value

4 limit values with icons for the configured

limit value types (for the meaning of the symbols, please refer to
Icons in the message area of faceplates, page 139)

Display: Graphical display

Process value as bargraph

Set point as bargraph

Scale range and engineering units
Limit values as marks on bargraph
Output variable as horizontal bargraph*
Limit values as marks on bargraph

Operator interventions

Operating mode for output variable: toggle manual/automatic
Operating mode for set point: toggle internal/external
Changing set point SP

Changing correcting variable OUT and, thus, changing binary
output OB according to the configured pulse-width modulation
(manual mode only)

Changing limit values

Operators Manual — Freelance Operations

165



Controller function blocks

Faceplates

Universal Two Position Controller, C_OU

c_ou
TwoPos Uni
= X
Valu55| Limits |
100.00 |
. PV 0.0000
SP 0.0000
Out 0.0000
Output
e
i n.ul]l]l]‘ A o 100
AAVNEN 2 J
[El=lhd

C_OU_1_us.png

c_ou
TwoPos Uni
M~ = X
Values L"E"':g
100.00 |
e PV 0.0000
[ 96.00
= 0.0000
X 10.00
[E======5|
i n.uuuu‘ i % 100
Y]A| 9] J
[Cs]

C_OU_2_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.
Icon for operating mode Track, if this mode is active.

Display: Numerical values

Values tab

PV Process value

SP Set point

Out Output variable

Current status of output variable OBGray background: output is
passive, yellow background output is active (activated).

Limits tab

PV Process value

4 limit values with icons for the configured limit value types (for the
meaning of the symbols, please refer to Icons in the message area
of faceplates, page 139)

Display: Graphical display

Process value as bargraph

Set point as bargraph

Scale range and engineering units
Output variable as horizontal bargraph
Limit values as marks on bargraph

Operator interventions

Operating mode for output variable: toggle manual/automatic
Operating mode for set point: toggle internal/external
Changing set point SP

Changing correcting variable OUT and, thus, changing binary
output OB according to the configured pulse-width modulation
(manual mode only)

Changing limit values
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Controller function blocks

Standard controller, three position C_PS

Al

B ]
\lalue5| Limits |

100.00 %

- PV 50.00
SP 50.00

ouT 50.00

< Output 1
Output 2
21 72

[E==S==SS|

0.0000 0 Ay 100
LAﬂﬁJ

ol imlhad

C_PS_1_us.png
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e PV 50.00
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C_PS_2_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.

Display: Numerical values

Values tab

PV Process value

SP Set point

Out QOutput variable

Current activation status of binary

outputs OB1, OB2 with the Output 1 and Output 2 text fields.
Gray background: output is passive, yellow background output is
active (activated).

Limits tab

PV Process value

4 limit values with icons for the configured limit value types (for the
meaning of the symbols, please refer to Icons in the message area
of faceplates, page 139)

Display: Graphical display

Process value as bargraph

Set point as bargraph

Scale range and engineering units

Output variable as horizontal bargraph

Limit values as marks on bargraph

Parameterized split points as arrows at the control value bargraph
(Their displayed height corresponds approximately to the Y1, Y2
characteristic line split points and indicate the relationship and pitch
of the characteristic line.)

Operator interventions

Operating mode for output variable: toggle manual/automatic
Operating mode for set point: toggle internal/external

Changing set point SP

Changing the output variable Out and with it the binary outputs
Outputl and Output2 in accordance with the configured split-range
characteristic and pulse-width modulation (in manual mode, only)
Changing limit values
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Controller function blocks

Faceplates

Universal controller, three position C_PU

C_PU
ThreePos Uni

Value5| Limits |
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Display: Message area
Icons for the configured limit values, if configured as messages.
Icon for operating mode Track, if this mode is active.

Display: Numerical values

Values tab

PV Process value

SP Set point

Out Output variable

Current activation status of binary

outputs OB1, OB2 with the Output 1 and Output 2 text fields.
Gray background: output is passive, yellow background output is
active (activated).

Limits tab

PV Process value

4 limit values with icons for the configured

limit value types (for the meaning of the symbols, please refer to
Icons in the message area of faceplates, page 139)

Display: Graphical display

Process value as bargraph

Set point as bargraph

Scale range and engineering units

Output variable as horizontal bargraph

Limit values as marks on bargraph

Parameterized split points as arrows at the control value bargraph
(Their displayed height corresponds approximately to the Y1, Y2
characteristic line split points and indicate relationship and pitch of
the characteristic line.)

Operator interventions

Operating mode for output variable: toggle manual/automatic
Operating mode for set point: toggle internal/external

Changing set point SP

Changing the output variable Out and with it the binary outputs
Outputl and Output2 in accordance with the configured split-
range characteristic and pulse-width modulation (in manual mode,

only)
Changing limit values
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Faceplates Controller function blocks

Controller selftune TUNE

TUNE_1_us.png TUNE_2_us.png

Display: Message area

Limit value icons: Low, High, NOISE, STAT, MOVE, OUT_LIMIT, TIME_OV Icon for
operating mode Track, if this mode is active.

Display: Numerical values

Values tab

PV Process value, currently controlled variable
Out Current control value

T Current test step duration

ST Current selftune status (see page 170)

Err Error code (see page 170)
Tune Parameter tab:

PV Process value, currently controlled variable
CP Proportional coefficient CP

TR Reset time

TD Rate time

CD Derivative gain

Display: Graphical display

Actual value as bargraph

Scale range and engineering units
Output variable as horizontal bargraph
Limit values as marks on bargraph

Operator interventions

Starting and stopping parameter selftune

Toggling PID parameter set between selftune and user-defined parameters
Defining controller dynamics

Defining stationarity

Toggling parameter scheduling
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Controller function blocks

Faceplates

Current selftune status ST:

Text

OFF
NOISE
STEP1 S
STEP1 M
BREAK
STEP2_S
STEP2 M
CANCEL
READY

Description

Selftune Off, no controller parameters have yet been determined
Noise level measurement; noise level is determined

Wait for movement after first test step

Wait for stationarity after first test step

Stop test step, wait for stationarity

Wait for movement after second test step

Wait for stationarity after second test step

Selftune canceled due to error, error cause indicated by error code
Selftune complete, controller parameters have been determined

Errors ERR occurred during selftuning:

Text

TIME_OV

NOISE
STAT
MOVE
LIMIT_Y
WSTART
oK

Description

Time overflow

Noise level

Too much movement
Not enough movement
Output limited

Break for warm start
No error
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Faceplates

Monitoring function blocks

Monitoring function blocks

Analog monitoring, M_ANA

M_ANA_us.png

Binary monitoring, M_BIN

M_BIN_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.

Display: Numerical values

IN Input signal

4 limit values with icons for the configured limit value types (for the
meaning of the symbols, please refer to Icons in the message area
of faceplates, page 139)

Display: Graphical display
Input signal as a bargraph with scale range and engineering units
Limit values as marks on bargraph

Operator interventions
Changing limit values

Display: Message area
Icon of binary message, if a message has been configured.

Display: Display
Message status with configured messages

Operator interventions
None

Binary monitoring of antivalence, M_BAV

|

M_BAV_us.png

Display: Message area
Icon of binary message, if a message has been configured.

Display: Display
Message status with configured messages

Operator interventions
None
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Open loop control function blocks Faceplates

Event message, EVENT

Display: Display
Event . .
Event Message status with configured messages

Operator interventions
Ps None

J)

General message block, M_GEN

Display: Message area
Icon for configured limit value, if configured as message

EVENT_us.png

MGEN

B
Display: Display
SMO UNLOCKED Message status with configured messages

J Operator interventions
None

Open loop control function blocks

Messages of control function blocks

Error e.g. from motor control unit via binary input

Runtime Caused by exceeding the configured runtime; the defined time
from control
command to achieving the end position was exceeded.

End position error
Caused by leaving the end position without a control command; a
static arrow in the graphical area indicates the last command.

Safety intervention
Caused by an external signal, selected statuses are locked for safety
reasons.
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Faceplates Open loop control function blocks

Local intervention
An external binary signal is sent to the individual drive function
when the actuator is locally operated. An operation from the
operator station is then inhibited.

Torque Caused by torque monitoring signal (for IDF_A only).

Individual drive function for unidirectional units, IDF_1

= Display: Message area
IDF - OneDir Icons for disturbance, runtime, end position, protection and local
o) m [k control, if configured as messages.
A past safety intervention is indicated by a black icon on white
background. This display will be reset in automatic or after an
operation intervention.

Display: Graphical display

Status fields with configured command texts indicate the switch

status.

RT | 00:10.00 Arrow: current direction of motion of the final control element. The

direction-of-motion arrow flashes when the final control element is

e J “moving”. In the event of an end-position error or a run-time error,
A¥]  theend position to be attained is indicated by a static direction-of-

IDF_1_us.png motion arrow in the faceplate.

RT Configured runtime

= s
Clo| 8

Operator interventions
Operating mode for output variable: toggle manual/automatic
Change control command 1/0 (in manual mode only)
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Open loop control function blocks

Faceplates

Individual drive function for bi-directional units, IDF_2

IDF_2

IDF - TwoDir

b @

RT

4 O [

STOP

F
00:15.00

IDF_2_us.png

o
m
o

il
|

@

©

Display: Message area

Icons for disturbance, runtime, end position, protection and local
control, if configured as messages. A past safety intervention is
indicated by a black icon on white background. This display will be
reset in automatic or after an operation intervention.

Display: Graphical display

Status fields with configured command texts indicate the switch
status;

Arrow: current direction of motion of the final control element. The
direction-of-motion arrow flashes when the final control element is
“moving”. In the event of an end-position error or a run-time error,
the end position to be attained is indicated by a static direction-of-
motion arrow in the faceplate. In direction of movement STOP the
status field for STOP flashes.

RT Configured runtime

Operator interventions
Operating mode for output variable: Toggle manual/automatic
Change control command 1/stop/0 (in manual mode, only)

Individual drive function for actuators, IDF_A

IDF_A
IDF - Act.

i

STOP

AUS

RT 59:00.000

e 0OMg

IDF_A_us.png

A
@0l

J

Display: Message area

Icons for disturbance, runtime, end position, protection, local control
and torque blockage, if configured as messages.

A past safety intervention is indicated by a black icon on white
background. This display will be reset in automatic or after an
operation intervention.

Display: Graphical display

Status fields with configured command texts indicate the switch
status.

Arrow: current direction of motion of the final control element. The
direction-of-motion arrow flashes when the final control element is
“moving”. In the event of an end-position error or a run-time error,
the end position to be attained is indicated by a static direction-of-
motion arrow in the faceplate. In direction of movement STOP the
status field for STOP flashes.

RT Configured runtime

Operator interventions
Operating mode for output variable: toggle manual/automatic
Change control command 1/stop/0 (in manual mode only)
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Faceplates

Constant function blocks

Dosing circuits, DOS, DOS_A, DOS_E

DOs
Dosing

100.00 Schafe

CA
CcP
S

PS
BV

16.00
90.00
90.00
70.00
0.0000

DOS_us.png

K

br)

“ﬂﬂrJ
e el¥]
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Display: Message area
For DOS_E, only, an alarm is indicated by an icon, if configured
accordingly.

Display: Numerical display

CA Actual counter position
CP Counter last period

S Shut-off value

PS Pre-shut-off value

BV Basic value

Display: Graphical display

Counter actual value CA as bargraph

Shut-off value S as bargraph

Basic value as marker to the left of the bargraph

Operator interventions

Change basic value, pre-shut-off value and/or shut-off value
Operating mode for output variable: toggle manual/automatic
Stopping and reactivating the dosing circuits (automatic mode only)
Reset: current counter is reset to its basic value

Adjust dosing: coarse dosing, fine dosing, and dosing OFF (in
manual mode only)

Constant function blocks

Constant function blocks CSTBO ... CSTWO

CSTBO - Binary value data type

Cst_Bool

Const Binary

out [ off ][ on ]

CST_BOOL_us.png

Gt

Display: Display
Status of the constant

Operator interventions
Toggling the binary value

Operators Manual — Freelance Operations 175



Constant function blocks Faceplates

CSTBY - Byte data type

Display: Display
Numerical value of constant

[ 2 Operator interventions
Changing constant value

CSTDI - Double integer word data type

CST_BYTE_us.png

Display: Display
Numerical value of constant and permissible value range

Operator interventions
Changing constant value

CST_DINT_us.png

Date&Time data type

Display: Display
Numerical value of constant

Operator interventions

:
Changing constant value

J

CSTDW - Double word value data type

Display: Display
Numerical value of constant

CST_DT_us.png

Operator interventions
Changing constant value

J

CST_DWORD_us.png
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Faceplates

Constant function blocks

CSTIN - Integer data type

Display: Display
Numerical value of constant and permissible value range

[ 32767

Operator interventions
Changing constant value

CST_INT_us.png

CSTRE - Floating point value data type

Display: Display
Numerical value of constant and permissible value range

Operator interventions
Changing constant value

CST_REAL_us.png

CSTTI - Time data type

Display: Display

Numerical value of constant and permissible value range
. .
[ 00:00.000 Operator interventions
Changing constant value

CST_TIME_us.png

CSTUD - Double integer word without prefix data type

Display: Display

Numerical value of constant and permissible value range
) .

Operator interventions

Changing constant value

CST_UDINT_us.png
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Constant function blocks Faceplates

CSTUI - Integer word without prefix data type

Display: Display
Numerical value of constant and permissible value range

Operator interventions
Changing constant value

CST_UINT_us.png

CSTWO - Word value data type

Display: Display
Numerical value of constant

Operator interventions
Changing constant value

CST_WORD_us.png

Function block constants CSTSTRS, ...... , CSTSTR256

Data type STRINGS

Display: Display
Text of the constant

Operator interventions
Changing constant value

Y

CST_STR8_us.png
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Faceplates Constant function blocks

STRING16, STRING32, STRING64, STRING128 and STRING256

Display: Display
c?:.ts‘t?;?fs Text of the constant

Operator interventions
out Changing constant value

‘Sixteen’

J

The following string constants are available:

CST_STR16_us.png

Function block Data type; max. number of characters

CSTSTR8 STRINGS, max. 8 characters
CSTSTRI16 STRINGS8, max. 16 characters
CSTSTR32 STRINGS, max. 32 characters
CSTSTR64 STRINGS, max. 64 characters
CSTSTR128 STRINGS8, max.128 characters
CSTSTR256 STRINGS8, max. 256 characters

The IEC character set is supported. This includes all characters from the 1SO646
Table 6461 "Basic Code Table", columns 3 to 7. Lowercase letters are also
supported Non-printing characters such as e.g. line feed are marked by the dollar
symbol $ and entered as hexadecimal characters.

Example:

$ODS$O0A Corresponds to 2 characters,
0D = carriage return and
0A = line feed

Other examples of the non-printing characters acc. to IEC are:
$$ Dollar sign,
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Batch control function blocks

Faceplates

$
$P or $p
$L or $l
$R or $r
$N or $n
$T or $t

Superscript,

Form feed,

Line feed or $0A

Carriage return or $0D,

New line, end current line and begin at start of next line,

Tab,with non-proportional script, advance to the column that can
be divided by 8, and to the next 2 cm limit with proportional script.

Characters marked by $ are not interpreted in the faceplates, but displayed in the
form entered, e.g. $AB for «.

The characters known from IEC are abbreviated accordingly, e.g. $0A is displayed

as $L.

Batch control function blocks

Function block FPX

 Running
Complete

FPX_1_us.png

 Running
Complete

B3
EAEDEVES

FPX_2_us.png FPX_3_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.

Display: Display
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Faceplates Batch control function blocks

Batch tab

Status fields (see below)
ST Status display
BA Batch ID

RE Recipe ID

LO Lot ID
CA Campaign ID
State tab:

Status fields (see below)

ST Status display

Sl Step index of current step

F Failure register

Tabs RP 1-10 and RP11-20:

Recipe parameters 1 to 10 or 11 to 20 If parameter names have been configured in
Freelance Engineering, these names will be displayed in the tool tip.

Operator interventions

Operating mode for output variable: toggle manual/automatic
Toggling the operating mode between operator/program
Starting run sequence

Starting restart sequence

Resetting after Idle

Pause

Continue after pause

Start stop sequence

Starting abort sequence

Start hold sequence

State fields in the FPX function block

The current state of the function block is indicated by the following text and colors:
Impossible states are shown on a white background

State field State Background color / text color
_ Idle Dark gray/black
| Running | Running Green/white
Complete Light gray/light green
Holding Stopping Light blue, flashing/black
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Batch control function blocks

Faceplates

Held Stopped
Restarting Restarting

Stopping

Stopped

Aborting
Aborted

Pausing

Pause

Light blue/black

Green, flashing/white
Blue, flashing/white
Blue/white

Orange, flashing/white
Orange/white

Light green, flashing/black

Light green/black

In the overview display the FPX function block's state is indicated by colored bars

meaning the following:

o Green Running
Green, flashing Restarting
Light green Pause
=
Light green, flashing Pausing
Light blue Stopped
Light blue, flashing Stopping
Dark gray Idle
==}
Blue Stopped
= Blue, flashing Stopping
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Faceplates Batch control function blocks

Orange Aborted
Orange, flashing Aborting
Light gray Complete

PLI function block

Idle
Running

l_l_l_l_ﬂr‘
X [ L[E

PLI_1_us.png PLI_2_us.png

Display: Message area
Icons for the configured limit values, if configured as messages.

Display: Display

Batch tab

Status fields (yellow: current status; gray: possible statuses; dark gray: impossible statuses)
ST Status display

Sl Step index of current step
F Failure register
RQ Request command

CID Campaign ID
Tabs RP 1-10 and RP11-20:
Recipe parameters 1 to 10 or 11 to 20
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Batch control function blocks Faceplates

Operator interventions

Operating mode for output variable: toggle manual/automatic
Toggling the operating mode between operator/program
Starting run sequence

Starting restart sequence

Resetting after Idle

Start stop sequence

Starting abort sequence

Start hold sequence

In the overview display the PLI function block's state is indicated by colored bars
meaning the following:

Yellow Running
Yellow, flashing Restarting
Yellow Stopped
Yellow, flashing Stopping
Dark gray Idle

m
Yellow Stopped
Yellow, flashing Stopping
Yellow Aborted
Yellow, flashing Aborting
Light gray Complete

i
I
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SFC Display General description — SFC display

Section 9 SFC Display

General description — SFC display

The SFC (Sequential Function Chart) is a user-defined network of steps and
transitions. The terms ‘step’ and ‘transition’ refer to action blocks and
advancement conditions respectively. Steps and transitions are represented by
graphical symbols. The display, type and color are dependent on the step and
transition states.

Every SFC program begins with the initial step and ends with the end transition.
During the initialization of the SFC program all steps are inactive. At the start of
the SFC program the initial step is activated and all other steps are inactive. The
SFC program starts when it is

enabled, i.e. when the start time, restart time or repeat time have been reached or
have expired. The end transition terminates the SFC program run. Afterwards all
steps will be in the inactive state.

The Freelance system provides the option of operating the SFC program in either
automatic or manual mode.

In automatic mode the SFC program runs automatically. In manual mode you are
able to influence the processing of steps and transitions.

Calling up the SFC display

Via the toolbar
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Calling up the SFC display SFC Display

Call up SFC.png

Q Left-click toolbar icon > In display explorer double-click appropriate SFC
display

Via the display menu item

Q Display > SFC displays > In Display Explorer double-click SFC display
or
ALT + D > C > Use CURSOR KEYS to select SFC display > ENTER

Via the context menu

In order to call up an SFC display via the context menu, you must first select a tag
to which an SFC display has been assigned in Freelance Engineering using the
Display access function.

g Select tag > Call up context menu > Select SFC display

From the overview display

Q Left-click appropriate SFC display icon
or
Use CURSOR or TAB keys to select appropriate SFC display > ENTER

From a graphic display

In order to call up an SFC display from a graphic display, a graphic object that
features the Show display action with an SFC display configured in Freelance
Engineering must have been previously selected.

g Left-click graphic object with appropriate configuration
or
Use TAB KEY to select appropriate graphic object > ENTER

186
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SFC Display Structure of the SFC display

Structure of the SFC display

AEAD «» BELEEHEEGBLR R 55 44 4

Favorites Fomul_SFC Histary
SFCname:  SFC_1 Short tet: Step:
SFC global imes Step imes
Start 28012019 162324513 Runtime: DUO005.500 Start Runtime: J
Rt " Repeat ime: [0000 00 000 | MY WA |
Inittep

SFC_Ampelt

Trans11

| | Trans31 | | Trensiz Trans34
Stepd2
’J_‘ Transaz
I — |
Fept1 ‘ Fepbd ‘
. | |
SFC Operalion Tip operation Transitian
@ ()] 1|[z][= Nermal
J EATWA o Steps Fore
. -
@) E™Mo [ Transitions Blacked

SFC structure.png

Title line

The title line displays the name, the short text and the long text of the current SFC

display.

Menu

Under the menu item Operation, the menu displays the actions available for the

SFC display.
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Structure of the SFC display SFC Display

Upper operating element area

The upper operating element area displays the SFC times and the step times. The
name of the SFC component and the currently marked step are also displayed.

Display area

In the display area, the individual steps and transitions are displayed depending on
their status and the mode of action execution. The SFC overview display is also
shown here. You can scroll the display using the horizontal and vertical scroll bars.

H The background color of the display section is dependent on the selected
operating mode. In automatic mode, the background color is light blue, whereas
it is dark blue in manual mode. The display of steps and transitions is identical
in both operating modes.
Lower operating element area

The lower operating element area includes the SFC Operation, Tip operation, Step
and Transition groups.

SFC overview display

AEAO « - |BEFXEF GG N 3@ 58| 4 4 4

Q

Favorites Formul_SFC History
SFC name: SFC_1 Short text: St
SFC global times 3]
Start: 28.01.2019 16:23:24.513 Runtime: 00:00:05.500 J St
Restart: ? Repeattime: | 00:00:00.000 | Th
i —
=L

SFC overview.png
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SFC Display Structure of the SFC display

The SFC overview display shows you the complete structure of the sequential
function chart at a glance. The green marking shows you the currently active step
or steps. Parallel branches are highlighted in blue.

The SFC overview display offers you a convenient way of viewing the required
area in complex SFC structures.

Calling up the SFC overview display

g In display area: Double-click next to a step or a transition
or
Operate > Overview display
or
ALT+0>0

Positioning the display area in the SFC overview display

Q Left-click in the appropriate display section > Double-click in the selected area

or
Use CURSOR KEYS to position the selection frame in the appropriate display
section > ENTER

Operate menu

The Operate menu for the SFC display comprises the following menu items:
Transitions...

Steps...

Active steps...

Control Aspect

Criteria window...

Overview display
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Structure of the SFC display SFC Display

Steps and Transitions

Step statuses

Steps in the Freelance system can have the status inactive, active, was active and

interrupted.

inactive A step is inactive when it has not yet been performed in the current
cycle. When a step is inactive, the programs assigned to it are not
executed.

active The step status changes to active as soon as all transition
conditions of the preceding step have been fulfilled. When a step is
active, the programs assigned to it are executed.

was active When a step has been executed in the cycle, it is set to the was

active status.

interrupted ~ The step monitoring time has been exceeded.

Executing steps
The Freelance system provides the normal, permanently off and permanently
on modes for the execution of steps.

E The action execution is independent of the step state.

normal The actions assigned to a step are performed only on condition that
the step is active.

permanently off
The actions assigned to the step are never executed.

permanently on
The actions assigned to the step are always performed.
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SFC Display

Structure of the SFC display

Display format of steps in the SFC display

The display format of steps in the SFC display depends upon the step state and the
mode of the action execution. The “permanently on” and “permanently off” action

execution modes are indicated by a triangle in the top right corner of the step

symbol. The triangle is dark blue for “permanently off”

and light green for “permanently on”.

Initial step
InitStep

Active step

Inactive step
Stepdz

Permanently on step
(light green triangle)

Stepd?

Branch-in

1
Abklhlen

kdhlung auf 98 °C

Normal step
Step42

Interrupted step

Step was active
Stepaz

Permanently off step

(dark blue trianglei
Stepd2

Branch-out

' RampDowin
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Structure of the SFC display SFC Display
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SFC Display

Structure of the SFC display

The following table provides information on the colors used for displaying steps
depending on their state and the mode of action execution.

Step status Symbol section Action execution
normal | perm. off | perm.on
inactive Background Gray Gray Gray
Text Black Black Black
Triangle - Dark blue Light green
active Background Dark green Dark green Light green
Text White White Black
Triangle - Black Black
was active Background Gray Gray Gray
Text Dark green Dark green Dark green
Triangle - Dark blue Light green
interrupted Background Dark green Dark blue Light green
Text Red Red Red
Triangle - Black Black

Transition statuses

In the Freelance system, transitions can have the status not processed, in progress,
fulfilled and completed.

not processed

in progress

fulfilled

completed

Not all preceding steps have become active. The transition will not
be evaluated.

All preceding steps have become active. The transition will be
evaluated.

The transition advancement condition is TRUE. All preceding
steps will become inactive and all following steps will become
active. The transition advances.

The end transition completes the SFC program run. Afterwards all
steps will be in the inactive state.
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Structure of the SFC display

SFC Display

Displaying transitions in the SFC display

Transitions are displayed in the SFC display depending on their status.

The table shows the status-dependent transition colors.

processed or fulfilled (green text)

I
Trans11
| not processed or completed (black text)
Trans21
| in progress
Trans51
| execution blocked (dark blue triangle)
‘ Trans32
|
| execution forced (light green triangle)
I
Transition Symbol Execution of the transition criteria
status section
normal blocked forced
not processed | Background Gray Gray Gray
or completed Text Black Black Light green
Triangle - Dark blue Light green
in progress Background Dark green Dark blue Light green
Text White White Black
Triangle - Black Black
fulfilled Background Gray Gray Gray
Text Dark green Dark blue Dark green
Triangle - Dark blue Black
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SFC Display SFC display operation

SFC display operation

SFC times in the SFC display

The upper operating element area includes the SFC times and step times groups.
The name of the SFC component and the currently marked step are also visible.

SFCname: SFC_1 Short text: Step: DOS_S
SFC global times Step times
Start: 7/6/2018 04:46:17.614 Runtime 00:07:02.114 J Start: 7I6/2018 04:46:22.614 Runtime: 00:06:57.114 J

SFC Time.png

The SFC times refer to the complete sequential function control.

ﬂ The start time and the runtime cannot be changed! The restart time and the
repeat time can only be modified in manual mode.

During active daylight saving time period, all sequential function chart times are

ﬂ indicated on this basis. The times entered by the operator are also recorded as
daylight saving time values in Freelance Operations and transferred accordingly
to the controller.

Start The start time is the beginning of execution of the SFC program.
At the start of each new run the current system time is recorded.

Runtime The runtime is the time that has elapsed since the start. The
runtime is reset to 0 s when the SFC is started.

Restart The restart time is the time when the SFC program is started
again. In contrast to the repeat time, the restart time represents a
single point in time for starting the SFC program. In conjunction
with repeat time, changing the restart time can influence the time
point for cyclical processing of the SFC program.

Repeattime  The repeat time is the minimum waiting time between two starts
of the SFC program.
If the restart time is fixed, it will take precedence over the repeat
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time. If the repeat time is less than or equal to the runtime of the
SFC, then the SFC is started again immediately after ending.

Modifying the SFC times

SFC name: SFC_START Short text: FW Start Up

SFC global times

Start: 7120/2018 08:55.07.037 Runtime: 00:12:13.166 J
Restart: 712002018 DE:EEtE?.DSE | Repeattime: |00:00:30.000 |

SFC times.png

Modifying the restart time

Q Left-click edit field Restart time > Enter new value > ENTER

Modifying the repeat time

Q Left-click edit field Repeat time > Enter new value > ENTER

Step times in the SFC display

The times in this area only refer to the selected step.

The start time and the runtime cannot be changed! The monitoring time and the
minimum waiting time can only be modified in manual mode of operation.

Step: DOs_5

Step times

Start: TIGI2018 04:46:22 614 Runtime: 00:08:48.120 J
THWO: 5O6:31:23.647 TWA 00:00:00.000 |

Step times.png
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Start The start time is the beginning of the execution of the selected
step. Each time the step is executed the start time is updated.

Runtime The runtime is the active time of the step. Each time the step is
executed, the runtime is reset to 0 s.

TMO Monitoring time for this step. The step should be completed prior
to the expiry of the monitoring time. If this time is exceeded a
message is generated.

TWA Minimum waiting time for a step. The step remains active at least
for the TWA duration.

Modifying the step times

Modifying the monitoring time

g Left-click edit field TMO > Enter new value > ENTER

Modifying the minimum waiting time

g Left-click edit field TWA > Enter new value > ENTER

SFC display operation

SFC Cperation
(>4 J
M &

SFC display operations.png
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The SFC Operation group consists of six buttons and the ENTER button to confirm
the selection. Operation is identical for all buttons.

¥

Left-click appropriate button > ENTER

Automatic | In automatic operating mode the transitions are stepped through by the

Q

program.

<
c

anual

G

In manual mode they can be stepped through by the operator.

Enable

This refers to starting the SFC program. If in automatic operating mode
Enable is switched on and either restart time or repeat time is reached, then
the initial step in the SFC program will be carried out.

Disable

®

The enable command for the SFC program is cancelled.

Reset

O

The SFC program on the process station is reset.

Execute

4
{Hk

The program is continued depending on the selected tip options.

The SFC program can be enabled and disabled in manual and automatic mode.
Resetting and execution are possible in manual mode only.
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Tip operation
Tip operation
1123

TWA Steps J
TMO  []Transitions

Tip operation.png

The Tip operation group consists of three buttons, four check boxes and the
ENTER button to confirm a selection. Operation is identical for all buttons and
check boxes.

g Left-click appropriate button or appropriate check box > ENTER

Tip operation

By activating one of these three buttons, a pre-defined profile for processing steps
and transitions or for observing the TWA and TMO times can be set.

1 TWA, TMO, steps and transitions are not activated
2 .

Steps activated
: Steps and transitions activated

TWA If this field is selected, the minimum waiting time TWA is applied
to all steps in the SFC display.

TMO If this field is selected in manual mode, the corresponding TMO
monitoring times will be applied to the active steps. In automatic
mode, TMO will always be observed.

Steps If this field is selected, the actions assigned to the active steps are

performed.
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Transitions If this field is selected, the programs assigned to the transitions are
performed. The transition condition is checked.
If this field is not selected, the transition condition is always
evaluated as TRUE.

Step operating element area

Step: INIT_S

(® Mormal
() Permanent on J
() Permanent off

Step-sfc.png

In the Step group, the action execution of the selected step can be defined. The
name of the selected step will be displayed.

The action execution of the step can only be changed in Manual mode; this is not
possible in Automatic mode.

The selected action execution mode is kept even if you switch to automatic
mode.

The action execution of a step can assume three different statuses:
Normal The step is processed normally.

Permanent off
The step is never processed.

Permanent on
The step is processed constantly.

The appropriate action can be selected via one of three radio buttons and the Enter
button to confirm a selection.

In display area: Left-click a step > Select appropriate action > ENTER
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Transition operating element area

Transition: END_T

(® Mormal

[ ]Farced J

() Blocked

Transition sfc.omp

In the Transitions group, the type of advancement of the selected transition can be
influenced. The name of the selected transition will be displayed.

The type of transition advancement can only be changed in Manual mode; this is
not possible in Automatic mode.

The transition advancement mode can assume three states:
Normal The transition is advanced normally.

Blocked Transition advancement is blocked. This transition is not advanced
even if the transition condition is TRUE.

Forced The transition is advanced immediately upon processing,
regardless of the transition condition. The Forced status will be
reset after one transition run has been completed.

The appropriate action can be selected via one of two radio buttons and the Enter
button to confirm the selection. The Forced action can be operated via a check box.

g In display area: Left-click a transition > Select appropriate action > ENTER

Selecting steps or transitions

You have the following options in order to select individual steps or transitions:

g In display area: Left-click a step or transition
or
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SFC Display

Operate > Transitions.../Steps.../Active steps

or
ALT +O>T/SIC

Displaying the transition list or step list

... > Select from list

Transition list > Step list x
T1 - FINISHED
21 Heating
T22 INIT
T23 L<45.0cm
™™ L=40.0cm
T32 SP=40°C
T4 Valve-=0
5 v
seoct | [ Careo seoct | oo
Transition/step list.png
Q Operate > Transitions.../Steps...
The following actions are available:
Operate The highlighted step or transition respectively is selected for
operation. The appropriate operating element area becomes active.
Select The highlighted step or transition is selected.
Abort The list is closed.

Displaying the list of active steps

Q Operate > Active steps..
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ﬂ This list is not updated automatically. This means that the steps included in the
list were active at the time the list was called up but are not necessarily still
active even a short time later.

The following actions are available:

Update The contents of the list are updated.

Operate The highlighted step or transition respectively is selected for
operation. The appropriate operating element area becomes active.

Select The highlighted step or transition is selected.

Abort The list is closed.

Operation in the display area

Criteria window

In the display area of the SFC display, you can call up a criteria window for each
transition or step. The criteria windows provide further information about the
selected transition or the selected step. In addition to the conventional criteria
windows, which must have been configured explicitly in Freelance Engineering,
the Control Aspect option also allows automatically created criteria windows to be
called up. These windows show the program of the transition or step as configured
in Freelance Engineering for the SFC. The display is based on online values similar
to the Commissioning mode in Freelance Engineering. Online animation is limited
to the display. Changes cannot be made.
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SFC Display

Criteria window for transitions

B Transition: T1

Variable

& | vi_sma
& V2_SMA
& V5_SMA
& V6 _SMA

Value

FALSE
FALSE
FALSE
FALSE

Comment

Value: |FALSE

| Write

Criteria window.png

The criteria window of a transition allows the advancement condition status to be
monitored. The transition-relevant variables are indicated with their status, current
value and a comment.

Variables marked with & are ANDed. Variables marked with >= are ORed.
Variables without any marking serve for information purposes only and do not

affect the transition condition.

A transition (criterion for advancement) is considered as fulfilled when the
conditions of all ANDed variables and at least one condition of the ORed variables
are fulfilled. The text lines shown in green in the criteria window represent a
fulfilled condition. All non-fulfilled conditions are indicated in black.

This type of display will only be used if configured accordingly in Freelance

ﬂ Engineering. During the configuration phase a tag can be assigned to each
criterion. The associated faceplate can be called by double-clicking on the
relevant line in the criteria window.

You can call up the criteria windows for transitions both from the display area of
the SFC display and via the menu item Operation. This call-up is also possible via

the context menu.
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Q In display area: Double-click a transition
or
Select transition > Operate > Criteria window
or
Call up the context menu of a transition > Criteria window

Criteria window for steps

B Step: Valve-=0 >
Variable Value Comment 2
FIC1T_MM FALSE
FICT1_OTM 0.0
FIC1_TRC FALSE
FICZ2_OTM 0.0
FICZ_TRC FALSE
VI_IN FALSE
VZ2_IN TRUE v

Value: |[FALSE Write

Criteria window for steps.png

The utilized variables with value and comment are displayed in the criteria
windows for steps.

This type of display will only be used if configured accordingly in Freelance

ﬂ Engineering. During the configuration phase a tag can be assigned to each
criterion. The associated faceplate can be called by double-clicking on the
relevant line in the criteria window.

You can call up the criteria windows for steps both from the display area of the
SFC display and via the menu item Operation. This call-up is also possible via the
context menu.

Q In display area: Double-click a step
or
Select step> Operate > Criteria window
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or
Call up the context menu of a step > Criteria window

Control Aspect

'5] CBFViewer - ReactorSFC.Step23 3
-_— Y

PFITTA
FF24TTA
FE3TTA

vh_j0036.png

The Control Aspect (CBF Viewer) add-on program must have been installed.
For more detailed information, please refer to section Operating Philosophy,
page 19 and to the "Getting started" manual, Installation.

If the Control Aspect (CBF Viewer) program is additionally installed on the
Freelance Operations PC and the Control Aspect option is licensed

and activated, the context menu of a step or a transition includes the Control
Aspect item. The Control aspect is an animated display of the step or transition
program, similar to the display of the program in the Commissioning mode in
Freelance Engineering.
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After selecting this entry, the associated configured program with all current values
is displayed. If the contents of the Control Aspect window are displayed in red,
there is either

no online connection or the step or transition is no longer active.

g Operate > Control Aspect
or
Right-click a step or transition > Control Aspect
or
ALT+0O>C

ﬂ Under Tools > Options the setting can be changed to ensure that a double-click
on a transition or a step calls up the Control Aspect feature instead of the
conventional criteria window.

Calling up displays assigned to transitions and steps

The display allocation made during configuration in Freelance Engineering allows
a group display, graphic display, trend display, time scheduler display, SFC
display, WEB display as well as logs to be assigned to each step or transition.

You can call up the assigned displays via the context menu.

Q Call up the context menu of a step or a transition > Select display
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Section 10 Time Scheduler Display

General description — Time scheduler display

The time scheduler display in Freelance Operations is used to observe and operate
the time scheduler. The time scheduler makes it possible to define analog variables
chronologically by default, using a maximum of 32 different support values. These
values are defined during configuration in Freelance Engineering. Each entry, of
which there may be up to a maximum of 32, comprises a basic value and the
associated runtime. The runtime defines the time at which the value is to be
approached. The time scheduler display provides the possibility to influence the
time scheduler output (analog signal), i.e. to deviate from the configured time
schedule.

AGEAD «+» BLTEAGDEL 8B hHé&a4QQQ]

avurtes

Time Schedule Display.png
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The time trend is also displayed in a graphical format. Two different colors are
used to distinguish between set trend and actual trend: green corresponds to the
configured set trend and blue to the actual trend of the time scheduler output value.
The latter does not necessarily match the set trend at all times. The current value is
marked by a red rectangle.

Unlike the trend display there is no data archiving for the time scheduler
display.

In addition to the trend curves, the time scheduler faceplate is shown. The actual
output value is displayed as a bar graph and as numerical value. The Act and Nom
tabs can be used to display and operate the actual values and nominal values in the
value field.

A typical application of the time scheduler is to write a time-dependent variable
value to a controller set point.

Below the faceplate of the time scheduler, any other faceplate can be displayed,
e. g. the faceplate of the downstream controller.

Operate menu

The Operate menu for the time scheduler display comprises the following menu

items:

e Scroll left

e Scroll right

e Zoom +

e Zoom -

e  Zoom to window width

Calling up the Time Scheduler Display

Via the toolbar

Call up time schedule.png

210 Operators Manual — Freelance Operations



Time Scheduler Display Calling up the Time Scheduler Display

Q Left-click toolbar icon > In the display explorer double-click appropriate time
scheduler display

Via the Display menu item

Q Display > Time scheduler displays > In Display Explorer double-click
appropriate time scheduler display
or
ALT + D > S > Use CURSOR KEYS to select appropriate time scheduler
display > ENTER

Via the context menu

In order to call up a time scheduler display via the context menu, you must first
select a tag to which a time scheduler display has been assigned in Freelance
Engineering using the Display access function.

Q Select tag > Call up context menu > Select appropriate time scheduler display

From the overview display

Time scheduler.PNG

Q Left-click appropriate time scheduler display icon

or
Use CURSOR or TAB keys to select appropriate time scheduler display >
ENTER
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From a graphic display

In order to call up a time scheduler display from a graphic display, a graphic object
that features the Show display action with a time scheduler display configured in
Freelance Engineering must have been previously selected.

g Left-click graphic object with appropriate configuration
or

Use TAB KEY to select appropriate graphic object > ENTER

Operating the Time Scheduler Display

Manipulating the Graphic Area

Within a certain time, all defined ancillary values in the time scheduler display are
reached. This time is the total time the horizontal axis of this time scheduler
display comprises in its default status.

To observe a certain range more closely, you can scroll the display section or
change the time range.

When you change the display section you can observe the trend area in the time
scheduler display in more detail.

The change is carried out via the Operate menu or via the zoom levels in the
toolbar. For this purpose the following three toolbar icons are available:

Zoom +;
Enlarges the displayed time range

Zoom —;
Reduces the displayed time range

JO)C

Zoom to window width
Resets the displayed time range to the original size

rnA
Ld
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v

¥

Scrolling the display

The graphic area of the time scheduler display can be scrolled via the horizontal
scroll bar positioned below the curve.

Left-click and hold position indicators in the scroll bar > Move position
indicator

or

Operate > Scroll left or Scroll right

or

ALT +O>Lor ALT + O > R to scroll left or right

Change display section

Left-click appropriate toolbar icon
or
Operate > Select zoom level: Zoom+, Zoom-, Zoom to window width

or
ALT + O > Use CURSOR KEYS to select zoom level > ENTER

Setting Parameters

Among the two possible faceplates the upper faceplate is assigned to the time
scheduler display. This faceplate is used to change the different parameters if this
option was configured in Freelance Engineering. For this purpose the following
parameters are available:

Offset Designates the offset between set trend and actual trend of the time

scheduler output value. Either positive or negative values can be
entered. The offset value can only be changed in manual mode.

ﬂ Entering an offset value in automatic mode is not accepted!

Cycles Indicates the number of runs for the section of the set trend to be

repeated. If the time scheduler is not operating in permanent mode
but in Cycle mode and the time scheduler has reached the
specified number of runs, the cyclic processing of the time
scheduler is terminated. The time scheduler automatically changes
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to Execution mode stop and the last ancillary value is issued at the
output.

E If the time scheduler is set to Off during a run, the run count starts at zero when
the time scheduler is set to On again.

Operating mode

The manual/automatic operating mode controls the use of the
offset value: in automatic mode, the time scheduler works with an
internal offset that was assigned to the function block during
configuration in Freelance Engineering; in manual mode it works
with the offset value set in Freelance Operations.

E If no internal offset was defined during configuration, the offset entered in
operating mode Manual is retained after switching to Automatic.

Execution mode

Off

Stop

On

Skip

Scroll

The execution mode is used to influence processing of the set
trend. The following states are possible:

The time scheduler completes its cyclical processing and outputs
the ancillary value 0. Execution time from start and elapsed time
are set to 0.

The time scheduler keeps the output value at the time of the stop
command at a constant level. This status is maintained until a
different execution mode is selected. The Execution time from start
continues to run during this time.

The time scheduler begins processing from its current position. If it
was previously interrupted by a Stop during a program, it will
resume processing from that precise point when the operator
switches over to On. If the time scheduler was in Off status before,
it will start the program from the beginning.

The time scheduler leaves the current section and starts processing
the next section.

The time scheduler scrolls forwards at 5 sec per section. If the max.
rate of change does not allow this, the execution time for the
section in question is extended accordingly.
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Permanent/Cycles
In Permanent mode, the entire target curve is continuously

performed. The curve section
configured as a cycle is run as often as configured under Number of

Cycles. After the last run, the time scheduler changes to Stop
execution mode.

For more detailed information on operations in the faceplates, please refer to
Faceplates, page 133.
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Section 11 Logs

General description — Logs

Logs are used to chronologically document historical information and messages
from the process and the Freelance system. Logs are output to the printer, screen or
(by data transfer) to data storage devices.

There are two different log types:

Event logs

These logs are used for logging events such as messages, faults, switching actions
and operator interventions. Logging is performed spontaneously when the event
takes place.

Log type: Signal sequence log

Status logs

These logs are used for cyclical process status logging. This includes the cyclical
logging of a tag status or the logging of events within the process.

Log types: Disturbance course log, Operation log, Excel report
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Number of logs

The following logs can be created for each operator station:

Operation log Max. four logs
Disturbance course log Max. four logs
Signal sequence log 1 Max. one log
Signal sequence log N Max. three logs
Excel reports Not limited

File transfer

Using the file transfer function it is possible to transfer a copy of the log files from
the local Freelance Operations PC to another PC. The target PC must feature a
network communication connection (FTP) to the Freelance Operations PC. Log
files are usually transferred to another PC in the network. However, transfer to
another disk drive of the local Freelance Operations PC is also possible. The file
transfer target is configured in Freelance Engineering and cannot be changed under
Freelance Operations. The exported files can be visualized using the Archive
Browser add-on program or MS Excel for Excel reports. The Archive Browser also
provides conversion of the files to standard CSV format, so that an evaluation with
other programs (e.g. MS Excel) is possible.

Display

After having called up a log, the title line indicates the log type plus the log name,
short text and long text. A list of available log files is displayed below the toolbar.
The following information applies to all logs except for the Excel reports:

The contents of the first log file are shown below the list.

The list header contains the following information:
e  Sequential number, number of entries
e  Time specified for the start of the logging
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e  Time specified for the end of the logging (if already terminated)
¢ Information on the log status.

The following information applies to Excel reports:

The file contents are only visible in Excel.

The list header contains the following information:

Size

Status

Status

File name

Sequential number
Entries

Last acquisition

Logs (except for Excel reports) can assume the following statuses in printer
queue, printing, printed and deleted.

in printer queue

printing
printed
deleted

The log file is in the printer queue.
The log file is being printed.
The log file was printed.

The log file is automatically deleted when the configured
maximum number of files that can be archived is reached and
automatic deletion has been enabled. When the screen view is
changed, these files are deleted from the log list.

Excel-Reports can assume the status acquiring, completed and (deleted).

acquiring
completed
(deleted)

Data for the Excel report are being acquired.
Data acquisition for the file is finished.

The Excel report was deleted. This line is cancelled from the file
list with the next display change.
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Log overview.png

The current log file can be identified by the fact that there is an entry in the Start
column, but no entry in the End column. The operation of the disturbance course
log, operation log, and signal sequence log is largely identical. Therefore, it is
described once for all log types.
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Operate menu

The Operate menu for logs contains the following menu items:
Start

Stop

Print...

Delete...

File transfer

Split

Details only

File list only

Calling up logs

Via the toolbar

) LA || [E=

Call up log.png

Q Left-click toolbar icon > In the display explorer double-click appropriate log

Via the Display menu item

Q Display > Logs > In display explorer double-click appropriate log

or
CTRL + F9 > Use CURSOR KEYS to select appropriate log or enter first
letters of the log name > ENTER

Via the context menu

In order to call up a log via the context menu, you must first select a tag to which a
log has been assigned in Freelance Engineering using the Display access function.
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Q Select tag > Call up context menu > Select appropriate log

From the overview display

m— 8 A
— v

or

log.png; excel.png

Q Left-click appropriate log symbol
or
Use CURSOR or TAB keys to select appropriate log symbol > ENTER

From a graphic display

In order to call up a log from a graphic display, a graphic object that features the
Show display action with a log configured in Freelance Engineering must have
been previously selected.

Q Left-click graphic object with appropriate configuration
or
Use TAB KEY to select appropriate graphic object > ENTER

Operating logs

There are three methods available to operate the different logs in the Freelance
system:

e viathe buttons in the toolbar,

e viamenu item Operate (mouse and keyboard operation),

e viathe buttons in the bottom operating element area.
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Operating logs

Changing the view settings

v

v

V

The logs - except for the Excel reports - can be viewed in various modes: split,
details only and file list only.

Split

The upper display area shows the list of log files, the lower the contents of the
selected log. When a log is called up, the first file of the list is selected. Click with
the mouse or use CURSOR KEYS to select a different file from the list.

In toolbar or operating element area: Left-click E
or

Operate > Split

or

ALT>L

Details only

Show only contents of selected log.

pe————

In toolbar or operating element area: Left-click
or

Operate > Details only

or

ALT>E

File list only

Show log file list only.

In toolbar or operating element area: Left-click =----:
or

Operate > File list only

or
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ALT >0

Starting the logging

Logging can be started by the operator only if manual starting and stopping has
been enabled during configuration in Freelance Engineering.

Logging can be started when:

¢ logging has not been started yet,

e the maximum number of log files has been reached and automatic delete is
enabled.

In toolbar or operating element area: Left-click b
or

Operate > Start

or

ALT >S

é Do not open an Excel report file while data are being acquired. Opening an

Excel report will interrupt data acquisition.

Stopping the logging

¥

Logging can be stopped by the operator only if manual starting and stopping has
been enabled during configuration in Freelance Engineering.

In toolbar or operating element area: Left-click ]
or

Operate > Stop

or

ALT>T
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Printing a log file

The contents of the selected log file can be printed. The selected log file can only
be printed if Manual print was enabled for this log during configuration in

Freelance Engineering.

Q In toolbar or operating element area: Left-click =
or
Operate > Print
or
Call up context menu> Print

or
ALT>P

In the subsequent dialog you define what is to be printed. Either the whole file, the
current page or a range of pages may be selected for printing. (These options are
not available for all log types.)

Print *

Print area

O Com plete selected log file

(®) Starting with first visible line

Mumber of pages: I:l

Configured lines per page: 70

ool

Print.png
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Deleting a log file

The selected log file can be deleted. The selected log file can only be deleted if
Manual delete was enabled for this log during configuration in Freelance

Engineering.

Q In toolbar or operating element area: Left-click Im

or
Operate > Delete

or

Call up context menu> Delete

or
ALT >D

Enabling/disabling automatic file transfer

If the automatic file transfer is enabled, the log data are copied to the specified
target directory either cyclically or after closing a file, depending on the
configuration.

The automatic file transfer can only be enabled or disabled if manual enable and
disable was expressly enabled during configuration in Freelance Engineering.

Log operation

.,_ Enable automatic

file transfer

File Transfer enabled.png

Q In operating element area: Click check box

Initiating manual file transfer

The data of the selected log file is copied to another computer or another folder
according to the configuration. With this option, it is also possible to transfer not

completed log files.
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Disturbance course log

¥

Manual file transfer can only be initiated if manual file transfer was enabled
during configuration in Freelance Engineering.

In toolbar or operating element area: Left-click [
or

Operate > File transfer

or

ALT>F

Updating log files

The list of available log files is automatically updated. The contents of the
respective log file can be updated manually (except for Excel reports).

Q In toolbar or operating element area: Left-click C

or
ALT>R

Disturbance course log

The disturbance course log belongs to the status logs. It is used for high-
resolution tracking of time-related changes in a maximum of six variables, which
are selected during configuration of analog and binary process variables. You can
use it e. g. for permanently archiving the most important process variables in this
time period in case of a disturbance.

The disturbance course log uses a special disturbance course acquisition function
block in the process station. This function block captures the input signals
cyclically and stores them in a ring buffer containing up to max. 200 values per
input signal. The disturbance course acquisition module can be configured in such
a way that the event triggering the log — i.e. the disturbance — is recorded at the
beginning, in the middle or at the end of the acquired data. Depending on the
configuration, either the preliminary events that have caused the disturbance or the
consequences or both can be analyzed. The log can either be started manually or by
a specific event.
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Displaying the disturbance course log

Below the toolbar the available log files are listed. The contents of the selected log
file are displayed in the area below the list.
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Operating the disturbance course log

For information on operating the disturbance course log, please refer to Operating
logs, page 222.

Format of the disturbance course log

The log header shows the name of the item that triggered the disturbance and the
start time of the log. The process variables of the input signals used by the
disturbance course acquisition module are displayed in a list with the associated
time stamps.
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Example:
Trigger: Disturb Time: 89:51:25.076
Time / Product A (/h) | ProductB (yh)  [Level | LI720(Saw] | LI720(Sinus] (%)
09:50:05.121 2.6 295.9 3.5 191.8 5.28
09:50:05.882 2.8 296.0 3.4 192.7 5.28
09:50:06.694 0.0 296.1 3.4 193.6 5.28
09:50:07.475 47 296.2 3.3 1945 5.29
09:50:08.276 1. 296.4 3.3 195.4 5.29
09:50:09.177 5.1 296.5 3.2 196.2 5.30
09:50:09.878 0.9 296.6 3.3 1970 5.30
09:50:10.679 5.4 296.7 3.2 198.0 5.31
09:50:11.480 1.0 296.8 3.3 198.9 5.31
09:50:12.282 0.0 296.9 3.0 199.8 5.32
09:50:13.143 3.4 297.0 3.0 200.4 5.32
09:50:13.884 115 297.1 3.4 201.3 5.33

vh_10116_us.png

Operation Log

The operation log belongs to the status logs. It is used for logging process
variables. Configured texts can be added to the process variables for better
understanding. The log can be started manually, cyclically or by a specific event.
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Logs

Displaying the operation log
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Operating the operation log

For more detailed information on how to use the operating log, please refer to
Operating logs, page 222.

The operation log file may consist of several pages. After the log file has been
opened, the appropriate “page” can be directly selected. In the bottom operating
element area you find an appropriate edit field.

Page:

.1

Operation log-page.png

-

-
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Edit field for the page number and button for scrolling backwards and forwards
one page at a time.

The current page number and the maximum number of pages are shown in the
window title bar of the log in the format (current page/max. page), e.g. (2/4).

Selecting a page in alog

g Left-click edit field > Enter page number
or
Use TAB key to select edit field > Enter page number > ENTER

Scrolling backwards and forwards one page at a time

Q Left-click button to scroll backwards and forwards
or
Use TAB KEY to select button > ENTER

ﬂ The current page number is displayed in the entry field.

Format of the Operation Log

The operation log does not feature a fixed format as its configuration in Freelance
Engineering allows text to be freely combined with formatted process variable
values.

Excel Report

The Excel report belongs to the status logs. It is used to track time-related changes
of process variables. Similar to the operation log, process values are acquired for a
configured time range on a cyclic basis and stored in a file. Depending on the
configuration in Freelance Engineering, several equivalent Excel files can be
created.
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Display of the Excel report
The list of generated files is shown in Freelance Operations. A double click on the
file will open the report in Microsoft Excel.

Do not open an Excel report while data are being acquired. Opening an Excel
report will interrupt data acquisition.

Operating the Excel report

For details on operating the Excel report, please refer to Operating logs, page 222.

Format of the Excel report

As the contents of the Excel files for a report are defined during configuration in
Freelance Engineering, there is no fixed format for Excel reports.

Signal Sequence Log

The signal sequence log is used for logging events and operator interventions and
belongs to the event logs. This implies that the data (events) are not recorded
cyclically, but only when an event actually occurs.

A distinction is made between two types of signal sequence logs:

Signal sequence log 1 continuously transfers the events occurred to a printer. This
log guarantees that events are printed out in strict chronological order.

Signal sequence log N transfers events only upon completion of the logging
process of after manual intervention to the printer.
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Signal Sequence Log

Displaying the signal sequence log
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Audio file not found

Audio file not found

Audio file not found
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Operating the sighal sequence log

V

For information on operating the signal sequence log, please refer to Operating

logs, page 222.

The signal sequence log is not divided into separate pages. It is therefore not

RUNTIME
RUNTIME
PROTECT
PROTECT
RUNTIME
MIN 2

MIN 2

TRUE
TRUE
TRUE
TRUE
TRUE
-1.6
-1.6

°C
°C

FLT_TIME
FLT_TIME
PROTECT.
PROTECT.
FLT_TIME
LL

LL

possible to directly specify a page as with the operation log.

For the sake of clarity, the text and background color of the signal sequence logs
can be changed.

Tools > Options

or

ALT+t>P
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In the following dialog, you define the color scheme for text and background.

Options X
General Signal sequence log
Cyclic backforward display switch Detail view colors:

Background

|
|

Faceplates always on top

Show display selection list:

O left ® right

I

Graphic display Trend display
@ lse whole screen width Operation panel:
O Use whole screen height

(®) at top () at bottom
O Centered

Message list SFC display

Priority filter preset: Open Gantrol Aspect on

®) use last O selectall double click

oo

Signal sequence logs.png

Format of the Signal Sequence Log

The format of the signal sequence log is largely identical to the format of the
message list. The first and last lines each contain a time marker comprising the date
and time of day. The time marker in the first line of the signal sequence log
represents the log’s start time. The time marker in the last line represents the log’s
stop time. In addition to this, another time marker is output every hour while a log
is being compiled.

In between these time markers are the various event entries. Messages can be
represented in any of the following four formats: Empty (none), Value, Long text
or All. During configuration in Freelance Engineering, the display format for the
events is defined. In addition, the length of the log lines (80 or 132 characters) is
specified during configuration.
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The following overview shows the explanations for the individual formats. The
abbreviations used are explained on the next page in alphabetical order.

Format for all messages
No entry (Format Empty)

Format for process messages

M Time AR Tag Stext Mtext Value Dim Type (Format
Value)

M Time AR Tag Stext Ltext M text (Format
Long
text)

M Time AR Tag Stext Ltext Mtext Value Dim Type  (Format
All)

Format for system messages
M Time AR Tag Sys-m-text (Format Value, Long text, All)

Format for operator actions

O Time Operator Tag Component Old New Dim (Format Value,
Long text, All)
O Time Operator Display Varname Old New Dim (Format Value,

Long text, All)

Format for Acknowledge Action
O Time Operator Tag Type M text Ack  (Format Value, Long text, All)

Formats for Log Events

! Time Log S text Event (Format Value, Long
text)
I Time Log S text L text Event (Format All)

Format for Sequence of Events
# Time AR Tag Bin-text (Format Value, Long text, All)
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Format for System Events

I Time “Timeout” Tag Component Old New Dim (Format Value, Long
text, All)

' Time “Error” Tag Component Old New Dim (Format Value, Long
text, All)

I Time “Timeout” Display Varname Old New Dim (Format Value, Long
text, All)

! Time “Error” Display Var name Old New Dim (FormatValue, Long
text, All)

Abbreviations

! Indication of a log event.

# Time stamp of edge of a binary value(sequence of events):
+# for change from 0 to 1, -# for change from 1t0 0

“ERROR” The write command to a process variable or component of a tag
could not be executed, the text Error is indicated.

“TIMEOUT” As the time limit is exceeded, writing to a process variable or
component of a tag could not be executed, the text Timeout is
indicated.

AR Plant area. If a line length of 132 characters has been configured,
the long names of the plant areas are shown. For logs with a line
length of 80 characters, the short names A-O appear instead.

Bin-text Fixed text: channel xx, sequence of events

Component ~ Component for tag that is written

Dim Dimension configured for message

Display Name of graphic display from which the action was initiated.
Event Log event such as Start, Stop, Print, Delete, and Export

L text Long text configured for tag

Log Log name

M text Message text configured for message
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Signal Sequence Log

New

0]

Old
Operator

S text
Sys-m-text
Tag

Time
Type
Value

Var name

All messages are displayed with their priority (S1..S3 or 1..5) and a
prefix for incoming (+) and outgoing (-).

Acknowledged messages are marked with < or >:

<The message was visually acknowledged

> The message was point acknowledged

New value of process variable
Indication of operator action
Old value of the process variable

If the User Management is enabled, this position contains the name
of the operator who carried out the operator action. Without User
Management, the default user name NOLOCK or SYSTEM is
indicated.

Short text configured for tag
Text of system message
Name of tag

Time stamp

Configured message type
Value of the process variable

Name of the written process variable

When using a line length of 80 characters and using tag names with a length of
16 characters, the time stamp will be printed without a separator, i.e.
“hhmmssmssS” will be printed instead of “hh:mm:ss.mssS”.Example:
12:30:24:333 will be printed as 123024333.
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Section 12 System Display

General description — System display

The standard system display in Freelance Operations shows the current status of
the hardware and software of the Freelance system at process level. The color of
the displayed components of the process level allows you to recognize the current
state. A Freelance operator station is always provided with one system display.

Calling up the system display

Via the toolbar

AEAO

Call up system display.png

Q Left-click the toolbar icon

Via the Display menu item

Q Display > System display
or
ALT+D>Y
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Via the context menu

Q Call up context menu > System display

Operating procedures in the system display

The system display provides information on the operator station and on the
configured process stations.

There are two different display areas available:
e  Leftside: tree view
e Right side: detailed view of the objects selected in the tree view

The separator line between the display areas can be moved with the mouse (left
mouse button pressed).

Graphic view of configuration (tree and system view)
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System display overview.png
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Display of Control Net redundancy

The system display of a Freelance Operations station always represents the system
in relation to the station. If the system comprises redundant controllers that are
connected to the system bus while the local station is not connected, this operator
station has no access via the B line. For this reason, the B line is shown in red.

Navigating in the system display

¥

The keyboard focus can be changed between the tree view and the module view
using
the TAB key.

In the tree view: Left-click appropriate object

(I)r: the station view: Double-click appropriate object

?r: the tree view: Select the object using the CURSOR KEYS

?r: the system view: Select the object using the CURSOR KEYS > ENTER

Each time the system display is called, a buffer memory is set up. Each newly
selected object in the tree leads to a new entry in this memory. You can call up
these objects without having to navigate again.

Operate > Previous object or Next object

or

CTRL + ALT + CURSOR KEY leftor CTRL + ALT + CURSOR KEY right
or

ALT+O>PorALT+0O>N

Diagnostic mode

The system display features two modes of display. The standard mode is designed
for normal operation. It contains information and instructions for normal
operations.

The diagnostic mode is provided for qualified personnel with special training in
diagnostics. It is here that information on diagnostics and operating instructions,
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over and above those in the standard mode, are provided. The title line changes
from “System display” to “System display — diagnostics” to indicate that the
diagnostic mode is selected.

Accessing the diagnostic mode:

g Operate > Enter diagnostic mode...
or
ALT+O>E

If the User Management is enabled, the user group must be assigned the “extended
diagnostics” rights. A diagnostic password is not required.

If the User Management is disabled, the diagnostic mode is password protected.
After entering the password the program changes to diagnostic mode.

Please refer to the Engineering Manual - User Management for detailed user
permission configuration.

The default diagnostics password is "diag". The password can be defined and

ﬂ changed separately for each operator station in Freelance Engineering. Please
refer to the Engineering Manual, System Configuration, Project Tree,
Editing Objects, Operator station.

Enter Diagnostic Password

Password: ||

cocs

Diagnostic password.png

Exit the diagnostic mode

g Operate > Leave diagnostic mode ...
or
ALT+O>L
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If the Security Lock is not enabled, the diagnostic mode is automatically left when
a new display is called.

If the Security Lock is enabled, the diagnostic mode is quit upon a user change.
Calling up another display will not close the diagnostic mode.

For further details, refer to Engineering Manual - User Management.

Operator station

Calling up the operator station

Q :Jr; the tree view: Left-click appropriate operator station object
In the station view: Double-click operator station icon
?r: the tree view: Use the CURSOR KEYS to select the operator station
?r: the system view: Use the CURSOR KEYS to select the operator station >
ENTER

Call up operator station.png

Operator station properties

When the operator station is called up, a dialog box with both the Operator station
and Diagnostic data tabs is displayed.
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Operator station

The diagnostic data tab is only visible when the program is in diagnostic mode.

By default, only the Operator station tab is shown.

Operator Station

VIS Properties

D05 Resource

General data
Mame: Short texd:

Project Prirter

Mame: demo2013 Frirter 1: on

D08 system
Frinter 2: On
Resource-ID: 22

Cancel

Apply

Operator station properties.PNG

General Data

Name, short ~ Name and short text of the operator station

Project

Name Project name, i.e. name of the currently loaded project

System

Resource ID  Resource ID of the operator station

Printer
Printer 1, printer 2, On ,Off

Printer names for channel 1 and channel 2

The current status (On/Off) is displayed and can be changed by the

operator.

A change-over is only possible in diagnostic mode. The printer
settings are initialized each time Freelance Operations is started.
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Diagnostic data of the operator station

VIS Properties %
D-0S Resource Diagnostic Data
Project

Bootstraps Loads Comections

Version: 15 ) 139 . 65535

Memary (RAM)

Total size: 2057151 | KByte Free: 2057151 @ KByte

Cancel Aoy

Diagnose data.png

Project
Bootstraps Number of Freelance Engineering bootstrap procedures
(Load, whole station)

Loads Number of Freelance Engineering loading procedures
(Load, changed objects)

Corrections  Number of Freelance Engineering correcting procedures
(Commissioning, correct)

Memory (RAM)
Size of overall and free memory of the operator station PC

For further details on this topic, please refer to Engineering Manual, System
Configuration, Commissioning, Version check.
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Process Stations

Calling up a process station

Q :Jr; the tree view: Left-click appropriate process station object
In the station view: Double-click process station icon
?r: the tree view: Use the CURSOR KEYS to select the process station
(I)r: the system view: Use the CURSOR KEYS to select the process station >
ENTER

Displaying a process station

The selected process station is displayed in a more detailed manner with the
configured and installed modules. Color coding of the modules distinguishes, for
example, whether the module is equipped and installed (ok), equipped but not yet
installed (red) or faulty (red). Other possible statuses are inactive (gray), other
module found than configured (orange) or found but not configured (yellow).

Displaying an AC 900F controller in the system display
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Displaying an AC 800F controller in the system display
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Displaying an AC 700F controller in the system display
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Displaying a rack-based process station in the system display

Cabinet name Rack bay name
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Displaying redundant process stations

L

Redundant stations can be recognized by the connecting line between the primary
and secondary CPU.

While the synchronous redundancy status is indicated by a continuous line, the non
synchronous redundancy status is represented by a dashed line or gray connection.

E In the detail display of the redundant station, the P and S characters on the CPU
front or next to the controller show which of the CPUs is currently the Primary
or Secondary.

Please also refer to Engineering Manual, System Configuration, Project tree
and Hardware structure.

Process station properties
When the process station is called up, a dialog box with both Operator station and
Diagnostic data tabs is displayed.

The diagnostic data tab is only visible when the program is in diagnostic mode.
By default, only the Resource station tab is shown.
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Process Stations

<Controller type> Resource

The display shows an example of the available information concerning a redundant
AC 800F. The other resources use only parts of this dialog box.

AC 800FR Properties =]
AC 800FR Resource |
— General data
Name: IJ"‘EBJDDFH? Short text: I
— PI‘O]EECt — CPU type
Name: Isv'l 02_main = PM 802F ¢ PMBO3F
— Run/5Stop switch 1P1 — Run/Stop switch P2
*  Run ¢~ Stop = Fun i~ Stop
— Prim/Sec state
IP1: IDI'iITIEIIT IP2: Isecondaw
— Resource
State: Irunning Download active: IFALSE
Red. state: ISY”C— Date./Time: |DT#2D1 5-04-28-14:55:15.465
[~ Stopped by Run/Stop switch [T Stopped by user command
oK Cancel Apply

ACB00FR_us.PNG

General data
Name, Short text

Name and short text of the resource

Project

Name Name of the loaded project
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CPU type
PM 802F/ PM 803F
Shows the configured CPU type of the resource

(only for AC 800F)
Run/Stop switch
Status of the RUN/STOP switch on the module
(not for AC 700F)
Prim/Sec status
IP1/ 1P2 For a redundant resource, the Primary and Secondary texts
indicate which CPU is currently applied as Primary or Secondary.
Resource
State Status of the resource, e.g. running
Redundancy state

Redundancy status of the resource

sync: Redundancy fully functional

not sync: Transition status while redundancy is

being set up

no secondary: Redundancy partner is not accessible

no redundancy: No redundancy configured, but there

is a connection to a redundant station.

Please also refer to Engineering Manual, Process Stations,
Redundancy.

Download active
TRUE during download procedure; otherwise FALSE.

Date and time
Local time of the process station

Stopped by Run/Stop switch
The check box is selected when the resource was stopped by the
Run/Stop switch.

Stopped by user command
The check box is selected when the resource was stopped by user
intervention.
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Diagnostic data for a Process Station

The diagnostic data are comparable for all controller types. The available
information on the redundant AC 800F are shown as an example.

AC BOOFR Properties =
AC BOOFR Resource Diagnostic Data |

AC BDOFR station 1P1 ALC BOOFR station IP2
Software version: 010.002 Software version: 010.002

Hardware version: 0102 Hardware version: 0102
Serial number: LLLLIF Serial number: 0000045
Op. hours fotal): 113688 Op. hours fatal): 111528
Op. hours (exc. temp.): 0 Op. hours (exc. temp.): 0

Project Resource info

Bootstraps: Loads: Comections:

|5 B T [

CPU load: 21 %
AC BDOFR resource Last emor code: 1
Wersion: 10 2 1346
oK | Cancel | |

ACB800FR_Diag_us.PNG

Station IP1/1P2(only for AC 800F and AC 900F)
Shows details of the assemblies or modules; with redundant
stations, information is separately provided for both modules.

Project
Bootstraps Number of Freelance Engineering bootstrap procedures
(Load, whole station)
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Loads Number of Freelance Engineering loading procedures
(Load, changed objects)

Corrections ~ Number of Freelance Engineering correcting procedures
(Commissioning, correct)

Resource
Version Version number of the controller software

Resource info
CPU load Capacity loading of the CPU in %

Last error code
ErrorNo system variable

Modules
Selecting a module
In the tree view: Left-click appropriate object
or
In the station view: Double-click the object
or
In the tree view: Select the object using the CURSOR KEY'S
or
In the system view: Select the object using the CURSOR KEYS > ENTER
The selected assembly or module is displayed in zoomed format.
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Process Stations

vis_m1013_us.png

IP1:

P2

Birief description:
Module type:
Tay name:
Station position:
Slot:

Mo rodule found

Configured:  EI312F
Detected: EIB02F
YWrong module type

Ethernet module AL
EIB12FR
EIB12F_8_E1

8

E1

More detailed information about the object can be obtained in the following way:

Q In the tree view: Double-click the object

or

In the detail view: Double-click the object

or

In the tree view: Select the object using the CURSOR KEYS > ENTER

or
In the detail view: ENTER
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General properties of the objects

 DCP10 Properties [==]
DCP 10 Properties | Diagnostic Data |

General data

Name: [DCPID_PS2 Short text:

Type: [DCPIO Detectedtype:  [DCP1D

Run/Stop switch Prim/Sec.

& Run " Stop |PRIMARY

ok | Cancel |
General data
Name Name of the module according to configuration
Type Module type
Short text Configured short text
Detected type  Type designation of the module mounted in this slot
Run/Stop switch
Displays the Run/Stop switch position (for CPU modules only)

Prim/Sec Current status is PRIMARY or SECONDARY (only for CPU

modules with redundant process stations)
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DAI 04 - Transient check monitoring

DAIO4 Properties

=

140 Module | Diagnostic Data  Acknowledge Transient Check Monitoring Messages |

Status of transient check monitoring

0 Channel 7
Acknowledge clears transient check monitoring

el el el el oo ol s messages of all channels

oK | Cancel

DAI04_us.PNG

Status of the transient check monitoring
Display of the transient check monitoring messages

ACKNOWLEDGE The error status of all channels is reset and the normal
operation for the respective channels is resumed

DDO 0 Properties - Short circuit fuses

DDO01 Properties

X

140 Module | Diagnostic Data  short circuit fuses
Short circuit status

Ch.0 7 15 2 ey
oo cocoCcoCco oo oo oo C

QK Cancel

DDOO01_us.PNG
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Short circuit status
Short circuits displayed for each channel.

Reset Reset of the short-circuit fuses

Diagnostic data - modules

DAIO1 Properties | =2 |
/0 Module  Diagnostic Data |
Cycle time: ’F ms
Software version: |DEA4 22 Boot test result: TRUE
Hardware version: |04 Operating hours ftotal): 172164
Seral number.: DO00188 Operating hours {excess temp ): |0
ok | cancel | |
DAIO1_Diag_us.PNG
Cycle time Configured cycle time (not for DCP modules)

Software version
Version of the 1/0 or Boot EPROM

Hardware version
Hardware version of the module

Serial number Number of the production line

Boot test result
TRUE/FALSE: module operates correctly or incorrectly

Operating hours
Total operating time of the module

Operating hours (excess temp.)
Operating time with excess temperature
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Information windows can be selected for all modules. The information content
depends on the module type and may be more extensive than in the example

provided.

Status Display of the Objects

States displayed in the tree view
The status details active (black), faulty (red) and inactive (gray) are displayed in
the tree view. Color coding is applied to the object information (text) and not to the
icon.
If subsidiary level errors are encountered (1/O cards, PROFIBUS, FF), the objects

are displayed
as disturbed up to the process station in the tree view. Errors can thus be detected

in the collapsed view already.

Status in system and station view

In the system and the station view, the actual status of the modules is visualized by
different colors.

(AX 721F)

AX T22F DX 722F DC 732F DATOIF  AOQ 7T23F (DI 724F)

cm  Cl
TT2F 930F |~

DC T32F

vis_l008.png
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Module status color

Transparent (rear view)
There is no module configured at the slot or installed in the station.

gray The module is configured and the correct module type is mounted.

red A module is configured in this slot, but not present in the process
station.

yellow A module (e.g. of type DI 724F) has been detected as installed in
this slot, but there is no configuration available.

orange The module type configured in the hardware structure (e.g.
AO 723F) does not correspond to the installed module type (e.g.
AX T21F).

Force state

green There is a green rectangle displayed in the upper area of the
module (1/0 modules only). At least one I/O channel from an 1/O
module is forced, i.e. allocated a debug value. Please refer to
Engineering Manual, System Configuration, Commissioning,
Forcing inputs and outputs.

Rack or basic unit status

dark gray / green
The sub-rack or the basic unit is activated.

red The sub-rack or the basic unit cannot be addressed.

Status displayed in the detail view

An error or diagnosis status is visualized in the graphic view by a colored warning
sign next to the detail view of the module.

No module found (red warning sign)

A module is configured in this slot, but not present in the station.
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Configured:  EIB13F
Detected: EIG03F
P11 “Wrong module type

vis_m0023_us.png

Wrong module type detected (orange warning sign)

The module type configured in the hardware structure does not correspond to the
installed module type (e.g. DAI0404).

Wrang module type
Configured:  DAIDY
Mounted: DAIDA

vis_m0024_us.png

Forced channel detected (green warning sign)

At least one 1/0 channel from an 1/0 or slave module is forced, i.e. allocated a
debug value. See Engineering Manual, System Configuration, Commissioning,
Forcing inputs and outputs.

Faorced

vis_m0025_us.png
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Diagnostic value present (blue warning sign)

A diagnostic value has been logged for the slave or one module of the slave. The
diagnostic value is shown in the detail view of the slave below the graphic view.
Please also refer to Engineering Manual, Communications and Fieldbusses,
PROFIBUS, Diagnostic data.

Diagnostic data present

vis_m0026_us.png

Modules and field devices

Detail displays of the I/O modules

System information is displayed next to the module display on the right side. The
status of the module is indicated by a colored triangle. See also Status displayed in

the detail view, page 258.
Wrong module type
Configured:  DC732
A Detected:  AX722

vis_m1119_us.png
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| Mo module found

vis_m1019_us.png

Detail displays of the PROFIBUS

Detail display of the PROFIBUS module

In addition to module-specific status information, the detail display of the
PROFIBUS module provides information on the associated PROFIBUS master.
The PROFIBUS master is represented by the gray box on the PROFIBUS line.
Errors are indicated by a red warning sign.
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CI1 930F PROFIBUS module

J IP1:  Module OK

IP2:  Module OK

Brief description: Profibus module
Module type: Cl 930F

Tag name: CI930F_5_C1
Station position: 0

Slot: c1

vis_l012_us.png
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CM 772F PROFIBUS module

v

Module type:
Tag name:

Slot:

vis_l013_us.png

FI 830F PROFIBUS module

-

Brief description:

Station position:

e J Module OK

Mlodule OK

Profibus module
CM 772F
CMT772F 4 _C1
0

c1

Brief description: Profibus module
Module type: Fla30F
Tag name: FIB30F_3_F4
Station position 3

Pl 0P Slot F4

vis_l014_us.png
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Detail display of the PROFIBUS master

The detail display of the PROFIBUS Master features a bus line with the slaves
configured on the bus. The status information for the master as well as the slaves or
the field devices

are shown on the left side of the bus line. See also Status displayed in the detail
view, page 258.

The slaves are represented by bitmaps on the right side of the Fieldbus line. With
GSD-based slaves, these bitmaps can be referenced in the GSD file. In Freelance
Engineering, manufacturer-specific bitmaps can be subsequently assigned to each
slave. If no bitmap files are specified, the standard bitmaps will be shown. The
assigned bitmaps are not automatically loaded on the Freelance Operations station,
but must be copied into the <FreelanceData>\bitmaps directory of the operator
station.

264
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rarilaleig “endor: ABR
ASTER - Iodel name: Frafibus DFY1 Master
Tag name: PROF_3_F4
Bus address:
State: Operate
P REOED “Wendor: SIEMENS
A 1 SLAVE Maodel name: S7-315-2DP
Slave nat Tag name: . SL_3F4_1
axistent Bus address: 2
| T “Yendor: ABB Awutormation Technologies
‘ 2 hWodel name: SB00/CI340
; ; Tag name: SL3F4 2
Diagnostic _ R
data present Bus address: 18
P o “endar: ABB Automation
3 i Model name: =300 (DTM)
== Tagname SL_3F4 3
Bus address: 3
P “endor: Metso Automation
A 4 Iodel name: MOBO0PA,
; ; Tag name: SL3F4 4
Diagnhostic . A
data present Bus address: 35

vis_m0021_us.bmp

Detail display of the PROFIBUS slave

The detail display of the PROFIBUS slave is divided into two sections. The upper
section shows the device view in the form of an individual bitmap, which can be
assigned to the slave in the parameter window.

In addition, general information on field devices and their status are displayed.

Please also refer to Status displayed in the detail view, page 258 and to the
Engineering Manual, Communications and Fieldbusses, PROFIBUS,
Diagnostic Data.
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Additional diagnostic details are listed below the graphical representation of the
field device. The diagnostic values of the units are distinguished here from those of
the modules. The diagnostic values are device-dependent. Refer to the appropriate
manual for details on content and function.

Yendor:

Model narme: TZID-F

Tag name: AC10_TIIDN3
Bus address: 13

Forced

Diagnostic running 09:46:07 SEBit EEit Yalue
Mo data

[ 4% ]*/]% Standard diagnostic A Unit diagnostic A Module diagnostic /

vis_m1022_us.png

An additional “DTM info” page is available in the lower section of the detail
display for slaves and modules provided with a DTM.

One Freelance Operations station in the project can be configured with extended
diagnostic features. Provided this Freelance Operations station includes the
required license, the available DTM function block interfaces can be called up via
view selection.

The graphical interfaces are device-dependent and can be restricted by different
user access rights.

If the extended diagnostic features are not configured, this page simply displays the
bitmap that is associated with the device.
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Select View: |1

for:  S800DF (28.4 ABB. DTM available)

‘ Functions | Documentation

Slave address: 3

Shatn

5 6 7 8 9 10 11 12 13 14 15 16

— Station Diagnosi

Slot 1:
Charinel related emror
Slot 3:
Channel related emror
Slot 4:
Channel related emror
Reread | Cloze | Help
=

A= [*] O™ Info A Standard diagnostic A Unit diagnastic }, Module diagnostic 7

vis_m0028_us.png

The device DTMs can also provide functions without graphical interfaces

for diagnostics, operations or documentation purposes. The available functions can
be viewed and called up via the “Functions” or “Documentation” items.

The functions are device-dependent and can be restricted by different user access
rights.

Please also refer to Engineering Manual, System Configuration, Project tree,
Editing Objects and Engineering Manual, System Configuration, Hardware

structure, User access.
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Detail display of the FOUNDATION Fieldbus (FF)

Detail display — FOUNDATION Fieldbus, HSE protocol module

Foundation Fieldbus HSE protocol function block (FF_HSE)

State : Running

CPU-Load : 39 %
FF-Cycle: 24 %

Fieldbus

Foundation

High Speed Ethernst

vis_m0029_us.png

The detail display of the FF protocol module shows the status and the load capacity
of the FF communication.

In addition to the CPU load, the current total load of the HSE FI840F module is
displayed. The FF cycle value indicates the capacity loading of the cycle
configured for the Publisher subscriber service. If the system is overloaded, this
value can exceed 100%. In this case, a system message is triggered.

The CPU loading can abruptly increase for a short term during client-server access.
If the FF values are read via an OPC server, make sure that both load values are
clearly below 100% as otherwise the read service may not be executed properly.
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Detail display — FOUNDATION Fieldbus, HSE link

g’ Tag name: HSE_LINk_1
HSE =

‘ = - Tay narne: LD

] Module type: ABB LDSOOHS
Frimary E IP address: 172.16.2.60
No Secondary IP address (redundant)  172.16.2.61
e Tag name: Lo2
Madule type: ABB LDBOOHS
Prirary E IP address: 172.16.2.66

—_— - Tay narne:; LD3
‘ Module type: ABE LDBOOHS
Mo connection A IF address: 172.16.2.68

vis_m0030_us.png

The detail display of the FF HSE link object shows the “Tag name” and the HSE
devices (linking devices) configured on the HSE segment in question.

The status of the configured FF linking devices is shown on the left side of the
HSE subnet.

Details link the “Tag name”, “Module type” and “IP address” are displayed on the
right of the HSE subnet.

In the tree view, the “Live list” for this HSE link can be called up via the context
menu. All currently active HSE and H1 devices are displayed here.

Please refer to Detail display showing subscribers in the HSE segment, page 275.
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System Display

Detail display — FOUNDATION Fieldbus linking device

vis_m0031_us.png

Tag name:
Module type:
Brief description:
IP address:

IP address (redundant)

LD1

ABB LDBOOHS
Fieldbus linking device
172.16.2.60
172.16.2.61

J 172.16.2.60 : Primary
A 172.16.2.61 : Mo Secondary

The detail display of the FF HSE linking device shows the configuration data such
as “Tag name”, “Module type”, “Short text”, “IP address”, “IP address
(redundant)” (only for redundant linking devices) and the configured H1 links.

The current status of the connection is shown under the configuration data.

In the tree view, the “Live list* for this HSE link can be called up via the context
menu. All currently active HSE and H1 devices are displayed here.

See also Detail display showing subscribers in the HSE segment, page 275.
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Detail display — FOUNDATION Fieldbus, H1 link

’ Tag name:
Hi Link = Link address:

LAS State:

P Tag narme:

=]
‘ - | Yendor:
] Device type:
I 1
a connection > Device 1D

Bus address:

— Tag narme:

34 — Yendor:
Ll | Device type:
e Device 1D

Bus address:

=] Tag narme:

25 Yendor:
Device type:
Device 1D
Bus address:

= !- ’ Tag name:
‘. 24 : “Yendor:
Mo connection gev!ce %pe:
evice

Bus address:

vis_m0032_us.png
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LD1_H1_FF1
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O00EDS2328M0o0000605018630
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2
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24

The detail display for the FF H1 link object shows the configuration data “Tag
name”, “Manufacturer name” and “Link address” as well as the current “LAS

status™ (status of the “Link active scheduler”).

The “LAS status” can be as follows:
e  “Running”

“Stopped”

“Unknown”

“Not loaded”

“Configuration error”

The status of the configured devices is shown on the left side of the H1 bus.

Device-specific bitmaps and the configuration data “Tag name”, “Manufacturer
name”, “Device type”, “Device ID” as well as the bus address of the devices are

displayed on the right side of the H1 bus.
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If no bitmap is configured, the standard bitmap is displayed.

In the tree view, the “Live list” for the H1 link can be called up via the context
menu. All configured H1 devices and all currently active H1 devices are displayed
in this list. See also Detail display showing subscribers in the H1 segment, page
277.

Detail display — FOUNDATION Fieldbus, H1 device

Tag narne: FF_DEWIC_002
Wendor AEB
Device type TZIDC-x20
Device 1D 0003200028 TZIDC-FFO35LT
Bus address: 40
Block ID 0D Index  Block Type Tag Name

_l" | Resource Block 300 RB0133 ABB RES_0002 Automatic (Auto)

_"' | Transducer Block 1 800 TRE010 ABB TRD1_0002 Automatic (Auto)

_’ | Function Block 1 400 AD - ABB FF-AQD2 Automatic (Auto)

_’ | Function Block 2 500 E-PID ABB FF-FID Out of Serice (0/5)

vis_m0034_us.png

The detail display for the FF H1 device shows the configuration data “Tag name”,
“Manufacturer name”, “Device type”, “Device ID” and the bus address of the
device in addition to the bitmap.

In the event of an error, a warning sign is displayed below these data.

The resource, transducer and function blocks and their current mode of operation
are displayed below the general information for the device.

The mode of operation of the blocks is indicated as follows:
e  Automatic (Auto)
e  Out of Service (O/S)
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Remote Output (ROut)

Remote Cascade (RCas)

Cascade (Cas)

Manual (Man)

Local Override (LO)

Initialization Manual (IMan)

»  (In case of an error: no display)

One Freelance Operations station in the project can be configured with extended
diagnostic features. Provided this Freelance Operations station includes the
required license, the parameters of the FF functions block can be viewed and even
changed, if the user has the appropriate access rights. Only parameters that have
been enabled in the function block class for access to Freelance Operations are
displayed.

The dialog displays the relative index, name, value, unit, value area, and the
comment for these parameters.

The title bar changes to “Diagnostic mode” to show that the user is in the
diagnostic mode.

Please refer to Engineering Manual, System Configuration, Project Tree,
Editing Objects, Operator station D-LS.
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B Parameters: Al - SMAR Al - SMAR  Diagnostic mode g|
General data
Name: ’Smar_Al— Short text: ’—
Long text: |
Helativl Mame | Value | Unit Fange | Comment -~
|1 ST_REY 1
]2 TaG_DESC ‘Smar Al Test!
13 STRATEGY 0
_ |4 ALERT_KEY 0 1.285
|5 MODE_ELK v
|51 Target I
151 .ROut r
|51 .RCas I
|51 .Cas I
|51 Ao v
|51 Man I
151 Lo r
|51 IMan r
151 .0os r
|52 Actual =
5.2 .ROut r
|52 RCas r
|52 .Cas I
|52 Auta i
|52 Man r
5.2 Lo r
|52 AMan I
5.2 .0os r
|53 .Permitted v
153 .ROut r
|53 .RCas I
|53 .Cas I W
< >
Cloze | Lancel | Wwirite | Help |

vh_mo0035_us.png

The Freelance Operations access requires additional Client/Server services on the
H1 Link, which could affect the data transfer rate. This is why only the following
standard parameters are enabled for the Freelance Operations access by the system:
e ST REV

e TAG_DESC

¢ MODE_BLK

e BLOCK_ERR

Further parameters can be enabled in Freelance Engineering in the function block
class for access from Freelance Operations. However, the limited data rate of an
H1 link must be taken into consideration.
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Please also refer to Engineering Manual, Communication and Fieldbusses,
FOUNDATION Fieldbus, Configuration, FF Libraries, FF function block
library.

Writing FF function block parameters

A logged-in user with the Operate access right may edit a value parameter in the
“value” column and subsequently write it into the H1 device using the “write”
button.

If the User Management is disabled, only the configured access rights are
evaluated. In Freelance Engineering, the access right is configured in the HWSYS
node in the tree view of the hardware structure (Edit / Access rights).

Logging of operator interventions

Writing of FF function block parameters is recorded and stored in the signal
sequence log.

The format corresponds to the entry in the case of operating procedures in the
faceplates.

Detail display showing subscribers in the HSE segment

The “Live list” for the HSE link can be displayed in the tree view on the objects
FOUNDATION

fieldbus HSE link (FF_HSE_LINK) and the FOUNDATION Fieldbus linking
device

(FF_HSE_DEV) via the context menu. All HSE and FF devices that are currently
active in the HSE segment are displayed in a hierarchic structure. Devices of other
projects will also be displayed, if any.
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B HSE Live List (w3

= E FF_HSE_D_001 D-3 Pri [172.16.32.80] (0003200067 D800HSEQD000030200109,
E| iﬁl H1 Link [4D36]
r,.,,. PI2600T [ 26] (0003200089_2600T_TO___1781665)
-r%, SRDS91[28] (3858842401_SRD931516/026338)
f;.'.',' ABB_TFO2 [ 30] (000320001 E0000000000000000766271)
¢ l.r% SAMSON_3787[53] (0DEDS900071_200323)
e H1 Link [4097]
-r%, ROSE3051[20] (0011513051081708182456-030057675)
%, TO2600_21[21] (D003200089_2600T_TO___1781673)
% FI_DVCB010 [ 36] (0051006000FisherDVC0070208332139)

4 1 | »

HSE_Live_list_us.PNG

The device-specific entry is composed of:

Tag name Tag name for the device. The tag name configured for a device
is written into the actual device during device assignment.

Redundancy mode
With an HSE device, the tag name is followed by the redundancy
mode (Pri, Sec). Non-redundant devices are indicated by the “Pri”
mode.

Address Device address.
For HSE devices - the IP address of the HSE device.
For H1 devices - the bus address on the H1 segment. The bus
address configured is written into the actual device during device
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Device ID

assignment.
For H1 links - the segment address of the H1 segment.

Unique identification number of the device. A unique device ID is
assigned to each device by the manufacturer and remains
unchanged. During device assignment, the device ID is read from
the device and recorded in the database.

Detail display showing subscribers in the H1 segment

The “Live list” of the H1 link can be displayed at the FOUNDATION fieldbus H1
link (FF_H1_LINK) object in the tree view via the context menu. All configured
H1 devices and all currently active H1 devices for this H1 link are displayed in this

list.

FF Live List of HL Link: LD_LINK_1 =]
Active Devices Configured Devices
Add PD Tag Device Type Device ID Add PD Tag Device Type | Device ID
r:, 26 PI2600T ABB 2600T_TO 0003200089_2601 r:. 26 PI2600T ABB 2600T.. 0003200089_2600T_TO___17816€
r:, 28 SRD991 Foxb SRD991 3858842401_SRC r:,:EB SRD991 Foxb SRDY9.. 38588424071_SRD991516/026398
ris30  ABB_TFO2 ABE Instrument 000320001E0000 r:, 30 ABB_TFOZ2 ABBTFDZ.. 000320001E00000000000000007E
.. SAMS0 Positi 00E0SS0001_200: ri,53 SAMSON_3.. SAMSOPo.. 00ED390001_200323

r%53 SAMSON_3787

< m 2

Close

[~ Show unassigned devices

H1_LiveList_us.PNG

Address

Tag name

Bus address of the device. The bus address configured is written
into the actual device during device assignment.

Tag name for the device. The tag name configured for a device is
written into the actual device during device assignment.
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Device ID Unique identification number of the device. A unique device ID is
assigned to each device by the manufacturer and remains
unchanged. During device assignment, the device ID is read from
the device and recorded in the database.

Device type  The device type specified in the description of the device.

Show unassigned device
A filter can be activated in order to reduce the number of devices

displayed. When this filter is set, only devices that are not assigned

are displayed in the display window, namely

- configured devices without device ID,

- active devices with temporary addresses (248... 251),

- active devices with permanent addresses (20...247) that
have not been entered into the configuration.
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Status displays of FOUNDATION Fieldbus devices

Status display of an HSE device

Normal status. There is a connection to the HSE device; the device appears in the

“live list™:

172.16.2.66 : Primary

There is no communication link to the HSE with the specified IP address, the tag

name or the device ID:

172.16.2 66 : Mo connection

Possible error cause

Corrective measure

The physical HSE device is not connected to
the HSE segment.

Connect the physical HSE device to the
HSE segment.

The Freelance Operations station is not
connected to the AC800F controller that is
linked via an FI840 module to the HSE
segment.

Establish the connection to the AC800F
controller.

The FI840 module is not connected with the
HSE segment.

Establish the connection between the FI840
module and the HSE segment.
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The FI840 module is switched off.

Switch-on the FI840 module.

The configuration is not loaded to the
AC 800F controller.

Load the configuration into the AC 800F
controller.

The current configuration is not loaded to the
Freelance Engineering station.

Load the configuration into the Freelance
Engineering station.

At least one of the configured parameters in
the database: IP address, tag name or the
device ID does not correspond to the current
value in the physical device.

If necessary, change the IP address in the
configuration and/or in the physical device
and assign the device once again.

Status display of a redundant HSE device

Normal status. There is a connection to
both devices appear in the “Live list”:

172.16.0.88 : Primary

172.16.0.89 : Secondary

the primary and secondary HSE device;

There is no communication link to the secondary HSE device. Only the primary

HSE devices appears in the “Live list”:

172.16.260 : Primary

172.16.2.61 : No Secondary
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Possible error cause

Corrective measure

The secondary device is in error status; it is
not ready to assume the function of the
primary linking device.

Replace the defective HSE device.

Follow the instructions on replacing a
defective linking device in a redundant
configuration of linking devices.

The physical HSE device is not connected
to the HSE segment.

Connect the physical HSE device to the HSE
segment.

Follow the instructions on commissioning
redundant linking device as specified in the
user documentation for FF linking devices.

The IP address configured in the database
does not correspond to the current IP
address of the physical device.

If necessary, change the IP address in the
configuration and/or in the physical device.

Follow the instructions on commissioning a
redundant linking device as specified in the
user documentation for FF linking devices.

There is no communication link to both redundant HSE devices. None of the HSE

devices appears in the “Live list”:

172.16.2.60 : No connection

17216.2.61 : Mo Secondary

Possible error cause

Corrective measure

Both HSE devices of the redundant
configuration are not connected to the HSE
segment.

Connect the physical HSE devices to the HSE
segment.

Follow the instructions on commissioning a
redundant linking device as specified in the
user documentation for FF linking devices.
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The Freelance Operations station is not
connected to the AC800F controller that is
linked via an FI840 module to the HSE
segment.

Establish the connection to the AC800F
controller.

The FI840 module is not connected with
the HSE segment.

Establish the connection between the FI840
module and the HSE segment.

The FI840 module is switched off.

Switch-on the FI840 module.

The configuration is not loaded to the
AC 800F controller.

Load the configuration into the AC 800F
controller.

The current configuration is not loaded on
to the Freelance Operations station.

Load the configuration into the Freelance
Operations station.

The IP addresses configured in the
database do not correspond to the current
IP addresses of the physical devices.

If necessary, change the IP addresses in the
configuration and/or in the physical devices
and assign the device once again.

Follow the instructions on commissioning a
redundant linking device as specified in the
user documentation for FF linking devices.

Status displays of an FF H1 link object

No connection to the H1 channel of the linking device.

Possible error cause

Corrective measure

No connection to the HSE device (FF
linking device) containing the H1 channel.

For possible causes, refer to the “Status of

an HSE device” tables.

See “Status of an HSE device” tables.
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The H1 channel in the HSE device (FF Activate the H1 channel and commission the
linking device) associated with this H1 linking device (“Load the configuration of the
segment is not activated. H1 port”).

Status displays of an FF H1 device

There is no communication link to the H1 device with the specified bus address,
the tag name or the device ID:

Mo connection

Possible error cause Corrective measure

No connection to the H1 channel of the See “Status H1 link” tables.
HSE device (FF linking device). For

possible causes, please refer to the “Status

H1 link” tables.

The physical H1 device is not connected to  Connect the physical H1 device to the H1 link.
the H1 link.

At least one of the configured parameters Perform an assignment of this H1 device.
in the database: IP address, tag hame or

the device ID does not correspond to the

current value in the physical device.
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Section 13 WEB Display

General description — WEB display

When a WEB display is called up in Freelance Operations, the local WEB browser
is loaded and the link to the configured Web site is activated.

The WEB display starts the local WEB browser. Users of Freelance Operations
could thus access files on the local machine or other machines in the Intranet or

global Internet.
Mind the risks and hazards involved.

Calling up the WEB display

Via the toolbar

][O 7 | [

Call up web display.png

Q Left-click toolbar icon > In the display explorer double-click appropriate WEB
display

Via the Display menu item

Q Display > WEB displays > In display explorer double-click appropriate Web
display
or
ALT+D >W > Use CURSOR KEYS to select appropriate Web display or
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enter first letters of the display name > ENTER

Via the context menu

In order to call up a Web display via the context menu, you must first select a tag
to which a Web display has been assigned in Freelance Engineering using the
Display access function.

Q Select tag > Call up context menu > Select Web display

From the overview display

Q Left-click appropriate Web display icon
or
Use CURSOR or TAB keys to select appropriate Web display icon > ENTER

From a graphic display

In order to call up a Web display from a graphic display, a graphic object that
features the Show display action configured with a Web display in Freelance
Engineering must have been previously selected.

Q Left-click graphic object with appropriate configuration
or

Use TAB KEY to select appropriate graphic object > ENTER
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Operating procedures in the WEB display

The operating procedures in the WEB display are given by the activated WEB site.
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Section 14 Multi Monitor

General description — Multi Monitor

Multi Monitor allows user to customize the display types on up to four monitors
during engineering. This gives users a better overview with improved structured
displays.

Freelance Operations goes to Emergency mode if more monitors are configured
in Freelance Engineering than licensed in Freelance Operations. Thus, user
needs to upgrade the Freelance license or change the monitor settings.

For detailed information about Quad Monitor, please refer to the chapter in user
manual of Engineering — Operator Station Configuration.
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Section 15 System Messages

Alphabetic list of system messages

Message text The text is displayed in the message list or the signal sequence log

Pr Priority level S1, S2 or S3
Mr Message rate:
1 = Message with one state, e.g. ‘Redundancy toggle occurred’
2 = Message with two states, e.g. ‘Battery low’ and ‘Battery low is
gone’
[.. The text in the brackets is not displayed in every case.
Message text Pr | Mr | Cause of message Remedy
Acquisition of S1 |1 Trend values were (partly) Check the connection to the
trend "xxxx' not received from OPC OPC server PC and the project
interrupted server. configuration.
Acquisition of S1 |1 The trend could not be Check the connection to the
trend 'xxxx' not started; writing to trend process station and the project
started function blocks failed. configuration.
Archivingoftrend |S1 |1 An unexpected error Create more space on the disk

'xxxx' has been
stopped

occurred while writing trend
archive data, e.g. the hard
disk is full.

in question or switch the
storage of log files etc. to a
disk with more space
available.
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Message text Pr | Mr | Cause of message Remedy
Audio file not S1 |1 A wave file can be Contact your authorized
found configured for each process | service engineer.
alarm.
Battery low (IP1/2) | S2 |2 CPU module battery is flat or | Replace or connect battery.
disconnected.
Battery low inCPU | S2 | 2 CPU module battery is flat or | Replace or connect battery.
module disconnected.
Battery low inlink | S2 | 2 Battery of link module is flat | Replace or connect battery.
module or disconnected.
Battery low in S2 |2 Battery of the module is flat | Replace or connect battery.
module E1/E2 or disconnected.
[(1P1/2)]
Channel xxx, edge | S1 |2 In a DDIO1 a change of edge
detection of the input signal was
detected from channel xxx
and reported with the
accompanying time stamp.
The report is written only in
the record and not in the
report page.
Coldstart by S1 |1 Due to a problem, a cold start | Contact your authorized
firmware was triggered on the CPU service engineer.
module.
Coldstart by S1 |1 An operator action (in Normal operation.
operator Freelance Engineering) has
caused a cold start on the
process station.
Coldstart by S1 |1 The application program has | Normal operation.

program

caused a cold start on the
process station.
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stopped, all files in
use

'Xxxx' has been halted
automatically. The maximum
volume of data for this log
has been reached, and
automatic deletion has not
been configured.

Message text Pr | Mr | Cause of message Remedy
Coldstart by reset S1 |1 A cold start has been Normal operation.
switch triggered on the CPU-
MODULE by the reset
button. Reset button pressed
for more than 5 seconds.
Coldstart from S1 |1 After reaching the safety Check reason for safety state
safety state state a cold start on the using the boot cause
process station has caused. information dialog.
Connection to S1 |2 The link to station 'xxxx' has | Check that the process station
'Xxxx' interrupted been disturbed. is functioning correctly and
check its system net
connection.
Counter overrunon | S2 |2 The internal counter in the Contact your authorized
channel "xxxx' frequency input module has | service engineer.
overrun.
Create fileon FTP | S1 |1 FTP access at target station Check the configured archive
'xxxx' failed failed, e.g. the configured path of the trend display
path may be wrong. configuration.
Data lost for all S2 |1 Data may have been lost by | Check the terminating
modules of process all subscribers as a result of a | resistors and the cable lengths
bus 1 [to 3] CAN bus error. or contact your authorized
service engineer.
DCL "xxxx' S1 |1 The disturbance course log Delete or export log data and

re-start the log. You can also
configure automatic deletion.

Operators Manual — Freelance Operations

293




Alphabetic list of system messages System Messages

Message text Pr | Mr | Cause of message Remedy

DCL 'xxxx'wasnot | S1 |1 The print job for the Check your system installation

printed disturbance course log could | or check that the printer is on-
not be carried out. line.

Presumably the printer driver
is not installed or the printer

gueue is full.
DDI01 modulenot | S2 |2 Internal error when invoking | Check the configuration or
exist the module method. contact your service
technician.
Diagnosis fault for | S3 | 2 Diagnosis faults were Check the associated
modulenlIm.... reported for the specified PROFIBUS module or contact
module. the slave manufacturer’s

service technician.

Diagnosis fault for | S2 | 2 A PROFIBUS unit has sent Check the connected

unit diagnosis faults. PROFIBUS units or contact
your authorized service
engineer.
Different time S1 |1 Contact your authorized
zones for project service engineer.
and Vis PC
Disturbance course | S1 |2 Log in emergency halt. An Create more space on the disk
log 'xxxx' stopped unexpected error occurred in question, or switch the
while writing log data, e.g. storage of log files etc. to a
the hard disk is full. disk with more space available
EN-Wire breakon | S3 |2 The cable connection for the | Check the relevant process
channel "xxxx' control input EN (Enable) is | signal cable.
faulty.
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accepted ("xxxx')

device addressed 'xxxx' was
denied due to an incorrect
password.

Message text Pr | Mr | Cause of message Remedy

Environment S1 |1 Under previous Windows Remove the environment

variable TZ is set systems this variable was variable from the system or
used to define the time zone. | user settings.

It can no longer be used as
nowadays the time zone is
handled differently.

Error: Restart FTP | S1 |1 FTP access at target station Restart the FTP server or

server “xXxxx' failed. contact your authorized

service engineer.

Export failed dueto | S1 |1 FTP export: Failure to save Increase size of Temp

copy file export file in temporary directory or delete
storage in the Temp directory | unnecessary files from it.
of the sending PC.

Export queue full S1 |1 The export of log data Use a faster network
requires a certain length of connection to the FTP server,
time, depending on the type | or a more powerful server.
of network connection to the | Alternatively, reduce the
FTP server and on the number of transmit tasks per
volume of data The unit of time.

Freelance Operations station
is producing transmit jobs
faster than they can be
processed.

Export: FTPconn. |S1 |1 No connection could be Check the target device.

('xxxx") failed established to the export
target device addressed
XXXX'.

Export: FTP not S1 |1 Access to the export target Check the password.
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has occurred in one of the
FOUNDATION Fieldbus
devices.

Message text Pr | Mr | Cause of message Remedy
Export: General S1 |1 A general error has occurred | Check the amount of storage
FTP error ('’xxxx') while exporting the archive available on the target device.
data.
Extended S3 |2 A PROFIBUS slave has Check the PROFIBUS slave
diagnostic data given an overflow of or contact slave
overflow diagnostic data. Probably a manufacturer’s service
“flutter’ signal. technician.
Fault in diagnosis S3 |1 The module has announced Check the effected 1/0 module
data the unknown diagnostic data. | or contact your service
Fault in output S2 |2 There is a short circuit on Check the process signal
channel "xxxx' output channel "Xxxx' connection, eliminate short-
circuit.
FF configuration S2 |2 The configuration that is to Adapt the configuration in
identity mismatch be loaded into the Freelance Engineering
FOUNDATION Fieldbus according to the physical
devices is not suitable for the | conditions.
devices which are physically
present.
FF cycle overrun S2 |2 The configured HSE bus Change the FF configuration,
cycle time was exceeded. e.g. increment the bus cycle
time.
FF data exchange S2 |2 The communication of FF
data has been reestablished.
FF HSE S2 |2 An internal error occurred
initialization error during initialization of the
HSE protocol function block.
FF PNA error S2 |2 An internal software error Check the fieldbus devices

and replace the defective
device.
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Message text Pr | Mr | Cause of message Remedy
FF protocol error S2 |2 An error has been detected in
the communication protocol
of the FOUNDATION
Fieldbus line.
FF state not ready S2 |2 Not possible to communicate | Check the hardware
FF data. installation and the
configuration.
FI840 IP [1/2] link | S2 |2 Communication disruption Check the Ethernet cable.
broken on the Ethernet link of the
F1840 module, possibly a
faulty cable, or cable not
plugged in.
FI840 IP [1/2] link | S2 |2 Ethernet connection of F1840
running module established.
First adjustmentnot | S1 | 2 An internal error has Contact your authorized
finished occurred on the secondary service engineer.
CPU during data balancing
between the CPU modules.
Frame-Error on S2 |2 An error has occurred in the | The time sequence of input
channel "xxxx' measurement timing on the signals at the frequency input
channels indicated. module DFI 01 should be
checked, depending on
operating mode.
Error Configuration | S1 |1 An error has occurred while | Check available disk space at

change Freel
Operations

loading new project data to
the Freelance Operations
station.

your Freelance Operations PC
or contact your authorized
service engineer.
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Diagnosis overflow

(9)

the diagnostic value 9 —
Overflow of diagnostic
messages.

Message text Pr | Mr | Cause of message Remedy
Hardkey not found | S1 |2 The hard key required for Check that the hard key is
operating the software was installed, and/or check its
not found. connection. Otherwise, contact
your authorized service
engineer.
High temperature S2 |2 The temperature of the CPU | The ambient temperature is
in CPU [(IP1/2)] module is more than 70 °C. probably more than 50 °C.
Reduce ambient temperature.
High temperature S2 |2 The temperature at the 1/0 The ambient temperature is
on 1/0 module module is above 70 °C. probably more than 50 °C.
Reduce ambient temperature.
HW module S1 |1 The processing station Check the assembly of the
assembly is cannot reach ‘sync’ state, modules in both controllers.
different because the assembly of the
two process stations is
different.
IN-Wire break on S3 |2 The cable connection for the | Check the relevant process
channel "xxxx' input signal IN is faulty. signal cable.
10 Bus: Module not | S2 | 2 The 10 module is detected, Check the 10 module and
ready but it is not ready for cyclic | check the process voltage of
data exchange. the 10 modules.
10 Bus: S2 |2 The module could not Check the 10 module or
Parameterization parametrized. contact your authorized
failed service engineer.
10 Module: S2 |2 The module has announced Check the 10 module or
Checksum error the diagnostic value 19 — contact your authorized
(19) Checksum error. service engineer.
10 Module: S2 |2 The module has announced Check the 10 module or

contact your authorized
service engineer.
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Message text Pr | Mr | Cause of message Remedy
10 Module: S2 |2 The module has announced Check the 10 module or
Different versions the diagnostic value 40 — contact your authorized
(40) Version error. service engineer.
10 Module: S2 |2 The module has announced Check the 10 module or
Internal data the diagnostic value 36 — contact your authorized
exchange (36) Error during internal data service engineer.
exchange.
10 Module: S2 |2 The module has announced Check the 10 module or
Internal error (43) the diagnostic value 43 - contact your authorized
Internal error. service engineer.
10 Module: Low S2 |2 The module has announced Check the 10 module or
process voltage the diagnostic value 11 — contact your authorized
(11) Low process voltage. service engineer.
10 Module: No S2 |2 The module has not Change the module or contact
Communication / communicated properly fora | your authorized service
Slot empty specified length of time or engineer.
the module is not plugged.
10 Module: S2 |2 The module has announced Check the 10 module or
Parameter error the diagnostic value 26 — contact your authorized
(26) wrong parameter values service engineer.
found.
10 Module: Process | S2 | 2 The module has announced Check the 10 module or
voltage switched the diagnostic value 45 — No | contact your authorized
off (45) process voltage. service engineer.
10 Module: S2 |2 The module has announced Check the 10 module or
Timeout (3) the diagnostic value 3 - contact your authorized
Timeout. service engineer.
10 Module: Type S2 |2 The detected module type is | Check the plugged modules.

not supported

not supported with this
software version.
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Message text Pr | Mr | Cause of message Remedy
10 Module: Wrong | S2 | 2 The configured and plugged | Correct the configuration.
type plugged module types are different.
Lateral communic: | S2 |2 Station 'xxxx' has sent its Check that the process station
Timeout from data in the specified interval | is functioning correctly, and
station 'xxxx' time. check its system network
connection.
Check the possibility that the
station may be operating under
overload and therefore be
unable to send its lateral data
in the specified interval.
Less than "xxxx' S1 |1 Hard disk "yyyy" on the Create more space on the disk
MB free disk space Freelance Operations PC no | in question or switch the
on drive "yyyy": longer has sufficient free storage of log files etc. to a
space (less than 'xxxx' MB). | disk with more space
available.
Less than "Xxxx' S1 |1 Low free memory on the Check all active programs on
KB free memory Freelance Operations PC the Freelance Operations PC
(less than 'xxxx' KB). and close those applications
which are currently not
needed. If possible restart
Freelance Operations and/or
the Freelance Operations PC.
Maximum of S1 |2 The volume of redundancy Dividing the program of the
redundancy data data per task is limited to 64 | task in question into several
exceeded KB. One of the tasks has parts reduces the volume of
exceeded this limit, and the redundancy data.
redundancy has been
completely deactivated.
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test error

module’s boot test.

Message text Pr | Mr | Cause of message Remedy
Message S1 |2 The message connection for | Check that station 'xxxx' is
connection to logs and messages to station | functioning correctly and/or
station "xxxx' lost "XXXX' is lost. check its system net
connection.
Message list S1 |1 The system is producing In the message list
overflow more messages than the configuration, increase the
Freelance Operations number of messages (up to
message list can 4000 are possible). If this
accommodate. parameter is already at the
maximum, try reducing the
number of messages or
changing the acknowledge
levels.
Messages lost: S1 |1 The internal message The Freelance Controller is
overflow for prio management of the controller | unable to process the
XXXX' is overloaded. messages as quickly as they
are generated (more than
1000 new alarms per second).
Miss. external S3 |2 No auxiliary power or Check the connection for this
power supply disrupted auxiliary power to | auxiliary power supply, or the
channel group 1 [to the channel group in supply itself.
4] guestion.
Missing transmitter | S3 | 2 No external power supply for | Check the connection for this
supply channel the channel in question. power supply, or the voltage
group 1 [to 2] itself.
Module fault S2 |2 Errors occurred in the Change the module or contact
module. your authorized service
engineer.
Module fault: Boot | S2 | 2 Errors occurred in the Change the module or contact

your authorized service
engineer.
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not ready

slave does not communicate
correctly.

Message text Pr | Mr | Cause of message Remedy
Module fault: S2 |2 The module has not Change the module or contact
Communication communicated properly fora | your authorized service
error specified length of time. engineer.
Module fault: S2 |2 The configuration of the Change the configuration or
Configuration error module is not valid. contact your authorized
service engineer.
Module fault: S2 |2 The module cannot be Change the module or contact
Identification error identified. your authorized service
engineer.
Module fault: No S2 |2 No master can be found on Check the PROFIBUS
master the PROFIBUS. connection.
Module fault: S2 |2 The configuration of Change the configuration or
Parameter error on PROFIBUS master does not | contact your authorized
master match to the connected service engineer.
device.
Module fault: S2 |2 The configuration of Change the configuration or
Parameter error on PROFIBUS slave does not contact your authorized
slave match to the connected service engineer.
device.
Module fault: Self | S2 |2 In its cyclical self-test the Contact your authorized
test error module has detected a fatal service engineer.
error.
Module fault: Slave | S2 | 2 The configured PROFIBUS | Change the configuration or
not existent slave cannot be connected. contact your authorized
service engineer.
Module fault: Slave | S2 | 2 The configured PROFIBUS | Change the configuration or

contact your authorized
service engineer.
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connection failure
[IP1/2]

connection of the process
station does not work.

Message text Pr | Mr | Cause of message Remedy
Module fault: Slot | S2 | 2 A specific module type has Alter the configuration to
empty been configured for a slot, match the hardware installed.
but no module has been
plugged in.
Module fault: S2 |2 The module has an incorrect | Load a new firmware version
Wrong firmware firmware version. in the module, change the
version module, or contact your
service technician.
Module [IP1/2]: S1 |2 The number of self-test Contact your authorized
Number self test errors detected in the module | service engineer.
errors 'nnn’ is dumped. If the number of
self-test errors reaches 5,
then the module will no
longer boot up.
Module self test S2 |2 In its cyclical self-test the Contact your authorized
error [IP1/2] 'xxxx' module has detected a failure | service engineer.
that cannot be accepted.
Network buffer S1 |1 There are no more network A warm start will solve the
error, warmstart buffers available; current problem. Check and
recommended communication with the clean your network to avoid
process stations does not this problem for the future.
work correctly.
Network buffer S1 |1 Only few network buffers are | A warm start will solve the
low, warmstart available, communication current problem. Check and
recommended with the process stations is clean your network to avoid
endangered. this problem for the future.
Network 'xxxx' S1 |1 The system bus network Check the system net

connection of the process
station.
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Message text Pr | Mr | Cause of message Remedy
No connection to S1 |2 The mentioned network Check the network
xxxx' (IP1/2) via connection is disturbed; connections.
line A/B/A+B cable may be defective or not

connected.
No external power | S3 |2 No auxiliary power or Check the connection for this
supply output disrupted auxiliary power to | auxiliary power supply, or the
channel "xxxx' the frequency input module supply itself.

in question.
No prim. and S2 |2 The redundant PROFIBUS Check the connection and
second. master connection is disturbed. configuration of the redundant
connection PROFIBUS line.
No RED Link S1 |2 Communication disruption Check cable connection.
connection on the RED link, possibly a

faulty cable, or cable not

plugged in.
No valid daylight S2 |2 Time cannot be converted to | Correct or extend your

saving time defined

daylight saving time. The
summer-time table’s period
of validity has expired, or the
table does not contain any
times in standard
chronological order. Another
possible cause is that the
time to be converted lies
precisely within the one
undefined hour when
daylight saving time starts.

summer-time table, or check
the time to be converted
against the last error source
declared.
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underranging / wire
break channel 0 [to
7]

been over/under-ranged for
the channel in question, or
the cable is damaged there.

Message text Pr | Mr | Cause of message Remedy
Object error, first S1 |2 The user program could not | Do not load user program with
adjustment not be loaded fully. “Load selected objects”.
possible Instead, update the project
data with “Load entire station”
or at least with “Load changed
objects”.
Operation log S1 |2 Log in emergency halt. An Create more space on the disk
'XXXX' stopped unexpected error occurred in question, or switch the
while writing log data, e.g. storage of log files etc. to a
the hard disk is full. disk with more space available
OPL "xxxx' S1 |1 The operation log 'xxxx' has | Delete or export log data and
stopped, all files in been halted automatically. re-start the log. You can also
use The maximum volume of configure automatic deletion.
data for this log has been
reached, and automatic
deletion has not been
configured.
OPL 'xxxx'wasnot | S1 |1 The print job for the Check your system
printed operation log could not be installation, or check that the
carried out. Presumably the printer is on-line.
printer driver is not installed
or the printer queue is full.
Outdated daylight | S1 |1 Contact your authorized
saving time service engineer.
information
Output 10V faulty | S3 |2 Output voltage 10 V faulty. Check output load.
at I: 'xxxx'
Over/ S3 |2 The measuring range has Ensure that values remain

within the permissible
measuring range and/or check
the process signal cable.
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HW module failure

due failure of a module of the
process station.

Message text Pr | Mr | Cause of message Remedy
Overflow/broken S3 |2 The measuring range has Ensure that values remain
wire at C: 'Xxxx' been overranged for the within the permissible
listed channel or the cable is | measuring range and/or check
damaged there. the process signal cable.
Overflow/broken S3 |2 The measuring range has Ensure that values remain
wire at I; "XXxx' been overranged for the within the permissible
listed input channel or the measuring range and/or check
cable is damaged there. the process signal cable.
Overflow/broken S3 |2 The measuring range has Ensure that values remain
wire at O: "Xxxx' been overranged for the within the permissible
listed output channel or the measuring range and/or check
cable is damaged there. the process signal cable.
Overload, first S1 |2 The CPU module is Rectify the overload by
adjustment not operating with an overload, altering the task interval times
possible with the result that redundant | or splitting up the program.
operation cannot be initiated.
The redundancy has been
completely deactivated.
Power fail of power | S1 | 2 The power supply in question | Check cable connection and
supply 1 [to 2] has failed. the supply itself.
Prim/Sec toggleby | S1 |1 Failure of the fieldbus Check the connection and
fieldbus communication has triggered | configuration of the fieldbus
communication a redundancy toggle. devices.
Prim/Sec toggleby |[S1 |1 Redundancy toggle caused Normal operation.
function by user function call
PRIM/SEC in the normal
program.
Prim/Sec toggleby |[S1 |1 Redundancy toggle occurred | Replace the defective module

or check for other causes.
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lost while sending

the module was unable to
send any data.

Message text Pr | Mr | Cause of message Remedy
Prim/Sec toggleby | S1 |1 Redundancy toggle through | Check the system net
network error detection of an error in the connection of the CPU
system net connection. modules, in particular that of
the current secondary.
Prim/Sec toggleby | S1 |1 Redundancy toggle caused Replace faulty CPU, or
primary failure by failure of the primary investigate other causes.
CPU-module.
Prim/Sec toggleby |S1 |1 Redundancy toggle by Normal operation.
toggle button operating the toggle button in
Freelance Engineering.
Prim/Sec toggleby | S1 |1 Redundancy toggle by Normal operation.
toggle switch operating the toggle button
on the primary CPU-module.
Process bus 'xxxx' | S2 |1 The CPU-module was unable | Check the terminating
data lost: Reception to process the received data resistors and the cable lengths
overload quickly enough. or contact your authorized
service engineer.
Process bus 'xxxx' | S2 |1 The CPU-module was unable | Contact your authorized
data lost: Sending to send any data for a certain | service engineer.
overload length of time.
Process bus data S2 |1 The module was unable to Check the terminating
lost while receiving process the received data resistors and the cable lengths
quickly enough. or contact your authorized
service engineer.
Process bus data S2 |1 For a certain period of time Check the terminating

resistors and the cable lengths
or contact your authorized
service engineer.
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Message text Pr | Mr | Cause of message Remedy
Process bus data S2 |1 For a certain period of time Reduce the distance or contact
lost / sending the module was unable to your authorized service
(Distance) send any data. It is likely that | engineer.
the connection distance to the
supplementary racks is too
great.
Profibus: Diagnosis | S2 | 2 The PROFIBUS slaves have | Check the PROFIBUS
buffer overflow given an overflow of configuration and, if possible,
diagnosis data. Probably increase the number of the
“flutter’ signals. PROFIBUS diagnosis buffers
of the master. Check the
PROFIBUS slaves or contact
the slave manufacturer’s
service technician.
Profibus: DP S2 |2 The maximum bus cycle time | Check the configuration and
Master Bus Cycle of the PROFIBUS connections of all PROFIBUS
Timeout communication was devices or contact your service
exceeded. The PROFIBUS technician.
master was reset.
Profibus: DP S2 |2 PROFIBUS DP Master isin | Check the configuration,
Master in state the CLEAR state. connection and status of all
CLEAR PROFIBUS devices.
Profibus: DP S2 |2 PROFIBUS Master is Check the configuration and
Master in state disturbed, all devices fail. connection to the PROFIBUS
ERROR [(IP1/2)] master and the status of the
PROFIBUS module.
Profibus: DP S2 |2 The PROFIBUS DP Master | Check the configuration and
Master in state is in the OFFLINE state. connection to the PROFIBUS
OFFLINE master and the status of the
PROFIBUS module.
308 Operators Manual — Freelance Operations




System Messages

Alphabetic list of system messages

error (Xxx)

occurred in the
communications software of
the PROFIBUS Master.

Message text Pr | Mr | Cause of message Remedy
Profibus: DP S2 |2 PROFIBUS DP Master isin | Check the configuration,
Master in state the STOP state. connection and status of all
STOP PROFIBUS devices.
Profibus: Duplicate | S2 | 2 The PROFIBUS master Check the configuration of the
Master addr software has detected that PROFIBUS line.
detected another PROFIBUS master

with an identical address is

active on the same

PROFIBUS line.
Profibus: Firmware | S2 | 2 The PROFIBUS master
API malfunction software has detected an

error in the protocol stack.

Depending on the nature of

the error, a reset of the

protocol stack is initiated and

PROFIBUS communication

is resumed.
Profibus: Firmware | S2 | 2 The PROFIBUS master
API timeout software has detected a

timeout in the protocol stack.

Depending on the nature of

the error, a reset of the

protocol stack is initiated and

PROFIBUS communication

is resumed.
Profibus: Firmware | S2 | 2 An internal error has Contact your service

technician.
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without actual
process values

new primary CPU is not
receiving any current input
data within the configured
waiting time.

Message text Pr | Mr | Cause of message Remedy
Profibus: Firmware | S2 | 2 The Firmware version of the | Load a new Firmware version
Version error PROFIBUS module is into the module, change the
[1P1/2] outdated. module or contact your service
technician.
Profibus: Line A/IB | S2 |2 The redundancy of the Check the configuration and
no data reception PROFIBUS line is disturbed. | the devices of the PROFIBUS.
[IP1/2]
Profibus: Master S2 |2 The communication to the Check the configuration and
bus cycle timeout PROFIBUS devices is the devices of the PROFIBUS.
disturbed.
Profibus: No S2 |2 The PROFIBUS master Check the configuration of the
connection to any software has detected a PROFIBUS line.
slave [IP1/2] physical error on the line,
and it is no longer possible to
perform any communication.
Profibus: Physical S2 |2 The PROFIBUS master Check the configuration of the
layer malfunction software has detected a PROFIBUS line.
physical error on the line,
and it is no longer possible to
perform error-free
communication.
Readback fault in S2 |2 An error has occurred during | Contact your authorized
output channel signal readback on an output | service engineer.
channel.
Recover from SD S2 |1 The SD card backup was
card restored to the controller.
Red. startup S1 |1 After redundancy toggle, the | Check the configuration of the

processing station, in
particular, the parameter
“Toggle timeout for field bus
inputs”.
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Message text Pr | Mr | Cause of message Remedy
Redundant fieldbus | S1 |1 The redundant Check the connections and
comm. not communication of a fieldbus | configuration of the connected
available has failed. field busses.
Report 'Xxxx' S1 |2 Report in emergency halt. An | Create more space on the disk
stopped unexpected error occurred in question, or switch the
while writing data, e.g. the storage of files etc. to a disk
hard disk is full. with more space available
Report "xxxx' S1 |1 The report 'xxxx' has been Delete or export log data and
stopped, all files in halted automatically. The re-start the report. You can
use maximum volume of data for | also configure automatic
this log has been reached, deletion.
and automatic deletion has
not been configured.
Report 'xxxx' was S1 |1 The print job for the report Check your system installation
not printed log could not be carried out. | or check that the printer is on-
Presumably the printer driver | line.
is not installed or the printer
gueue is full.
RS-Wire breakon | S3 | 2 The cable connection for the | Check the relevant process
channel "xxxx' input signal RS (Run/Stop) is | signal cable.
faulty.
RUN/STOP S1 |2 Mismatched positions of Adjust switch positions.
mismatch P-RUN RUN/STOP switches on
<->S-STOP CPU-modules, with current
positions displayed.
RUN/STOP S1 |2 Mismatched positions of Adjust switch positions.
mismatch P-STOP RUN/STOP switches on
<->S-RUN CPU-modules, with current

positions displayed.
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Message text Pr | Mr | Cause of message Remedy

RUN/STOP S1 |2 The positions of the RUN / Match the switch positions.

mismatch switch STOP-switches of the

<-> state Primary and Secondary are
different. After redundancy
toggling, the switch position
and state (RUN / STOP) on
the new primary do not
correspond.

SD card removed S2 |2 SD card could not be Insert a valid SD card in the

[IP1/2] detected in the controller. controller.

Sec boot cause: S1 |1 A fatal software error has Contact your authorized

CPU fault detected occurred on the module. service engineer.

Secondary failure S1 |2 In the course of synchronous | Check that the CPU module is
operation, the secondary has | fully functional. Also occurs
failed. when there is a fault in the

RED link connection.

Secondary fatal S1 |1 A fatal software error has Contact your authorized

error %s occurred on the secondary service engineer.
CPU module.

Secondary not S1 |2 The redundancy partner Check whether there is a

found (secondary) cannot be found, | secondary CPU, and whether
and consequently cannot be the RED link is connected
loaded. correctly.

Secondary not S1 |2 After the operating system Check whether the secondary

reachable after boot has been loaded, the was unable to terminate the
secondary cannot be boot-up of its operating
accessed. system.

Secondary reboot: | S1 |1 Due to a problem, a cold start | Contact your authorized

Coldstart by was triggered on the service engineer.
firmware secondary CPU module.
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Message text Pr | Mr | Cause of message Remedy
Secondary reboot: | S1 |1 An operator action (in Normal operation.
Coldstart by Freelance Engineering) has
operator caused a cold start on the

secondary CPU module.
Secondary reboot: | S1 |1 A new synchronization has Normal operation.
Coldstart by reset been triggered on the CPU-
switch module by the reset button.

Reset button pressed for

longer than 5 seconds.
Secondary reboot: | S1 |1 A fatal software error has Contact your authorized
CPU fault" occurred on the module. service engineer.
Secondary reboot: | S1 |1 A critical software error has | Contact your authorized
Critical error triggered a new service engineer.

synchronization by the

primary CPU-module.
Secondary reboot: | S1 |1 No boot configuration is Contact your authorized
Default config only present in the process station. | service engineer.

The process station has been

initialized since it does not

contain a boot configuration.

The standard (default)

configuration has been

reverted to.
Secondary reboot: | S1 |1 A fatal software error has Contact your authorized
Fatal error occurred on the module. service engineer.
Secondary reboot: | S1 |1 An operator action (in Normal operation.

Firmware update

Freelance Engineering) has
caused a firmware update on
the CPU-module.
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invalid operating
system

‘sync’ state, because the
operating system of the
secondary does not
correspond to that of the
primary.

Message text Pr | Mr | Cause of message Remedy
Secondary reboot: | S1 |1 An operator action (in Normal operation.
Initialize by Freelance Engineering) has
operator caused a cold start on the
process station.
Secondary reboot: S1 |1 The secondary CPU was E(;)v:/r:? lsﬁp?p?l?til: rr:écc:SeS;I;yyour
Power fail synchronized again by the ’
primary CPU after a power
failure.
Secondary reboot: | S1 |1 A warm start has been Contact your authorized
Recover mode activated on a process service engineer.
station.
Secondary reboot: | S1 |1 CPU starts after a
Redundancy boot redundancy toggle.
Secondary reboot: | S1 |1 An operator action (in Normal operation.
Warmstart by Freelance Engineering) has
operator caused a warm start on the
process station.
Secondary reboot: | S1 |1 A warm start has been Normal operation.
Warmstart by reset triggered on the CPU-
switch moduleby the reset button.
Secondary reboot: S1 |1 The CPU-module watchdog | Contact your authorized
Watchdog has triggered a new service engineer.
synchronization by the
primary CPU-module.
Secondary with S1 |1 The station cannot accept the | Load the operating system of

the secondary using the
Settings tool.
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Message text Pr | Mr | Cause of message Remedy
Short circuit at C: S3 |2 A short circuit has been Check the relevant process
"XXXX' detected for one or more signal cable.
digital channels; all channels
are listed if enough space in
text.
Short circuit at I S3 |2 A short circuit has been Check the relevant process
XXXX' detected for one or more signal cable.
input channels; all channels
are listed if enough space in
text.
Short circuit at O: S3 |2 A short circuit has been Check the relevant process
XXXX' detected for one or more signal cable.
ouput channels; all channels
are listed if enough space in
text.
Shortcut on channel | S3 | 2 The cable connection for the | Check the relevant process
XXXX' analog input has a short signal cable.
circuit.
Signal sequence log | S1 | 2 Log in emergency halt. An Create more space on the disk
'Xxxx' stopped unexpected error occurred in question, or switch the
while writing log data, e.g. storage of log files etc. to a
the hard disk is full. disk with more space available
Slave deactivated S2 |2 Errors occurred on the Check the related PROFIBUS
due to protocol communication to the device or contact slave
error PROFIBUS slave. manufacturer’s service
technician.
Slave was S2 |2 The PROFIBUS device was | Check the configuration of the

parameterized by
another Master

configured from another
master.

A different master has
parameterized the slave.

other PROFIBUS master.
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Message text Pr | Mr | Cause of message Remedy
SSL 'xxxx' stopped, | S1 |1 The signal sequence log Delete or export log data and
all files in use 'xxxx' has been halted re-start the log. You can also
automatically. The maximum | configure automatic deletion.
volume of data for this log
has been reached, and
automatic deletion has not
been configured.
SSL 'xxxx'wasnot | S1 |1 The print job for the signal Check your system
printed sequence log could not be installation, or check that the
carried out. Presumably the printer is on-line.
printer driver is not installed
or the printer queue is full.
Station Ethernet S1 |1 The communication load on | Check the configuration and
overload of interface xxx is too high. The | the associated Ethernet
interface xxx Ethernet controller was devices.
temporarily switched off.
Station fatal error S1 |1 A fatal error has occurred on | Contact your authorized
"XXXX' the CPU-module, 'xxxx' service engineer.
contains its ID.
Station FPGA S1 |1 An error has occurred in the | Contact your authorized
image error xxx FPGA of the controller's service engineer.
CPU.
Station radio clock | S1 |1 A radio clock linked to the Check radio clock and/or
failed process station has failed. connection.
Station reboot: S1 |1 The application program has | Normal operation.
Cold start by caused a cold start on the
program process station.
Station reboot: S1 |1 Due to a problem, a cold start | Contact your authorized
Coldstart by was triggered on the CPU service engineer.
firmware module.
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Firmware update

Freelance Engineering) has
caused a firmware update on
the CPU-module.

Message text Pr | Mr | Cause of message Remedy
Station reboot: S1 |1 An operator action (in Normal operation.
Coldstart by Freelance Engineering) has
operator caused a cold start on the

process station.
Station reboot: S1 |1 A cold start has been Normal operation.
Coldstart by reset triggered on the CPU-
switch MODULE by the reset

button.

Reset button pressed for

more than 5 seconds.
Station reboot: S1 |1 After reaching the safety Check reason for safety state
Cold start/Safety state a cold start on the using the boot cause
state process station has caused. information dialog.
Station reboot: S1 |1 A fatal software error has Contact your authorized
CPU fault occurred on the CPU- service engineer.

module.
Station reboot: S1 |1 No boot configuration is Contact your authorized
Default present in the process station. | service engineer.
configuration only The process station has been

initialized since it does not

contain a boot configuration.

The standard (default)

configuration has been

reverted to.
Station reboot: S1 |1 A fatal software error has Contact your authorized
Fatal error occurred on the CPU- service engineer.

module.
Station reboot: S1 |1 An operator action (in Normal operation.
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Message text Pr | Mr | Cause of message Remedy
Station reboot: S1 |1 An operator action (in Normal operation.
Initialization by Freelance Engineering) has
operator caused an Initialize on the
process station.
Station reboot: S1 |1 CPU starts after a power fail. | Check your power supply if
Power fail necessary.
Station reboot: S1 |1 A warm start has been Contact your authorized
Recover mode activated on a process service engineer.
station.
Station reboot: S1 |1 CPU starts after a
Redundancy boot redundancy toggle.
Station reboot: S1 |1 The controller has been Normal operation
Restore from SD initialized with the data from
card the SD card.
Station reboot: S1 |1 A critical software error has | Contact your authorized
Warmstart by triggered a warm start on the | service engineer.
critical error CPU-module.
Station reboot: S1 |1 An operator action (in Normal operation.
Warmstart by Freelance Engineering) has
operator caused a warm start on the
CPU-module.
Station reboot: S1 |1 A warm start has been Normal operation.
Warmstart by reset triggered on the CPU-module
switch by the reset button. Reset
button pressed for less than 5
seconds.
Station reboot: S1 |1 The CPU-module watchdog | Contact your authorized
Watchdog has triggered a boot. service engineer.
Station stopped S1 |1 Station resource has been Normal operation, start the

stopped.

resource.
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occurred while writing
archive data, e.g. the hard
disk is full.

Message text Pr | Mr | Cause of message Remedy
Station system time | S1 | 2 The system time of the Set the system time in your
not set resource has never been set. | plant (Freelance Engineering,
The message in Freelance Commissioning, Options, Set
Operations is displayed with | system time).
a time stamp that is
calculated with a system time
DT#2099-12-31 00:00:000
and the actual time zone.
The controller performs a
cold start on power fail.
Station task break S2 |1 A user task in the station has | In commissioning mode,
point activated reached a break point. debugger: deactivate or
remove the break point. Allow
task to continue running.
Station task ready S2 |1 The user task in question is Normal operation.
ready to be started.
Station task S2 |1 The user task in question has | Normal operation.
stopped been stopped.
Station warmstart | S1 |1 The CPU-module has been Normal operation, check
down time > 24 re-started, and has performed | power supply if necessary.
days a warm start following a
power failure. Power down
time was higher than 24
days.
Stop archiving S1 |1 An unexpected error Create more space on the disk

in question, or switch the
storage of log files etc. to a
disk with more space
available.
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executable: INT
overflow (store)

in question has caused an
integer overflow on saving.

Message text Pr | Mr | Cause of message Remedy
Sys. time set at S1 |1 The system time in the Normal operation.
XXXX' process or gateway station

has been changed by an

operator action (in Freelance

Engineering), 'xxxx' contains

the original time (local).
System network S1 |1 The system bus network Check the system bus net
connection failure connection of the is connection of the process
[(IP1/2)] incorrect. station.
Task not S1 |1 The program of the user task | Correct problem in user
executable: DT in question has caused a DT | program.
overflow arithmetic error.
Task not S1 |1 The program of the user task | Correct problem in user
executable: DT in question has caused a DT | program.
underflow arithmetic error.
Task not S1 |1 An illegal array index has Check and correct the user
executable: Illegal been calculated in the user program.
array index program.
Task not S1 |1 The program of the user task | Correct problem in user
executable: INT in question has caused an program.
divide by 0 integer arithmetic error.
Task not S1 |1 The program of the user task | Contact your authorized
executable: INT FB in question has caused an service engineer.
error arithmetic error within a

function block.
Task not S1 |1 The program of the user task | Correct problem in user
executable: INT in question has caused an program.
overflow integer arithmetic error.
Task not S1 |1 The program of the user task | Correct problem in user

program.
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Message text Pr | Mr | Cause of message Remedy
Task not S1 |1 The program of the user task | Correct problem in user
executable: INT in question has caused an program.
underflow integer arithmetic error.
Task not S1 |1 If the resource is halted while | The resource must not be
executable: Invalid atask is at a break point, the | halted whilst one of the tasks
debug command task switches to state ‘not is at a break point.
executable'. The error task is
not initiated.
Task not S1 |1 The program of the user task | The configuration has not
executable: Process in question has caused an been loaded correctly,
image read error on reading in the presumably because of an
process values. operator error. Either "Load
entire station" or "Load
changed objects™ and load the
objects individually.
Task not S1 |1 The program of the user task | The configuration has not
executable: Process in question has caused an been loaded correctly,
image write error on outputting the presumably because of an
process values. operator error. Either "Load
entire station" or "Load
changed objects" and load the
objects individually.
Task not executable | S1 | 1 The program in the user task | Correct problem in user
Program execution concerned has been program.
abort interrupted. A task is running
in an endless loop.
Task not executable | S1 | 1 The program of the user task | Correct problem in user
Program execution in question has caused a program.
error program execution error.
Task not S1 |1 The program of the user task | Correct problem in user
executable: REAL in question has caused a real | program.
divide by 0 arithmetic error.
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been underrun for the listed
input channels.

Message text Pr | Mr | Cause of message Remedy
Task not S1 |1 The program of the user task | Contact your authorized
executable: REAL in question has caused an service engineer.
FB error arithmetic error within a
function block.
Task not S1 |1 The program of the user task | Correct problem in user
executable: REAL in question is attempting to program.
no valid float process an illegal real value.
Task not S1 |1 The program of the user task | Correct problem in user
executable: REAL in question has caused a real | program.
overflow arithmetic error.
Task not S1 |1 The program of the user task | Correct problem in user
executable: REAL in question has caused a real | program.
underflow arithmetic error.
Task not S1 |1 The program of the user task | Correct problem in user
executable: UINT in question has caused an program.
divide by 0 integer arithmetic error.
Temp. comp. chan. | S3 |2 Possibly wrong measured Check the temperature
error at I: 'xxxx' value caused by inadmissible | compensation channel.
temperature of the
compensation channel.
Time stamp is off S2 |2 The “Time-stamp” mode is To record the sequence of
in module DDI101 switched off in DDI 01. events messages, the “Time
stamp” function in DDO 01
must be activated.
Underflow C: S3 |2 The measuring range has Ensure that values remain
XXXX' been underrun for the listed within the permissible
channels. measuring range.
Underflow I: 'xxxx' | S3 | 2 The measuring range has Ensure that values remain

within the permissible
measuring range.
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plugged [IPx]

incompatible with the
module plugged in. (IPx = IP
address of the redundant
process station).

Message text Pr | Mr | Cause of message Remedy

Underflow O: S3 |2 The measuring range has Ensure that values remain

"XXXX' been underrun for the listed | within the permissible
output channels. measuring range.

Voltage diff. high S3 |2 Invalid measured value of the | Check voltage difference;

at I: 'xxxx' channel caused by too high install equalizing conductors if
voltage difference. necessary

Wire break of S3 |2 The process signal cable at Check the process signal

analog input the analog input is faulty. cable.

Wire break of S3 |2 The cable connection for the | Check the relevant process

channel "Xxxx' analog input is faulty. signal cable.

Wrong module type | S2 | 2 The block type configured is | Alter the configuration to

match the hardware installed.
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Terms and definitions

Access

Acknowledge

Acknowledge
button

Acknowledge
level

Actual time

Appendix A Glossary

Parameters from function blocks and preconfigured
displays that either authorize or prevent certain sizes, values
or actions for the user.

Operator action whereby one or more messages is/are
acknowledged as seen and understood. Every action
performed by the logged-in operator can be logged in the
signal sequence log.

Button in the message line that enables the most recently
received messages in the message line (VA, visual
acknowledge) or message list (A, acknowledge) to be
acknowledged without having to call up the message list.

The acknowledge level determines how events or messages
on an operator station have to be acknowledged: 1)
incoming and outgoing; 2) incoming only; 3) no
acknowledgement.

The local time with any daylight saving time shift applied is
the current time, that is, the time which the user sees on his
or her watch. This time is used when setting the freelance
time during commissioning is generally the time that is used
on the Freelance user interface; for example timestamps of
system and process messages are communicated with the
system time and converted to actual time for display in
Freelance Operations.

See also Local time, System time, Daylight saving time.
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Alphanumeric
display

Archive

Archive Browser

Authentication
key

Auto/Automatic

Band end

Band start

Block

Block
acknowledgement

A dynamic symbol from the graphics editor for displaying
analog values on the operator station.

An archive is the file in which the data from a trend display
or log are stored. Depending on how data are logged, large
volumes of data can be generated under certain
circumstances.

Freelance software program for a PC to visualize archives
of trends and logs. Additionally archives can be exported as
text files (csv format).

The authentication key includes data corresponding to your
license rights for the Freelance software packages. To work
with the Freelance software in the extent you have ordered,
you will need your authentication key during installation.
The Authentication key can be downloaded from ABB
Software Factory (SOFA).

Operating mode in which processing is carried out
automatically through the program’s control settings. The
operator is not allowed to do any input in automatic mode.
For operator input you must change to manual operating
mode.

The band end defines the value for the end of the scale on
the Y-axis in the single trend curve.
See also Y-scaling

The band start defines the value for the start of the scale on
the Y-axis in the single trend curve.
See also Y-scaling

Summary of several similar entries in a list to perform an
action on all selected elements, for example acknowledge of
messages or export of data sets.

Acknowledgement of several selected entries in the
message list or hints list

326

Operators Manual — Freelance Operations



Glossary

Block class

Block instance

Block type

Blocked

Carry out

Colors

Control
Aspect/Control
aspect

A block class includes the functionality and appearance of
the block. This information is defined with the interface, the
program and the faceplate. With the installation of freelance
software numerous standard block classes are provided. For
specific process requirements, new block classes can be
configured (user-defined function blocks). For the
connection of OPC Servers new OPC block classes can be
defined (OPC-FB-CLASS).

A class itself cannot be processed in a process station. For
execution, first an instance of the class must be created. See
also Block instance.

A block instance is the executable form of a block class.
Different instances are identified by their tag names. Each
instance works with values specific to that instance (local
variables and parameters). See also Block class.

Identical to the type respectively class of a tag instance. As
a name of a block type the short name of the type in the
block library is used.

SFC operating mode in which a transition blocks the
advancement of the program run.

Operator action performed on an SFC program whereby all
active transitions whose transition criteria have been
satisfied activate the steps next in sequence.

The colors that are not set through the Windows interface
can be set individually in Freelance Engineering in the
project tree and the program editors. The colors for trends
in Freelance Operations can also be selected by the
operator.

The Control Aspect is an animated representation of the
program, in which a tag or step or transition of an SFC
program has been configured in Freelance Engineering,
similar to the display of the program in the commissioning
program
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Control Builder F  Software package for engineering station which enables

(CBF) overall configuration of the user program including the
operation and observation level. As from Freelance 2016
replaced by Freelance Engineering.

Control Net All stations in a project, engineering, process, gateway and
operator stations, are linked through the Control Net. The
Control Net is based on the Ethernet standard with the
TCP/IP transfer protocol and can be redundant.

Control room A control room horn can be configured along with the field

horn horn. This is done by entering a wav file (requiring a sound
board) in the local event processing. When an event occurs
with the configured priority, this wav file is executed.

Criteria window Used for displaying the transition criteria and commands of
an SFC program. Criteria windows can be configured both
for steps (actions) and for transitions (conditions).

Data type Data types are assigned to variables either directly in the
program or through a variable declaration in the variable
list. Along with the basic data types such as REAL or
BOOL, user-defined data types can also be set up
(structured variables).

Daylight saving In a Freelance system the Local time can be adjusted to

time daylight-saving-time automatically. For using Daylight
saving time in user applications, a function block is
available that converts a variable of data type DT
(Date&Time) to daylight-saving-time.
See also Actual time, Local time, System time.

Default display The default display is a display with a special significance
for the tag, step or transition. On the operator station this

display can be called for a tag with the F11 key; in the
context menu this display is shown at the first position.

Default value Value, predefined from the system.
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Demo mode If Freelance software is operated without a hard key, the
application will automatically start in demo mode. In demo
mode the software is fully functional and will run for 100
days. At the end of this 100-day period the software is no
longer functional.

Diagnostics A number of diagnostic tools are running during operation,
and these make it easier to trace a problem in the event of a
malfunction. When an error occurs, a system error message
results. There are also diagnostic options available through
the diagnostics interface.

DigiVis Software package for the operator station that enables
operation and observation of the process with the aid of
numerous standard functions. As from Freelance 2016
replaced by Freelance Operations.

Directory During installation, directories are set up in advance for the
storage of specific Freelance data.

Display Displays are pre-defined standard displays or can be free
configured with the graphics editor. Displays are shown in
Freelance Operations to visualize and operate the process.
See also Graphic display; Overview display, Group
display, Trend display, Sequential function chart
display, Time scheduler display, WEB display, Logs.

Display access Through display access displays can be allocated to each
tag as well as each transition and step of a signal function
chart. These displays can then be called up quick and easily
on the operation station for a selected tag, transition or step.

Display format The display format determines the format in which a value
of a variable or process signal is displayed in the operation
interface.
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Display object

Display selection

Disturbance
course log

Disturbance
course log
acquisition

Emergency mode

Enable

Engineering
station

Event

Event log

Display objects can be simple or complex, static or dynamic
symbols that can be created using the graphic editor and
have parameters defined. A display object contains
information for displaying the graphic symbol on the
operator station.

An operator action that alters the content of the display area
of the operation interface.

The disturbance course log is one of the state logs. It is used
for logging chronological sequences of selected analog and
binary variables.

Function block that records in the process station the values
of up to 6 variables from a start point onwards and passes
these values to the operator station.

If the hard key cannot be detected during program start up
or during normal operation (hard key is missing or
defective) the system will enter the emergency mode. In
this mode the software is fully operational for 100 days.
During this time you have to exchange the defective hard
key.

For a Signal function chart to run, an Enabled state must be
detected. The enable command could be issued
automatically by the user program or the operator.

PC or laptop with Microsoft Windows operating system and
the software Freelance Engineering. Used by the system
operator for configuration, commissioning, and
documentation.

An event triggers a message or a control action.

Event logs are used for logging events such as messages,
faults, switching actions and/or operator actions. Logging is
performed automatically when the appropriate event occurs.
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Extension All Freelance files are saved in the directory specified
during installation; the default name is ""Freelance™". The
different types of files can be distinguished from one
another by their extensions. For example, .pro, .csv, .arc

and so on.
Extended User An effective way to manager user account. User can select
Management either Use Local Account or Use Domain Account to login

to the Freelance system via Settings tool.

Faceplate A faceplate is a graphic display or observation and
operation of a tag, adjusted to the block class definition A
faceplate is part of the block class. Faceplates for the
standard modules are provided with the freelance software;
for user-defined blocks own faceplates can be created. See
also Block class.

Fault message Fault messages have the priority levels 1 to 3. These
messages are used, for example, to signal that a limit value
has been exceeded.

Fill pattern Area attribute of a graphic object or symbol which allows
the hatching style of the area to be modified.

Firmware update  Update of the controller firmware. The update allows error
corrections and providing of new features.

Flash Flashing refers to the cyclical pulsing of display objects.
Font type Text attribute in the graphics editor.
Force SFC operating mode whereby a transition forces an

advancement when the program activates the transition but
the transition criterion is not yet satisfied..

Freelance Software package for the engineering station which enables

Engineering overall configuration of the user program including the
operation and observation level

Freelance Software package for the operator station that enables

Operations operation and observation of the process with the aid of

numerous standard functions.
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Freelance system

Function key

Graphic display

Graphic object

Group display

Hard disk
requirement

Hard disk space

The sum of all the Freelance components: Freelance
Engineering, Freelance Operations, add-on packages,
hardware components. * Process station, engineering
station, operator station.

The function keys (F1 - F12) form a standard part of the
keyboard, and some of them have standard functions
assigned to them.

Additional to the standard displays and logs, free graphic
displays can be configured with the graphics editor in
Freelance Engineering to observe and operate the process
on an operator station. Different static and dynamic graphic
objects can be used to create graphical views of the plant,
functions and processes.

Elements of the graphics editor to create free graphic
displays to visualize and operate the processes in the plant.
Examples of static objects are line, rectangle, circle;
dynamic objects are bargraph, alphanumeric display, trend
window etc.

A group display is a combination of several faceplates. It
provides the user with the opportunity to display related
tags in the same display. After a displayed faceplate has
been selected, the corresponding tag can then be operated.

The amount of hard disk space needed for a trend archive or
a log file is calculated, during the configuration. If it is
established during loading the project to the operator station
that the free storage capacity on the hard disk is not
sufficient, an appropriate message is issued.

During installation, the Freelance software provides you
with information of the disk space. Additional space you
need to work with the software. The size of this requirement
depends on the scope and contents of your user program,
such as the number and scope of trends and archives.
Details can be found in the Getting Started manual.
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Hard key

Help

Hint

Hint field

Hint list

Hint message

Horn

Host name

Icon

Initial step

Running Freelance software requires a hard key (USB port)
and an authentication key. These enable the licensed
version of the program to be used along with the licensed
options.

The Freelance help system enables operators to quickly call
up relevant information onto the screen while they are
working with the software.

The option is provided to configure a hint for the operator
for every message of type Fault Message or Switch
Message. These hints should be configured to inform the
operator of the cause of the message, options for remedying
the process anomaly and, where necessary, further
operating hints. All hints are saved in the hint list.

Display field in the message line showing whether or not
there are any available hints relating to a message or event.
Through this hint field one reaches a hint list showing any
unacknowledged hints.

The hint list contains a list of all hints that have arisen and
not yet been acknowledged.

Hint messages have the level 5. They appear only in the
hint list and are purely for the operator’s information.

A field horn or control room horn can be controlled by an
event. A horn function is also provided that allows you to
attach any control signals you wish to a horn.

A name identifying the computer. The host name must be
unique within the network.

Windows terminology. Symbol for a program or a link.

Every SFC (Sequential Function Chart) program starts with
an initial step. A reset command always returns to the initial
step.
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Interface

Interpolation

Limit value

Limit value type

Line break

Load

Local time

The term interface refers to the point where two systems
meet. The different features of the two systems are made
compatible with one another through the interface (e.g.
Modbus interface).

The trend display and the representation therein between
two captured values can appear in three varying forms: with
no interpolation (whereby only the data point is shown), as
a line connecting two points, or as a staircase.

Limit values form the basis for generating events. Limit
values are thus declared in the operation interface and/or in
a log, e.g. when a particular value is exceeded. Particular
events are specified depending on the type of limit value.
The message is generated with, amongst other attributes, a
specific priority and a message text.

The limit value type determines the event triggered by the
message (HH, LL_XD, DHm...).

Monitoring of an input signal for voltage or current
interruption. In general, cable break detection triggers a
system message.

During the commissioning mode programs or sections of
programs that have passed the plausibility check without
revealing any errors can be loaded into the according
process, gateway or operator station. Therefore the elements
or levels are selected in the project tree and the load
procedure is started from the menu.

The local time is the system time with the time zone taken
into account, but not the daylight saving time. In the
process stations the local time is available in the system
variable <name>.DateTime.

See also Actual time, System time, Daylight saving time.
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Log

Log type

Long text

Manual

Measuring range

Measuring range
end

Measuring range
start

Menu line

Message

Message color

Logs are used for documenting events, states and sequences
from the process. The data they capture can be saved on the
hard disk in the operator station, printed out on the printer
or displayed on the monitor.

Three different types of logs are provided: Signal sequence
log (SSL), Operation log (OP), Disturbance course log
(DCL), Excel reports (REPORT).

A text entry up to 30 characters in length for providing a
brief description of a function block or preconfigured
display.

Operating mode in which the tag can be operated from the
operator station.

The measuring range defines the valid range for a value;
measured values within the measuring range have a defined
accuracy; at controller blocks the measuring range is used
for internal normalization of the control algorithm. Within
the faceplates the process values of the controller function
blocks are shown with their measuring range.

See also Scale range.

The measuring range end is the physical value assigned to
the transmitter’s end point (e.g. 20 mA = 1000 I/h).

The measuring range start is the physical value assigned to
the transmitter’s O-point (e.g. 0/4 mA = 200 I/h).

A screen region in the operation interface. The menu line
remains visible at all times. Because of this, actions linked
in the background with the menu can be performed in any
operating situation.

Process states and events can be configured as messages.
When that event occurs a message is then sent to the
operator station. Such messages are configured through the
function blocks.

Colors for message display.
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Message line

Message list

Message priority

Message text

Message types

Monitoring time

Multi Monitor

The message line is part of the operation interface and is
shown above every display on the operator station. The
message line allows the operator to view any time the most
recently received messages without calling-up the message
list.

The kind of the representation of the messages in the
message line (list, tags, areas) can be firmly configured or
be changed by the operator on the operator station.”

In the message list the messages sent from the process
stations to the operator station are displayed and managed.
These messages may relate either to the Freelance system or
to the automated process.

In the message list a message can be selected and/or
acknowledged, and the display assigned to a message can
also be called up. In this way one can quickly obtain
detailed information relating to the selected message.

Messages are distinguished by different priority levels;
priority S1, S2 and S3 are reserved for system messages, 1
to 3 for fault messages, 4 for switch messages and 5 for hint
messages.

Additional output text of a message in the message box and
in the message list.

In Freelance messages are subdivided into the following
message types based on their significance for the process:
system errors, fault messages, switch messages, hints and
hint messages.

Parameter of an SFC (Signal Function Chart) program. The
length of time after which the transitions/advancing criteria
that follow a step but have not been satisfied will be
reported.

Enables the operation of up to four monitors on a Freelance
Operations workstation. The displays to be displayed on the
monitors can be selected.
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Network board

Normal

Offset mode
Offset value
Operate and
observe (man

machine
interface)

Operating mode

Operating system

Operation log

Operator

Operator action

Operator
interface

Plug-in Ethernet card for a PC through which connection to
the Control Net is affected.

Operating mode in the Sequential Function Chart in which a
transition or step is processed normally. This means that the
transition is neither blocked nor forced and steps are not
switched permanently on or off.

This operating mode is used to determine which offset
value is being used in the time scheduler.

Value added to the time scheduler’s set point.

A general term describing the process-control approach in
an industrial process.

Status (on, off, manual, automatic) of the tags in the process
station, respectively enabling particular operator actions or
commands from the user program.

Basic software in a resource. In the process stations the
operating system (firmware) enables the communication
with other process stations and enables the calculation of
the user programs. Further functions of the operating
system are program management, test routines etc.

Cyclical, manual or event-related logging of up to 200
variables within a configurable text.

The person who holds responsibility at any given point in
time for controlling process events through the control
system.

An operator action is an action on the part of the operator
through which a process state or process value is changed
from the operator station.

The operator interface is the sum of all the display objects
and operating objects at the operator station.
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Operator station ~ An operator station is based on a PC with a Windows
operating system and the software Freelance Operations.
Used for observation and operation and alarm messages,
trends, archives and logs.

Options Operating mode in SFC programs whereby the progression
through the following steps is controlled through actions on
the part of the operator.

Overview display  Preconfigured display for favorites of displays and/or logs.

Parameter Parameters are configurable attributes effecting the
processing and display of function blocks, displays and
logs.

Permanent Scheduler operating mode whereby all sections of the set

curve are run through systematically.

Permanent off SFC operating mode whereby a step is switched off
permanently. Activating it has no effect.

Permanent on SFC operating mode whereby a step is switched on
permanently. The step is not necessarily active but will
nonetheless be kept in the processing sequence.

Primary The currently-active CPU module or the active controller of
a redundant process station is named as the primary.
See also Seconday.

Print job The output of documentation is always controlled by a so-
called print job, i.e. there must always be a job selected
before printing. The content of the print task is defined in
this job.

Printer Printers can be connected to the operator and to the
engineering station. Different printer types can be used
depending on the requirements; for example color printer
for hardcopies, line printer for message logs.
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Priority levels

Process message

Process station
Project
Redundancy
connection

Redundancy link

Redundancy
toggle

Redundant
process station

Messages received from the process stations may have
differing levels of importance in terms of effect on the
smooth operation of the process. The Freelance system
provides six different priority levels for messages. S1, S2,
S3 = System messages, 1 to 3 = Fault messages, 4 = Switch
messages and 5 = Hint messages.

"Process messages inform the user about disturbances and
specific status changes in the Freelance system. A
distinction is made between system messages, fault
messages, switch messages, hints and hint messages. The
message types are further subdivided according to their
importance for the process and according to the priority
levels.

The process station contains the CPU module, which
performs the processing of the configured programs.

The configuration of a system is created and stored with the
software and hardware parts in a project.

The physical connection of the two redundant partner that is
used for the synchronization of the redundant data.

Via the redundancy link, the synchronization of the
redundancy partner, Primary and Secondary, is carried out.

A redundancy toggle takes place when on the active
controller (Primary) detected a problem or the toggle has
been actively triggered, for example, by an operator action
on Prim/Sec-switch of the controller. The previous
Secondary is the new Primary and takes over the further
execution of the programs. A redundancy toggle is
bumpless, all states of the user programs remain unchanged.

A process station that is constructed and configured
redundantly. A redundant process station can be built only
with dedicated controller types.
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Refresh cycle General term for the update time of data; for I/O signals of
the refresh cycle describes the data exchange rate between
the I/0O module and the CPU, for fieldbus communication
the data exchange rate between two devices.

Repeat time The time at which an SFC program is restarted.

Report printer The report printer is the printer connected to the operating
station. A maximum of two printers can be connected to
one operator station.

Reset Control action on a function block or SFC program to reset
the counter in an internal register or reset the SFC program
to its initial step.

Resetting of a process station via the reset button of the
controllers triggers a warm- or cold start of the process
station.

Restart time The restart time is the point in time at which the SFC is to
be started. Unlike repeat time, restart time represents a
single point in time for starting the SFC.

Ring memory Fixed-size memory area which is overwritten after a
specified length of time.

Scale end Defines the scale end for values of a tag.

Scale range With the scale range the conversion of a process value is

determined to a different value range. Signals of different
sources must be scaled to a common area in order to
compare them with each other. Within the faceplates the
process values of the according function blocks are shown
with their scale range. See also Measuring range.

Scale start Defines the scale start for values of a tag.

Secondary The currently-passive CPU module or the passive controller
of a redundant process station is named as the secondary.
See also Primary.
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Security Lock

Selection

Sequential
function chart
display

Short term
archive

Short text

Signal sequence
log

Signal sequence
log 1

Signal sequence
log N

Standard display

Part of the User Management. It enables access right
settings for specific user groups on the operator stations and
also for configuration and commissioning on the
engineering station to be configured.

Operating technique from the operation interface. Selection
is used to activate displays or to select tags for operation.

Standard display that allows a program sequence set up
using the Sequential Function Chart to be operated on a
Freelance operator station.

When a trend display is selected, the short-term archive for
the individual signals is displayed first. The short-term
archive holds 200 values, i.e. max. 6 x 200 values per trend
display. For older values the system will then automatically
return to access the archive file.

A text entry up to 12 characters in length as a brief
description of a function block or preconfigured display.

Configurable logging of system errors, fault messages,
switch messages, operator hints and operator actions.

Logging of system errors, fault messages, switch messages,
operator hints and operator actions with continuous
printing.

Logging of system errors, fault messages, switch messages,
operator hints and operator actions, recording these in a log
file.

Along with the free graphic displays created with the
graphics editor there are also several standard displays
available; to display these in Freelance Operations you only
need to configure a tag and a few parameters.

The standard displays in Freelance are the system display,
the overview display, group displays, trend displays, SFC
displays, time scheduler display, WEB display and logs.
Additionally for each tag a faceplate is available without
any configuration.
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Standard value

Start time

State
State log

Step

Step list

Step name

Subnet mask

Substitute value

Switch message

System message

Same as default value.

The start time is the time at which the SFC program is to
be/was started for the first time.

See Operating mode.

The function of state logs is to record process states
cyclically. This includes the cyclical logging of the state of
a tag or the logging of sequences in the process.

An element of the SFC controlling actions in conjunction
with a transition. In Freelance a string of FBD and/or IL
programs continues to be processed until the next transition
is satisfied.

List of all the steps in an SFC program.

Free-form text with up to 8 characters; displayed and
documented in the graphic object of a step in an SFC
program).

Masking in the main network for a possible lower-level
network.

Configurable fixed default value which is, in case of
overrun or underrun of a process signal, used for further
calculation instead of the real value.

Switch messages have the priority level 4. Messages of this
type are used to report switch events, e.g. "Valve open™ or
"Valve closed".

System messages have the highest priority level and are
subdivided into three message groups S1 to S3. These
messages cannot be configured or changed by the user.
System messages are used to indicate fault states of the
system (hardware) itself.
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System time

Tag

Tag type

Taskbar

Time scheduler

Time scheduler
display

Time
synchronization

Current time on the stations, used for internal transfer of
time stamps. For time synchronization of the stations of a
project, the system time is used. System time is equal to
Greenwich Mean Time GMT (UTC).

See also Actual time, Local time, Daylight saving time.

A tag is an instance of a preconfigured function block. A
tag name must be assigned to each configured function
block. All the tags in a project are listed in the tag list.

Brief description of the function block in the function
library. See also Block class.

Windows taskbar that is used to call the Windows start
menu.

With a time scheduler, analog values defined as time-
dependent are output; these values can be transferred to
other functions, e.g. to a controller as a setpoint input.

The time scheduler display displays the time scheduler’s
state and enables it to be controlled by the operator. This
display consists of a trend region for tracking set points and
process values, a state field and the associated faceplate.

All Freelance stations are equipped with a real-time clock.
When the system is running, the clock times must
correspond throughout the system, so that for example
entries can be made in logs and trends in the correct time
sequence. For this purpose, the system time on all stations
via the Ethernet bus is synchronized. For the PCs in the
Freelance system time synchronization can be enabled or
disabled individually. If the time synchronization for a
Freelance Operations station is disabled, trends cannot be
displayed correctly.
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Transition

Transition
criteria

Trend

Trend data
acquisition

Trend display

Trend server

User Management

Value

Value region

An element of the Sequential Function Chart that activates
the following step (alternative situation) or steps (parallel
situation). Within a transition in Freelance, an FBD or IL
program will continue to be processed until the transition
criterion is satisfied.

Condition that must be satisfied in order for a step to
activate subsequent steps. See also Transition.

The function of a trend is to provide a graphic
representation of values using a time axis. In Freelance this
is done by capturing values in the process station and
transferring them to the operator station in blocks;
alternatively directly in the operator station variables can be
collected and visualized as trends.

Function block that captures the signal values of the linked
variables and transfers them in blocks to the operator
station.

The trend display is used to display values graphically using
a time axis. A maximum of 6 trends can be shown in one
trend display.

The Trend server is used for the acquisition of variables.
The Trend server makes these variables available for the
trend displays in the operator stations.

The entry for user account management. It includes
Security Lock and Extended User Management.

Numeric value of a variable that must be entered in a
specific format depending on data type.

General term for the allowed values of a variable.

In the description of graphical user interfaces also part of a
representation or display where values are shown, for
example the trend display of Freelance Operations.
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Visual Only the messages in the message line are acknowledged.
acknowledgement The message itself remains in the message list and must
also be acknowledged there.

Waiting time The waiting time TWA is the minimum duration of time the
SFC program will remain in a step.

WERB display After calling a WEB display on the operator station, the
local WEB browser is launched and the configured WEB
site is activated.

Y scaling With the Y-scaling the range of a variable is specified that
is displayed in a trend display. The limits of this range - the
band start and band end - are configurable and can be
modified by the user on an operator station.

See also Band start, Band end.
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Acknowledgment level, 61

Al TR, 152

Al_TRT, 152

Analog input transformation, Al_TR, 152

Analog input transformation, transient
Al_TRT, 152

Analog monitoring, M_ANA, 173

Analog output transformation, AO_TR, 153

AO_TR, 153

Back/Forward, 40

Batch control function blocks, 182

Binary Function Blocks, 153

Binary monitoring of antivalence, M_BAYV,
173

Binary monitoring, M_BIN, 173

Binary output, M_BOUT, 153

C_ANA, 150

C CR, 162

C_CsS, 160

C Cu, 161

0sS, 167

OuU, 168

PS, 169

PU, 170

C SR, 165

C_SS, 163

C _SU, 164

Calling up a faceplate, 21

Constant function blocks, 177

Context menu, 27

Continuous controller
Ratio, C_CR, 162

C_
C_
C_
C_

Index

Standard, C_CS, 160
Universal, C_CU, 161
Control room horn, 70
Controller function blocks, 160
Controller selftune TUNE, 171
Counter with analog input, CT_ANA, 150
Criteria window, 205
CSTBO, 177
CSTBY, 178
CSTDI, 178
CSTDT, 178
CSTDW, 178
CSTIN, 179
CSTRE, 179
CSTTI, 179
CSTUD, 179
CSTUI, 180
CT_ANA, 150
CT_LT, 158
CT_P, 157
CTT, 156
CTUD, 157
Default display, 22, 23
Defining the trend display, 115
Diagnostic mode, 243
Display Explorer, 23
Display selection, 24, 48
Displaying a process station, 248
Disturbance course log, 229
DOS, 177
DOS A, 177
DOS E, 177
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Dosing circuits, DOS, DOS_A, DOS _E, 177
EVENT, 174
Event logs, 219
Event message, EVENT, 174
Excel Report, 233
FAC_D, 159
Faceplate, 23, 31
Call-up, 137
Message area, 140
Structure and operation, 138
Faceplates, 135
Fault messages, 59
Field horn, 70
File transfer, 220
Focus, 24
FPX, 182
Free displays, 30
Freelance Operations
Installation, 20
Operator interventions, 21
Overview, 19
Frequency/analog converter, FAC_D, 159
Function block FPX, 182
Function blocks
Analog, 150
Function blocks string constants, 180
Function keys, 24
General message block, M_GEN, 174
Graphic display, 31, 99
Dynamic display elements, 104
Executing actions, 22
Operator interventions, 102
Trend window, 105
Graphic Display
Call-up, 100
Display scaling, 101
Group display, 30, 95
Call-up, 96
Operator interventions, 98

Hint field, 66
Hint list
Call-up, 79
Hint List, 78
Operator interventions, 82
structure, 79
Hint messages, 59
Hints, 59
IDF_1, 175
IDF_2, 176
IDF_A, 176
Individual drive function
for actuators, IDF_A, 176
for bi-directional units IDF_2, 176
for unidirectional units IDF_1, 175
List view
Message, 68
Logs, 32, 219
Call-up, 223
Operator interventions, 223, 224
Long-term archive, 112
M_ANA, 173
M_BAV, 173
M_BIN, 173
M_BOUT, 153
M_GEN, 174
Menu
Display, 38
Help, 47
Message list, 35
Operation, 35
Print, 47
Tools, 42
View, 35
Menu overview, 34
Message
Acknowledgment, 60
Incoming/outgoing, 77
List view, 68
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Plant view, 68
Point acknowledgment, 61
Sound file, 63
Standard view, 67
Visual acknowledgment, 60
Message acknowledgement, 60
Message fields, 66
Message line, 65
Operator interventions, 69
Overview, 25
Message list, 70
Call-up, 72
Operator interventions, 75, 77
Structure, 72
Message types, 58
Monitoring function blocks, 173
MONO _F, 154
Moving a faceplate, 22, 23
Open loop control function blocks, 174
Operating time counter, CT_LT, 158
Operation log, 231
Operator interventions
Context menu, 27
Keyboard, 22
Mouse, 21
Overview display, 30, 85
Call-up, 85
Display types, 88
Dynamics in the Group Display Symbol,
90
Operator interventions, 87
Symbols, 88
Plant view
Message, 68
PLI, 185
PLI function block, 185
Point acknowledgment, 61
Priority levels, 59
Process operation, 21

Process station, 248
Process visualization, 30
Pulse counter, CT_P, 157
Sequential function chart
Operator interventions, 199
Tip operation, 201
Set point controller, C_ANA, 150
SFC display, 32, 187
Call-up, 187
Control Aspect, 208
Operator interventions, 191, 197
Overview display, 190
SFC times, 197
Step times, 198
Structure, 189
Short-term archive, 111
Signal sequence log, 234
Format, 236
Sound file, 63, 76
Standard displays, 30
Standard view
Message, 67
Start-up characteristics
Trend display, 113
Status logs, 219
Step
Display, 193
Execute, 192
Operator interventions, 202
Statuses, 192
Step controller
Ratio C_SR, 165
Standard C_SS, 163
Universal C_SU, 164
STRING128, 181
STRING16, 181
STRING256, 181
STRING32, 181
STRING64, 181
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STRINGS, 180

Switch messages, 59

System display, 33
Calling up, 241
Operator interventions, 242
State display, 260

System Display, 241
Detail displays, 263

System messages, 59

Tag selection, 21, 22

Three position controller
Universal C_PU, 170

Three position controller
Standard C_PS, 169

Time scheduler display, 32, 211
Calling up, 212

Time Scheduler Display
Operator interventions, 214

Time scheduler, TS, 151

Timer, 156
Monoflop, MONO_F, 154
Switch-off delay, TOF, 155
Switch-on delay, TON, 155
Switch-on/off delay, TONOF, 154
with external time input, TIMER, 156

Timer counter, CTT, 156

TOF, 155

TON, 155
TONOF, 154
TOUCH, 159
Touch Button, TOUCH, 159
Transitions
Displaying, 196
Operator interventions, 203
Statuses, 195
Trend display, 31, 111
Change time range, 127
Operator interventions, 113, 121
Options, 128
structure, 114
Trend window in the graphic display, 105
TS, 151
TUNE, 171
Two position controller
Universal C_PU, 168
Two position controller
Standard C_OS, 167
Up/Down counter, CTUD, 157
User identification, 28
User interface, 25
Visual acknowledgment, 60
WEB display, 33
WEB Display, 288
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